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PowerMILL 9 1. Getting Started

1. Getting Started

Introduction.

This course covers the 3-Axis functionality available in PowerMILL. The additional features
available with PowerMILL—-Pro and Five Axis licenses are covered in separate modules.
PowerMILL will quickly create gouge free cutter paths on imported component data. It
supports Wireframe, Triangle, Surface, and Solid models created by other Delcam products
or from neutral formats such as IGES. If the relevant PS-Exchange translators are purchased
PowerMILL will also directly import data created by other of proprietary CAD packages.

Start PowerMILL

e Double click the relevant PowerMILL shortcut icon on the desktop:

Note:- On the training pc the icon will be displayed as PowerMILL .

The following screen is then displayed:

&7 PowerMILL Pro 9.0 [ * None |

File view Insert Draw Tools Help
@E?égﬁﬁjiﬁﬁliggéﬁéﬁ‘®Rasherlesh\ng v E&(@mmﬂx x
l=om D
- @ NP C(‘
@ Toolpaths @
¥ Todls @:
(O Boundaries 2o
¥§ Patterns @
I:? Feature Sets @
i Workplanes @‘
Q Levels and Sets
@ Models =] 1
& stock Models ‘@|
¥ Groups Q
3 Macros ‘@'
!
g
units [mm | gTulerancE [ | WO | x 88.025863 | ¥ [3.406296 x
Ready

Issue PMILL 9 1.1



1. Getting Started PowerMILL 9

The screen is divided into the following main areas:

File %iew Insert Oraw Tools Hel
1) Menu Bar - a

Clicking one of the menu names on this bar (for example, File) opens a pull-down list of
associated commands and sub-menus. A sub-menu is indicated by a small arrow to the right
of the text (for example File - Recent Projects >). Highlighting this arrow generates a list of
commands/names specific to that sub-menu (for example, File - Recent Projects displays a
list of recently opened projects that will open directly when clicked).

2) Main Toolbar — E,ﬁ; H & aﬁiﬁﬁlglw{?% @; @ ERast&rFinishing v %( @ = mx ®

This provides quick access to the most commonly used commands in PowerMILL.

3) Explorer -

»
—>

The Explorer provides control options and storage of PowerMILL entities
created during the session.

4) Graphics Window — This is the large, visual display area to the right of the
Explorer (Look at the illustration on previous page).

5) View Toolbar — |f(‘,—£‘g‘ P e R84 @ 0 My x

Provides quick access to standard view and shading options in PowerMILL.

6) Information Toolbar - “® i 1 He=m ezl

This area provides a reminder of some of the active setup options.

Tool Toolbar - facilitates the rapid creation of tools in PowerMILL.

The other toolbars are not factory defaults, and are therefore not shown at initial startup. To
display any of these, select using the relevant option under View - Toolbar, for example
View - Toolbar - Toolpath to display the Toolpath Toolbar:

InsErt Draw Tools Help

Resize to Fit F6 3 ]
Zoom to Box... ‘]Ie‘:;"aj gy
From 3
150 3
Tool 3
Rotation Anchor 3
Refresh Ctrl+R
Blank Selected Cirl+3
Blank Except Cirl+K
Blank Toggle Ctrl+Y
Unblank Ctrl+
Dialogs F| v Viewing Alt+y
Snapshot... ViewMill
. . Command
L Dynamic Sectioning. .. v Info
Pattern
Todlpath
Boundary K

v Status
v Tool
Web

Simulation
Machine Tool
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PowerMILL 9 1. Getting Started

To change the background colour of the graphics area, select Tools - Customise Colours and
select View Background. The Top and/or Bottom colours can be changed independently
and Reset using Restore Defaults to restore to the original settings:

- =
g Customise Colours

- NC Program | Selected Colour

+- Toolpath o

+- Tool __
+- Patkern

+- Feature Set Clipboard

+- Workplane

+- Model

+- Stock Model

+- Block

+- Area Clearance

+- Collision Checking

+- Local Thickness Sets
+- Default Thickness Sets
+- Machining Mode

+- Transform

Al Colours

=
=I- View Background Reset all
Eoktorm W Restore Defaults

PowerMILL remembers Toolbar and colour selections from one session to the next, for
example, if the Toolpath Toolbar is open when the session is closed, it will appear the next
time that PowerMILL is opened.

Mouse buttons
Each of the three mouse buttons perform a different dynamic operation in PowerMILL.

Mouse button 1: Picking and selecting

This button is used for selecting items off the pull down menus,
options within forms, and entities in the graphics area.

The method of selection is controlled by 2 options accessed from the
Viewing toolbar the default being ‘Select using a Box’

LRI

Select using a box _[:SJ

If the cursor is positioned on an entity, such as part of a surface model and the left mouse
key is pressed, then the item will turn yellow signifying that it has been selected.

If the same process is applied to another surface, all currently selected items will be de-
selected.

If the Shift key is held down during the process then the new selection will be added to the
original selection.

If the Ctrl key is held down while clicking on a surface it will be removed from the total
selection.
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1. Getting Started PowerMILL 9

Select by dragging the cursor E

If this option is selected then multiple, selection of entities will occur by simply dragging the
cursor across the required items. This is ideal for quick selection areas of the model
consisting of multiple surfaces. To deselect the Ctrl key is depressed while dragging across
an entity.

Mouse button 2: Dynamics

Zooming in and out: - Hold down the CTRL key and mouse
button 2. Move the mouse up and down to zoom in and out.

Pan around the model: -Hold down the SHIFT key with mouse
button 2. Move the mouse in the required direction.

Zoom Box — hold down the Ctrl and shift key, drag a box around
the area to zoom into using the middle mouse button.

Rotate mode: Hold down mouse button 2 and move the mouse,
and the rotation is centered about the trackerball.

View Spinning- Dynamically rotate the view and quickly release the mouse. The faster the
mouse movement, the faster it will spin. This feature is switched off by default.

e Select Tools -> Options - View - 3D Graphics and tick the option Spin

View. & Options FIx
\ 3D Graphics
5 Pick Radius

rawing Tolerance

Instrument On Select

Use Mode! Colour for Holes []

Spin Vi

[ Restore Defauits_| [ Accent ] [_concel ]

Mouse button 3: Special Menus & PowerMILL Explorer Options

When this button is pressed it brings up a local menu relating to
whatever the mouse is over, such as a named item in the
PowerMILL Explorer or a physical entity in the graphics area.
If nothing specific is selected the View menu appears.
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PowerMILL 9 1. Getting Started

HELP!

PowerMill provides the user with help in a number of ways:

1. Tooltips. Place the mouse cursor over a menu button. A box will appear containing
a description of what that button does.

2. Online Help. Select Help>Contents... from the Main Toolbar, to access the
online help documents. There is a full index and search facility provided.

3. Context Sensitive Help. Pressing the F1 key will display the help page for the
currently active form. Clicking on the E] button in the top right hand corner of the
form, followed by a left click in any of the input fields will focus on the help topic
for that part of the form.

4. PowerMill User Forum. On any PowerMill PC with an Internet connection,
selecting Help from the main toolbar, followed by Visit the User Forum, will
enable you to participate in web based user discussions on PowerMILL issues. The
forum can also be accessed from any other internet connection by going to
http://forum.delcam.com/

5. Telephone and Email Support. UK customers with up-to-date software
maintenance can call 01216831010 or mail support@delcam.com to get help or
advice on specific application problems.

PowerMILL contains On-Line Help the main access being via the Help tab on the main
pulldown menus.

Draw Tools

- e Contents...
U _E t
a = What's MNew...
Parameters 3 \

Check for PowerMILL Updates... * Select Help -> What’s New.
Subscribe to the PowerMILL Mewsletter...
Visit the User Forum

Data Translation Services. ..
Delcam on the Web 4

About...

A summary of all the new functionality available in the current version of PowerMILL is
loaded into the html pane.
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1. Getting Started PowerMILL 9

Simplified PowerMILL Example

This example provides a quick overview of the machining process. It shows how to create
and output a couple of simple toolpaths on a model of a valve chamber (using default settings
wherever possible).

The basic procedure is:

[S—

Start PowerMILL.

Import a Model.

Define the Block from which the part will be cut.

Define the cutting Tools to be used.

Define Set up options (Rapid Move Heights — Start and End Point).
Create a Roughing Strategy.

Create a Finishing Strategy.

Animate and Simulate the toolpaths.

e S A O T

Create an NCProgram and output as a post-processed ncdata file.

10. Save the PowerMILL Project to an external directory.

Import a Model

e From the main pulldown menus select, File - Import Model and browse
for the model file:-
D:\users\\training\ PowerMILL_Data\Models\PmillGettingStarted.dgk.
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PowerMILL 9 1. Getting Started

Blanking of Model entities

This provides the user with a quick and simple way to control which individual, model
entities are displayed. In the illustrations below, the light blue surfaces are selected.

If one or more surfaces are selected they can temporarily be removed from the graphics area
by using the Blank Selected option (Ctrl J) in the local Model menu (accessed by right
clicking on a surface).

< O

If one or more surfaces are selected all others can be removed from the graphics area by
using the Blank Except option (Ctrl K) in the local menu.

The 2 selected items are light blue.

To return all Blanked items back to the graphics are the Unblank option (Ctrl L) is selected
in the Default menu (accessed by right clicking in the graphics area). The Blanked items are
returned to the graphics area and become selected (back to the left hand image above).

Also accessed form the Default menu is the Blank Toggle option (Ctrl Y) which if selected
will switch the Blanked and Unblanked items to the other status.
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1. Getting Started

Definition of the Block

PowerMILL 9

¢ Click on the Block icon @ on the top toolbar.

&% Block

Defined by |Box vl
Limits
Min Max Length
x[o0 | [mo | ) [mo |
v [00 | [ 100.0 | [100.0 |
z |00 |

| | 43.7366¢ | | 43.73668

Diarneter F_—I
@

Cylinder Parameters

£ N
.U

Centre X

Centre Y

") @

Estimate Limits

Tolerance

Draw

-
| Caloulate

Opadty —

[ Accept J [ Cancel J

e (Click on the Calculate button.
e Click on Accept.

The Block Form is used to define the 3D
working limits. This could be the actual raw
material size or a user defined volume,
localised to a particular part of the
component.

The Block Form default is Defined by - Box
around the model dimensions on clicking the
Calculate button. Individual values in the
form can be edited or locked (greyed out) as
required in addition to being calculated to
include an offset by entering a suitable value
in the box marked Expansion.
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PowerMILL 9 1. Getting Started

Cutting Tool definition

The Tool definition forms are accessed from the icons accessed from the Tool toolbar
located to the bottom left corner of the graphics area.

For use with this example, 2 tools will be created, A Tip Radiused for roughing out and a
Ball Nosed for finishing.

'1'_|v

e Click on the down arrow to display all of the Create Tool icons.

All of the tool types appear as icons.

|Create a Tip Radiused tool|

Placing the cursor over an icon will open a small box containing a description of
the tool type (Tool tips). Note the unavailable, greyed out tool definition icons
are only available in PowerMILL Pro.

Un

W

C[EIBCECTCECE

e Select the Create a Tip Radiused tool icon. Ej

u'g Tip Radiused Tool ﬂﬂ

Tip | Shank I Halder I Cutting Data I Descripkion

i~ Tool Assembly

Tool Number | 1
Mumber of Flutes | 1

Mame | D121
- Geomekry M
| |
1 ‘ |
! i
Length ‘ |
|6D.D |
| i
‘ |
r A 0
|
Tip Radius ot - ‘
I 1.0 12.0 |
Diameter |
Tool Status I\p'ahd |
|
|
|
|
.~
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1. Getting Started PowerMILL 9

The Tip Radiused Tool form opens ready for the user to input the required values. When a
diameter value is input the tool length automatically defaults to five times this value. This
value can be edited if required.

It is highly recommended to input a more appropriate Name for the tool. In this case the tool
has been renamed as Name D12t1.

If appropriate, a specified Tool Number can be output to the NC program. If the machine has
a tool changer this number will represent the location in the carousel.

Enter a Diameter of 12 a Tip Radius of 1.
Enter D12t1 in the box marked Name before Clicking on Close.

Repeat the Tool Definition operation, this time selecting ‘Create a Ball
Nosed tool’ and in the form entering a Diameter 12 with a Tool Number 2
before and enter the name BN12 before Clicking on Close.

In the explorer panel on the left of the screen, open the tools and right
mouse click on the D12t1 tool to raise the local menu. Select Activate.

54 Tools ‘ Only one tool can be Active at any one time and the
= U EE word Activate in the local menu will be prefixed with a
Ct) b L_l ZBN pizn tick. the active tool will automatically be included in the
oundaries .. g .
% Patterns form when a machining strategy option is opened.
4P Feature Sets Settings... In the explorer, the Active tool will be displayed in bold

text and prefixed with > *.

Rapid Move Heights

The Rapid move heights form is essential to allow the user to safely control rapid tool
movements across the component. Safe Z is the height above the job at which the tool can
move at rapid feedrate, clear of any obstructions such as the workpeice or clamps. Start Z is
the height to which the tool will descend, at rapid feed rate prior to applying the plunge feed
rate. PowerMill displays rapid moves as dotted red lines, plunge as pale blue and cutting as

green.
Safe Z
» Y

Start Z

e R apid

————-> Plunge

—— > Cutting
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PowerMILL 9 1. Getting Started

e Click on the Rapid Move Heights icon.
¢ In the resultant form select the Reset to Safe Height button.
e C(Click on Accept.

This will automatically set absolute SafeZ and Start

Absolute Heights A .
Z values to be above the block by the distance in the
Safe Area |P|ane "l . . .
incremental height fields shown at the bottom of the
Workplane | vl form
An Absolute setting will always cause the tool to feed
down from the same height.
Mormal

floo B oo |

Safez | 537366

Start Z | 48,7306

II :

Reset to Safe Heights

Incremental Heights

Rapid Move Type | Absolute w

[ Accept ] [ Cancel ]

Tool Start and End Point.

e C(Click on the Tool Start and End Point icon. é

U‘E Start and End Point

StartPaint | End Point The Start and End Point form allows the user to

define a position where the tool travels to before
and after a machining strategy. By default the tool

Method Start Point is set at Block Centre Safe. Other

Use | Block Centre Safe vl Start and End Point definitions are achieved by
selecting different options in the Method area on
Approach Along |TCID| Axis vl the form.

These include First/Last Point Safe, First/Last
e Point, and Absolute.

Coordinates

x[00 | v[oo | z[s3.7386]
Tool Axis

1|00 | 1[0 | k[0 |
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1. Getting Started PowerMILL 9

e Accept the form with the default settings.

The D12t1 tool is positioned at the Block Centre Safe position ready for the user to create
the first toolpath.

Creating a Roughing Strateqy

From the Main toolbar select the Toolpath Strategies icon.

i ?‘ﬂ @' @ Raster Finishing
Toolpath Strategies

e Select the 3D
Area Clearance
Tab.

2.50 Area Clearance | 3D Area Clearance | glisks || Driling | Favourites | Finishing | Ports |

I;'LFPIunge Milling
€ Profile AreaClear Model Preview

ster AreaClear Model

'Of‘fset AreaClear Model E Q |:|

e Select the option Raster AreaClear Model to open the following form.

¢ Input the new Name D12t1-a1 for the toolpath that will be created.
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PowerMILL 9

&f Raster Area Clearance Form [Model Machining]

1. Getting Started

Tool

Tolerances
Tolerance
Thickness
g
Skepower
Stepover
Stepdown

| Automatic

Boundary

v [0 ]

Profiling

[CIFinal Profile Pass

[l area Filker

Tool Axis

Name | D12tl-al

Lead In Moves

Type | Plunging w | | Options, ..

Approach Qutside
Crilling Holes

]

High Speed Machining
[CIProfile Smoothing

[CIresk Machining

[oo ]
[oo ]
Sarting Ordering

Raster Angle

|Manual vl | 0.0 |

L Apply

1[ Accepk ][ Cancel ]

Edit the Thickness value
to 0.5. This is the amount
of material that will be left
on the job

Edit the Stepover value
to 10. This is the
distance between each
raster pass (the width of
cut).

The Stepdown value
(depth of cut) is left at the
default of 5 mm.

e Click the Apply tab to process the machining strategy.
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1. Getting Started PowerMILL 9

The resultant 3D Raster Area Clearance can be simulated as follows:

e Raise the Simulation Toolbar by selecting View>Toolbar>Simulation.

@4 PowerMILL9.0 [ * None]
File | view Insert Draw Tools Help

2 Resize to Fit F& . ‘
* g i JE S| &
o2 rrom S LEEEY
=== TSR 3
@ Tool 3 - b
~—  Rotation Anchor 3

H;; Refresh Cirl+R

Blank Selected Ctrl+1

-4 Blank Except Cirl +¢

=  Blank Toggle Ctrl+Y
Unblank Ctrl+L

Y ] - -

" Dialogs b W Viewing Alt+V

""" ViewMill

S |

al Dnapshos e Command

_____ ynamic Sectioning... B
[]---Q’ Levels and Sets Pattern
[—]. Models v Toolpath

- i@ PmillGettingStarted Boundary

-4 Stock Models v Status

----- ¥ Groups v Tool
-E8 Macros Web

Machine Tool !

¢ From the Simulation Toolbar, select toolpath D12t1-al in the first field and
then click the Play button to initiate the simulation.

ﬂ PowerMILL 9.0 [ Editable Project - test ]

File View Insert Draw Tools Help

PH & earIIVESTE Y |

&5 D1t1a1 v ol D127t Al
=

| e laml =1

The other buttons on this toolbar can be used to rewind or step through the
simulation.

DI04l > <44 D> KDY J a X

NB. The above strategy has been processed almost completely using the default values, the
exceptions being the Name, Thickness and Stepover.
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PowerMILL 9 1. Getting Started

Creating a Finishing Strategy

¢ In the explorer right mouse click on the BN12 tool and in the local menu
select Activate.

¢ From the Main toolbar select the Toolpath Strategies icon.
f Eﬁ L@é" @ Raster Finishing

Toolpath Strategies

e Select the Finishing Tab.

&
z

2]

'2.5D Area Clearanoel 3D Area Clearance I Blisks I Driling I Favourites Finishing |Ports I

£} 30 Offset Finishing EE' Q |

&= Constant Z Finishing

|Corner Along Finishing % Preview
b Corner Pendl Finishing

e Corner Stitch Finishing

ﬁ Pattern Finishing

Radial Finishing
== Raster Finishing
@ Spiral Finishing

Select an icon to see a preview

e Select the option Raster Finishing to open the following form.

&% Raster Finishing Form

e Input Name Bn12-ai

Mame | BN1Z-al

Taool

U « |[bn1z 3 Angle | 0.0

Start Cormer | Lower Left A
Talerances
Tolerance | 0.1 Perpendicular Pass
Thickness
e : - e Edit the Stepover value
sleoona 10 e Cne Way E¥3 tO 1 .0

Boundary

[ W

Carners

arcFit [

Leads and Links

Lead In | Mone
Lead Out | Mone
Short Links | Safe

Long Lirks | Safe

Tool Axis

e e Click the Apply tab to

Clovaw process the machining
strategy.

[ Apply ][ Accept ][ Cancel
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The Raster Finishing
pattern is projected
down Z onto the
component taking into
account tool geometry
and machining
settings.

Note:- The toolpath
link moves, clear of
the job are not
displayed in this
illustration for clarity.
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Toolpath Simulation and ViewMILL

PowerMill provides two main options for simulating toolpaths. The first simulates the cutting
tool as it progresses along the toolpath. The second includes a shaded image of the stock
material being reduced as the tool progresses along the toolpath.

1 — Toolpath Simulation

e In the explorer right mouse click on the roughing toolpath D12t1-a1 and
from the pop-up menu click Activate to make the toolpath active (ticked).

@ M Programs

= @ Toolpaths
w0V & =D12t1-al Note: The Active toolpath is displayed in bold text and
w0 B BM1Z-al prefixed with a > symbol.

= ¥ Tools

e In the explorer right mouse click on the roughing toolpath D12t1-a1 again
and from the menu click Simulate from start.

----- @ MC Programs

|_:_|\'§> Toolpaths

ERVAESE 1> D12t1-a1
w-v) § B Bn12al D12t1-al
=47 Tools
w o L >oen IEEEEETIN
w by
m- okl Bni2 v Activate
{;’ Boundaries Activate Workplane
..... “% Patterns e

e The Toolpath Simulation toolbar will be displayed at the top of the screen.

This displays the name of the toolpath and tool, together with buttons to
control the simulation.

&b p12ti-a1 v| ¥ p12t v b ID DD KAPA o X

The operations performed by each of the buttons are as follows:

P
Il

Play - starts the simulation and plays it in continuous mode.

Pause - pauses the simulation.
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1. Getting Started PowerMILL 9

Step Forward - steps the simulation by tool moves. The faster the speed (defined

using & J Speed Control) the bigger the step. Click the Step Forward button
again to see the next move or click the Play button to resume continuous mode.

\ Step Back - steps the simulation back by tool moves. Click the Play button to
resume continuous mode.

pb Search Forward - steps the simulation to the next toolpath segment. Click the
Search Forward button again to see the next component or click the Play button to
resume continuous mode.

N Search Backward - steps the simulation back to the previous toolpath segment.
Go to End - moves to the end of the toolpath.

ki Go to Beginning - moves to the start of the toolpath.

% - Speed Control - controls the speed of the animation. The fastest setting
is by having the slider at the right, the slowest at the left.

Unload - stops the simulation and dims all the 'play’ buttons.

NB. Resting the mouse pointer over any button will also raise a tool-tip
describing the button function.

e Animate the toolpath using the controls listed.
e Actvate the finishing toolpath Bn12-a1 and repeat the animation process.
e Unload the toolpath when complete.

TIPS!

When selecting a path for animation from the toolbar, be sure that the light
bulb next to the toolpath name in the tree is switched on.

The toolpath must be rewound to the beginning or unloaded and re-loaded
before it can be played again.
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2 — ViewMILL

e Activate roughing toolpath D12t1-a1 and select it in the simulation
toolbar.

e Raise the ViewMILL toolbar by selecting View>Toolbars>ViewMILL from
the top toolbar.

ﬂ PowerMILL 9.0 [ Editable Project * test ]

File | view Insert Draw Tools Help

-~ Resize toFit F& N ‘ i | "
Zoom to Box... Ie *e ﬁ =N
= From 4
Hz 150 3
Toal »
{ Rotation Anchor »
B Refresh ctri+R
Blank Selected Cirl+2
g+ Blank Except Crl+
Blank Toggle Ctrl+y
Unblank Ctrl-+
""" | Diglogs b v Viewing Alt+y
-~
_____ e
Bl ynamic Sectioning... . Info
The ViewMILL - o toolbar will be

displayed, although initially all the icons will be greyed out.

9 <4 | =

e Click the first button i to Toggle ViewMILL Window and enter

ViewMILL mode .
The ViewMILL toolbar will then highlight.

O/ eRleeedV | [ wA @ *

Click the fourth button |"‘—| to select a plain shaded image.
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e Select the tool icon “L to display the tool followed by the Play icon b :

§ opuar v oo T DN DK — & x
Clevcved| L /wvA @ x|

=
- @] o]

@ MC Programs
E»@ Toolpaths
B, @ >D12t1-a1l
B+ § B Bn1z-a1
£ Tools

= 4| =p1am
- gk ena
O Boundaries

-4 Patterns

1—_‘? Feature Sets

- Workplanes

[]---@ Levels and Sets
[-§ Models

.‘ Stock Models

- ¥ Groups

-8 Macros

In ViewMILL the machining of the material block is simulated as shown above.

e When the above simulation is finished, in the Simulation Toolbar, select

the finishing toolpath BN12-a1

& eniz-a1 v| i a1z o DI DKIPKIDN ——31 a x

followed by the tool icon I and Play icon [} again, to view the
continued simulation of material removal by the finishing toolpath.

¢ |n the Simulation toolbar select the ViewMILL Exit icon @ to exit the
ViewMILL session.
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NC Programs (Post-Processing and Ncdata Output)

e In the main pull down menus select Tools - Customise Paths to open the
PowerMILL Paths form (shown below right).

Fie View Insert Draw | Tools Help - 21
@ E | & Ea ﬁ Echo Commands |NC Program Cutput =l gﬁ&l ﬂﬁj
Reset Forms L NC Program Output

IE File Dialog Examples Button
- Default Directory
v Snamng File Dialog Button 1
- il File Dialog Button 2
H:—- .I t:.’] Snap Filter b Template Paths
Filter SthE [ Setup Sheets Template Paths
Setup Sheets Export Paths
@] MC Programs . e Option Files
Customise Paths...
E@ Toolpaths
. m-v ¢ @ D12tlal  Release Licences »
v 7 B > BN12.  ReguestLlicences 3

¢ In the Powermill Paths form select the option NC Programs Output.

Select Path @

&% PowerMILL Paths E]@ Mavigake to the desired path, creating new Faolders if

necessary. Press OK to accept of Cancel to quit.
MC Program Output b ’%

[=) = Local Disk {C:) ~
# |2 dcam
I3 DERLOY
[# |2) Documents and Settings
|2) image
[ [ Z) NYIDIA
. . . [# |Z) Program Files
This dictates where the post-processed, ncdata files are ) pshaper
output ready for download to a machine tool = ":'g" e
controller. [ [C3) PaowierSHAPE-jobs v

Ciftemp/MCPrograms

A4

Folder: | C\kempiNCPragrams

[ Make Mew Folder ] [ Ok ] [ Cancel ]

¢ Right mouse click the Add path to top of list icon and in the Select Path
form browse to the required location C:\temp\NCPrograms and select OK.

¢ In the explorer right mouse click over NC Programs to open the following
sub-menu.

-V NC Preferences enable the user to control the content of
v Create NC Program files for d oo oo o
MC Program Mames  # output files for download to a Machine 1ool.
=4 Toc
Deactivate
B write Al
(2 Bou Setup Sheets 3
I:P S| Freferences...
il vasenn Project Settings
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¢ Inthe NC Programs sub-menu select Preferences to open the following
form.

&% NC Preferences

| output | Toalpath

Changes made here will not change existing MC Prograns The OUtPUt FOlder
defaults to the location
Output Folder | C: ftemp/MCPrograms already defined in TOOlS'
OukpLE File | %%[neprogram] Customise Paths.

IMachine Option File . C: fdcamjconfigiduct post/heid400.opt

[ Apply l[ Accept ][ Cancel ]

¢ In the above form click on the Machine Option File icon (arrowed) and in
the resultant form select heid400 before clicking Open.
&% Select Machine Option Filename @@
Look ir: | I3 ductpost I & G il
|ﬂfidia.npt Ll theid400, opt |:_'f]inc0n.opt
m fidian. opt m heid426.opt m kryle. opt
m ge2000m. opt m Heids30. opk m maho,opk
m h33.0pt m heid. opt m mnaksura, opt
= |ﬁh155.opt Mheidiso.npt Mmazak.opt
m Mhaas.opt Mhurco.upt mmtsu.opt
—1 & L4
Ih File name: | heid400.opt
— | Filescftype: | Maching Dption files [* opt:* pmaopt) v

e On return to the NC Preferences form select the Apply tab to action the
settings and then Accept the form.

¢ In the explorer right mouse click over NC Programs and from the sub-
menu select Create NC Program.

[I::‘ l.] T;;I An empty NC Program will appear in the
explorer ready to have machining strategies
£.&> Toolpaths | jC Programs assigned to it. The NC Program form will also
g s @0 open in the Graphics area.
E|Jl“r Tools
: : U 0 Deactivate
=~ B0 .

MC Program Mames »
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¢ In the explorer move the cursor over the toolpath D12t1-a1 and while
holding down the left mouse key drag a ghosted image onto the NC
Program named 1.

= | @] ]

E@] NC Programs A copy of the toolpath name will appear in the NC
B Edl Program indicating that it has been assigned as part of the
E»@ Toolpaths .

B/ Diztiat output file.

@) ¢ B >eN12-a1
.4 Tools

¢ In the explorer drag a copy of the finishing toolpath name BN12-a1 onto
the NC Program named 1 and click on the small, adjacent boxed plus sign.

= ﬁ NC Programs
5 >
+ & Dlztl-al
+ 5@ BN1z-al
= -@ Toolpaths
w4 Dizti-al
#-v -, B =BN1Z-al
+-4 Tools

The toolpath names are listed in the NC Program
ready to be post-processed.

¢ Inthe NC Program form displayed in the graphics area, select the Write
tab to start the post processing operation. The following Information form
will open providing the user with a progress and confirmation summary.

Write NC Program

+ DUCTPOST VERSION 1.4 +
+ Revision 90 BETA +

Copyright (c) Delcam plc, Birmingham, England
1891, 1992, 1983, 1884, 1895, 1936, 1997, 1888, 18993, 2000,
2001, 2002, 2003, 2004, 2005, 2006

Licensed to Delcam Software Development for 2007
For academic use only

Supplied by asw@delcam.con

Uszing built-in standard

e Close both the NC Program and Information forms and using the
windows explorer move to C:\temp\NCPrograms and note the existence
of the ncdata output file 1.tap.
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Saving the Project

e Left mouse Click on the 2" icon along the Main toolbar to open the Save
Project As form.

File “iew Insert Draw Tools Help

B CUII WS W 1fhe Project has been Saved before then the Project will

“ é a&re_l ‘ be updated without the following form being opened.

&% save Project As

File name: | GettingStarted -
Save as pe: | PowerMILL Project v

Al &S

¢ In the Save Project As form, in the Save in box browse to
D:\users\training\COURSEWORK\PowerMILL-Profects\GettingStarted-1

e Left mouse click in the Save tab to store the Project to a named external
directory (the form will close automatically).

¢ |n the Main toolbar select File — Delete All followed by Tools — Reset
Forms.

The content of the explorer will be deleted and all forms will be reinstated to factory, default

settings. The externally stored copy of the Project (GettingStarted-1) can be reopened as
required.

Additional Exercise

e Import the model facia.dgk located in the Examples directory.

e Save the Project as:-
D:\users\training\coursework\PowerMILL\Facia-1

Use the same tooling and strategies as applied in the previous worked example.
e Once completed and the Project finally Saved, select File — Delete All
followed by Tools — Reset Forms.
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2. Machining Setup in Detail

Additional Preparation before creating toolpaths

In the previous section we created toolpaths using the default values whenever possible. We
will now look at the machining process in more detail.
I particular:

Setting up direct access to regularly used files

Orienting the job for machining

Detail Examination model features

Tool and Holder definition

Material Block Definition

Setting safe Z Heights

Setting up direct access to regularly used files

To Import a Model the user can select File > Import Model from the top pulldown menu. A
selection of sample model files are supplied and installed with PowerMILL in a default
directory called Examples. These are directly accessed via the icon in the Import Model

form. g

Alternatively, regularly used models can be accessed quickly with the user definable buttons

@ and ﬁ‘ on the Import Model form.

e From the Main pulldown menus select Tools - Customise Paths.

mg HE||:I @j‘?uweerLL Paths mgj

Select Path ﬂ
Echo Commands . ﬂde Didlog Button 1+ .@
{ » NMavigate to the desired path, creating new Folders if
Reset Forms E:fusers(dfb/PawerMILL_Data/Models necessary, Press OK to accept or Cancel to quit.
i = [ PowerMILL_Data ~
¥ Snapping {

) 2 cut_files
anap Filker 4 (3 five_ads

. » + [_) HighSpeedme
Filker Style # [ MachineData

Zustomise Paths.., (2 Pattel

Folder: | EslusersldfbipowerMILL DatalModsls

Make ewFolder | [ ok | [ cancel

* Select the option File Dialog Button 1 followed by the Add path to top of

listicon @J and browse to:-
D:\users\training\PowerMILL_Data\Models.
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e Repeat the last process, but this time set File Dialog Button 2 to provide
direct access to:- D:\users\training \PowerMILL_Data.

Note:- Outside the training environment the location of the PowerMILL_Data directory will
depend on where the user has installed it!

Loading a Model into PowerMILL

e From the Main pulldown menus select File - Import Model.
e Use Shortcut Button 1 or browse to
D:\users\training\PowerMILL_Data\Models

& Import Model @
@ Laok in: | I3 Models Bl O % i m'
RetainerPlate.dgk speaker_core.dgk swheel, dgk
reverse_spotface,dgk skeam_valve.dgk trochoidal_pé
rotary_bottle, dgk steering_wheel_model, dgk. ucut_blk, dgk
Seat.dgk surf_hol_blk.dgk undercut_poi
= solid_haoles.dgk surf_holesz . dgk usergl.dgk
m speaker.dgk surf_hiles, dgk. werify_rnadel
Bl ! k4
h File: narme:
| Filesoftype: | Delcam Models [*.dgk;” psmodeldoc.det* p

Note: A variety of different types of Model format can be Imported into PowerMILL.
These can easily be discriminated on the form using the filter Files of type to widen or
narrow the choice for file extension.

e Click on the file name speaker_core.dgk and then select the Open.

it ®

e Select View from top (Z) “— followed by Resize to fit from the
Viewing toolbar to the right of the graphics area.

The model will be displayed (as shown) in the PowerMILL
graphics area looking down the Z-axis with X aligned from
left to right and Y from bottom to top.

In most cases the X dimension of a machine tool table will

Lo R -]

o be greater than Y in which case the longer side of the
component may be in excess of the travel limits in Y.
i If this is the case it will be necessary to align the

o o
o 2 Aa

component with the longest side along X to ensure that it
can be positioned within the travel limits.
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Viewing the Model
Although the model is displayed it is a good idea to look at it from all angles to fully
understand its size and features.

l'.'-]
e Select an isometric ISO 1 view. “I

Although it is possible to rotate the actual component
this is not generally regarded as the ideal approach.

An additional moveable datum (Workplane) will be
created and rotated through 90 Degrees to effectively
create the condition that the longer side of the component
is parallel with the front of the machine.

The original coordinate set-up can then easily be re-
activated for tasks such as checking dimensions.

Orienting the Model — creating the machining datum using a
Workplane

A Workplane will be created and rotated through 90 degrees about Z to effectively arrange
the longest lower front edge of the model to be aligned to the front of the machine tool i.e.
along the X-axis.

e Right click over Workplanes in the PowerMILL explorer and select
Create Workplane

“Aorkplanes

9 Level Workplanes

@ Models . .

& Stockk Create workplane Workplanes are alternative or additional component datums

o= ELDEL:';Z' Workplane Names + | that can be moved and/or orientated within the global

el . . 0 . .

Deactivate environment. They are frequently used in 3 Axis machining and
Draw Al are an essential item in the application of 3plus2 and 5-Axis
Undraw All

machining strategies.
Create Folder

Delete All

The Workplane creation and editing form will appear.

For easy identification it is recommended to appropriately rename any entity created in the
Explorer.

¢ Inthe form modify the default Name to Datum.
e Setthe Active Workplane to Datum.

Issue PMILL 9 2.3



2. Machining Set up in Detail PowerMILL

The next step will be to rotate the new Active Workplane to indirectly re-orientate the

model.

Mame I Datum

Active Workplane IDat_lm j

v Align———
Draw |+

I
Transform Copy [ @ I’E I’_'
- absolube Position

x I::-:: i I:i.:i ZI::,::

Relative Position
% VY2 Distance | 0.0

Rotate

Xy & o[
" 2|2

Accept |

e Enter Angle 90.0 before selecting the Rotate - Around Z icon.
e Accept the form.

OEIE‘EIO
on.:,l:lo

OLLJJO

e Select a View from top (Z) and observe the effect of the rotated, Active
Workplane providing a more suitable machining position for the model.

It will not always be necessary to create and rotate or move a Workplane after import into
PowerMILL. It depends on the original, orientation of the model when exported from the
CAD software.
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Examination of Model Properties

Information regarding the model dimensions in relation to the world datum (Transform) or
(if present), an Active Workplane can be obtained.

e |n the explorer Right click over Models and select Properties.

Models 21 x|
3 . 2
Create Plane Model: speaker_core E
Paste as new Model X ¥ H
Import Model Minimum: -330.00955 -236.06606 -7z.03208
Impart Reference Surfaces Mk o : 330.00958 113,95370 115,47048
Select Al Components: 639
Select Wireframes
Select Surfaces Component Level Type
zoo core Surface

Deselect All 201 core Surface

i z0z core Surface
Select Duplicate Surfaces 203 core Surface
Deselect Duplicate Surfaces 207 core Furface |
Drawing Cptions 2
Expart All ...
Edit L4
Reverse Selected
Delete Empty Models
Delete All

The values in this form can be copied (Ctrl C) and then pasted (Ctrl V) into other forms.
The Workplane is moved up in the Z plane so that it is situated at the maximum height of
the model.

The form shows that the current maximum Z value is 115.47048mm. It will be necessary to
move the Workplane by 115.47048 to position it at the maximum height of the model.

Model Properties

¥ Z
Minimum: -330.00133 -236.06035 =72.03208
Maxirmarn: 330.000=23 113.9477:2 115.47045

e

e Highlight the Maximum Z value (115.47048) by swiping over it with the left
mouse button and press Ctrl C on the keyboard to Copy the value to the
buffer.

e Eject the Model Properties form by clicking X in the top right corner.
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e In the explorer Right Click over the Workplane named (Datum) to access

the local pull down menu.
21|

gﬁ] MNC Programs

w-$ Level
=40 Models

--45% Toolpaths

$ TDDIE Active Workplane IDat_lm j

() Boundaries o

-8 Patterns - m ff

é) Feature Sets Transform Copy [~ w k'
0.0

MName I Datum

- absolute Position

5 |.;.,.;. iy |.;.,.;. z | 0.0

r~ Relative Position

__. speaker_t v Activate
& Stock Modely ¥ Draw % Y 2 Disiﬁncel 115.47048
-V Groups Add to Folder
-4 Macros Renarne Rotate
Properties @g g @ e Igu.u

] ]

Remave from Folder
Delete Woarkplane

Copy Workplane

Accept |

e Select Edit - Workplane to open the form (above right) and use Crtl V to
replace the previously stored value (115.47048) into the Distance box
before selecting the Relative Position - Along Z icon.

e Accept the form.

e Selecta Y- view. :f

lﬁ v The Workplane is now in
position on the top of the
model.

Minimum Radius and Draft Angle shading views.

Visual checks can be made quickly with the use of two shading options found in the views
menu on the right hand side of the screen.

It is useful to know before generating tools and toolpaths what the minimum radius is on the
model and also whether there are any undercuts or draft angles.

$FBFe 0000
&

e Open the Shading Toolbar by clicking the small arrow as shown above.
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o Select the Minimum Radius Shade icon on the toolbar. %

Any internal radii that are smaller than the specified Minimum Tool Radius will be shaded
RED. The settings are located in the explorer - Model pull down menu in Drawing
Options.

Examine the model to identify areas that are inaccessible to the specified radius (shaded
Red).

The two internal radii can be seen shaded red visually identifying that they will not be
machined to their correct size if the default value tool was used.

The specified Minimum Tool Radius can be modified to suit in the Drawing Options area
within the Models menu in the explorer.

¢ In the explorer Right click over Models and select Drawing Options.

= Models o o
. i' Model Drawing Options
Bt Models
& stock Wireframe
=3 Macra
Import Maodel Laterals Longitudinals Filter Angle
Import Reference Surfaces Shade
Select all Shade Inside Shade Colour _i
Select Wireframes Draw Outlines Shading Taolerance
Select Surfaces Draft Angle Shading
Deselect All Draft Angle | 0.0 Warning Angle
Select Duplicate Surfaces Minirmum Radius Shading
Deselect Duplicate Surfaces Minimurn Tool '= 0.0 ’
Drawing Options
ACCED
Funnet all ..

e Change the Minimum Tool Radius value to 5.

The shading on some parts of the model has changed from Red to Green signifying that from
a finishing viewpoint these local areas are fully accessible to a Dia 10 Ball Nose cutter.

e Change the Minimum Tool Radius value to 2.
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All of the red areas have now disappeared which suggests that the maximum tool size
guaranteed to access all areas of the component would be a Dia 4 Ball Nose cutter.
The model can also be visually inspected for the size of draft angles and undercuts.

e Select the Draft Angle Shade icon on the shading toolbar. 'r;"

The model is shaded in three different colours, red, green and yellow.

The red areas represent angles equal to or less than the current Draft Angle specified in the
Drawing Options form (default is 0).

The green areas represent angles above the current Warning Angle specified in the Drawing
Options form (default is 5).

The yellow areas represent the areas between the current Draft Angle and Warning Angle.
On this particular model the yellow areas represent angles between 0 and 5 degrees.

e To check for undercuts change the Draft Angle to —0.2 and the Warning
Angle to 0.2.

All of the red areas have disappeared and all that remain are green and yellow. If any red
areas remain then these would indicate an undercut situation greater than —0.2 degrees.

The yellow areas indicate on or near vertical faces because the difference between the Draft
and Warning Angles is so small.

e Accept the Drawing Options form

=
e Select the Draft Angle Shade icon I{-' again to turn off the shading.

e Make sure the Wireframe @ icon from the View toolbar is on so the
model is displayed in Wireframe only.

Measuring the model.

The user may require dimensional information relating to certain features on the model. A
measuring tool is provided in PowerMILL that allows the user to snap in the graphics area to
obtain dimensions based on points lines and arcs.

Before any such measurements can be taken the PowerMILL, Snap Filter will need to be
modified.

e From the top Pull Down menus select Tools > Snap Filter and use the left
mouse key to untick - Anywhere.

el
Echo Cormmands 1] £ =
o
Reset Forms %
v Snapping S If Anywhere is unticked then measurements can be only be
Filter Style v| v Boundary snapped onto the remaining ticked entities and not in free space.

v Pattern
v Feature

Customise Paths...

Release Licences 4
Fequest Licences L4

Custornise Colours...
Options...
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The gap at the bottom of the slot will be measured to determine its size and depth.

¢ From the Main toolbar select the Measure model icon. AR

The Model Measurement for appears defaulted to Line. An Anchor Point is required to
commence measuring.

e The PowerMILL Calculator form will open in Line measurement mode.
Using the left mouse button drag a window around (or snap) point 1 shown
below to display the XYZ coordinates in the form.

Drag a window around (or snap) point 1.

@# Measure Line 2=l
Standard Calculator I Scientific Calculator — Line I Cirde I Expression I
r— Anchor Paint

X |-114.002443 ¥ |-1?4. 14391 z I—?9.88436? il

End Point

2 X |-11199808 v [-174.787214 | z [-79.884367 il

r Difference
/ x | 2004363 ¥ |-0.643304 z |00 il
Angle

vz [0 xz oo Xy |-17.794137
The Anchor Point is now selected and
is represented by a small circle. Distance [ 2105068 >> |
The x, y and z values seen in the above Sevaton [00 >3

form are relative to the Active
Workplane ‘Datum’.

e Drag a window around (or snap) point 2 to obtain the final ‘point to point’
measurement information.
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A temporary line appears connecting the two points, and the information relating to the line is

displayed in the form.
Minimum Radius is measured via the Circle tab combined with snapping three points on the

model.

e Select the Circle tab on the Model Measurement form and zoom into the
area shown below.

e Select three points along the arc either by dragging a small window
around, or snapping onto each one as shown below.

A temporary circle will appear after the third point is selected as shown.
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& Measure Gircle d |
Standard Calculator I Scientific Calculator | Line Circe | Expression I
— Start Point
% | 97.620882 v |-8.297265 z |-8.02048
r~Mid Paint
X |95.5 ¥ |-8.386228 z |-11.02048
End Point

X IQ?.059348 Y I-B.130454 z m434694

The Circle measurement form will

~Centre

x [ss757175 v [Seo7iss  z[oiseoss | display details of the arc as shown.
Radius I 1910942 22 |
Diameter [3.821884 > |

¢ Close the Model Measurement form.

PowerMILL Panes

E!‘ l .l _‘_JI On the left hand side of the screen above the explorer are the
- PowerMILL panes.
@ MC Programs
»@ Toolpaths
""" #¥ Tools The standard format pane is denoted by the PowerMILL symbol
’Cr) Boundaries and contains the explorer tree categorised into NC
""" £3 Patterns Programs,Toolpaths, Tools, Boundaries, Patterns, Feature Sets,
- {§P Feature Sets Workplanes, etc.

- Workplanes
Eg...@' Levels and Sets

-l Models
& Stock Models The second pane is the HTML browser used for viewing HTML files
{:J; S‘r':""ps or Help files and the third pane opens the PowerMILL Recycle Bin.
- acros
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Setting Feedrates

Feedrates can be set individually for the current tool and toolpath or loaded from a database
of predefined values. At this stage we will look at setting the feedrate individually. The Tool
Database will be covered later in the course.

e C(Click the Feeds and Speeds icon I on the top toolbar to raise the Feeds
and Speeds form.

é Feeds and Speeds

Toolpath Properties Tool Properties
Toolpath: (none active) Tool: D50T6

Type ) Diameter: 50.0 mm

| Finishing w |

) Number of Flutes: 1

Operation

jﬁ;eneral V Overhana: 250.0 mm
Tool/Material Properties Cutting Conditions
Surface Speed Spindle Speed
[188.495 | m/min :1205110 | rpm
Feed/Tooth Cutting Feed Rate

|400.0 | mm/min

(0.333333 | mm
Axial Depth of Cut
| 0.0 | mm

Plunging Feed Rate

| 40.0 | mm/min
Skim Feed Rate

13000.0 | mm/min

Radial Depth of Cut
| 0.0 | mm
[Jworking Diameter

Coolant

| standard

mm

[ overhang Compensatio

Accept | [ cCancel |

/ \
¢ Inthe Cutting Conditions section of the form, enter a Spindle Speed of

1200 and a Cutting Feed Rate of 400 (as shown above).
e Accept the form.

e Save Project As:-
D:\users\training\COURSEWORK\PowerMILL-Projects\Spkr-Core (but do

not close).
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Tool and Holder Definition

e Open the Tip Radiused tool form.
20x

ey | | Tip | Shank. I Holder I Cutting Data I Description I

L Tools "
ool

: 2 Name [ dsoTs o Y

L% Toolbar... M

P ~Geometry

: 4 From Database...

é Tool Names b T Y '

- @  Deactivate Ball Nosed

8

i

|

prow 1 AT '

Undraw All Tapered Spherical Length ‘
I 125.0

!

r A
——
Tip Radius -t
I 6.0 I 50.0
Diameter

Tool Status | Valid

Tool Number I [
Number of Flutes I 1

Close

¢ In the (above) default Tip form define a Dia 50 Tiprad 6 - Length 125 -
Named D50T6 - Tool Number 6.

ﬁ'ﬁp Radiused Tool 2lx|

Tp  Shank |Holder I Cutting Data I Description I

~ Comporfhnis ~Tool Assembly

|

Dimensibns

Upper Piameter ISD.D
Lower Dyameter W
Length IIZS‘D

Cutting length I 125.0
Shank legth |125.0

\
oo ||

\

¢ In the Shank form, click the Add a shank component icon and enter
Upper/Lower Diameter 50 and Length 125.
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Tip I Shank Holder |Cuth'ng Data I Description

—ComponeAE ~Tool

¥
Holder Name | 1 M

i Overha IW A
! Gauge Length\500.0 The Overhang is the vertical
! distance from the bottom of
: ] the holder to the tip of the
i | cutter.
| i
_I— — Vv

\
ae |\

\

¢ In the Holder form, click the Add holder component icon entering Upper
Diameter 120 - Lower Diameter 80 - Length 125 and Overhang 250.

¢ |nthe Holder form, click the Add holder component icon entering an
Upper/Lower Diameter 120 and Length 100.

e Close the form

The way in which the tool is displayed can be controlled by right clicking on TOOLS in the
tree browser pane and selecting Shaded.

- .
E  100ls| |

C.) Bou Tools

""" £3 pat Toolbar...

|j;' Fea
- woi  Create Tool 3
[]...@.' Ley  Tool Mames 3
- I Mo Deactivate

"' St praw Al

""" LF Gro Undraw Al
-2 Mac

i

v Draw Shank
v Draw Holder

Create Folder

Add All Tools to Database
Change Stock Material for all Tools

Delete Al
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Material Block Definition

e Calculate a 3D working volume (Block) to actual model dimensions using
the Defined by - Box option.

2] x|
efine lﬁ (= . .
Limits ey :,1 kg The default option for Block is Box (A

2

rectangular volume). Other options include
[o.0 % Cylinder (a Cylindrical volume), a Triangle

o o & model (Casting) available in PowerMILL
& o0 &) oo & PRO only, and Picture/Boundary (Extruded
2D wireframe contours).

r— Cylinder Parameters

Zentre & r ﬁ_l Diarmeter: r ﬁ-l
centre ¢[00 =1 & | || The dimensions of the Block can be entered
 Eetimate Linits mapually or calculated directly to the Type of
Tolerance IEI.I Type IMDdeI vl entlty:‘
xpanson [0 i | Model, Boundary, Pattern, or Feature.
- d Opadty —f—— The Opacity slider controls the degree of
accent | cancel | shading (clear to dense).

Rapid Move Heights

¢ Inthe Rapid Move Heights form click the Reset to Safe Heights tab and
ensure that in the Incremental Heights area that Rapid Move Heights is
set to the Absolute option.

fﬂ Rapid Move Heights

Absolute Heights
Safe &rea | Plane v
Marmal
| (00 J (0.0 k1.0
Safez |100
StatZ 5.0

[ Reset to Safe Heights ]

The Absolute option enables safe rapid moves
between tool tracks clear of the top of the

e il gl Component or Block (whichever is the higher).
Rapid Move Tupe | Abzolute w

[ Apply to Active Toolpath ]

Issue PMILL 9 2.15



2. Machining Set up in Detail PowerMILL

Start and End Point

e In the Start and End Point form use the default settings :-
Start Point - Block Centre Safe and End Point - Last Point Safe.

&% Start ond End Point Form E'FX'
StartNoint | End Point Skart Poink | EFAFoint
Method Method
(LW | o<t Poink Safe
Retract Along
Retract Distance
Coordinates Coordinates
w[000] v[eto] oz 100 ; wlon | vloo | z[oo |
Tool Axis Tool Axis
tfoo | oafon | kfio ]| Lo ool e
[ Accept ] [ Cancel ] [ Accept ] [ Cancel ]

Select Save Project to update the saved PowerMILL Project (Do not
close the Project).

Note: The Project is stored in:-
D:\users\training\COURSEWORK\PowerMILL-Projects\Spkr-Core
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3. 3D Area Clearance

Introduction

The main strategies for roughing a 3D component Model are called 3D Area Clearance.
These provide a choice of 2D material removal methods, which progressively machine the
area (Slice), up to the component contour, down a sequence of user-defined Z Heights.
There is also a similar group of strategies, 2.5D Area Clearance for use, exclusively
withPowerMILL 2.5D Feature Sets (covered in Chapter 9:- 2D Feature Set machining).

Sometimes known as Waterline Roughing the cutter steps down to a specified Z Height and
fully clears an area (Slice) before stepping down to the next Z Height to repeat the process.

For some components a secondary Area Clearance strategy is applied using the Rest
Machining options in conjunction with a smaller roughing tool. This will locally remove
pockets of excess material inaccessible to the original Reference Toolpath or Stock Model.
This will reduce the degree of tool overload and provide a more consistent material removal
rate for any subsequent Finishing operations.

If the original material is in the form of a casting or fabrication then it may not be necessary
to apply any Area Clearance machining but to go directly for a semi-Finishing strategy.
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Thickness and Tolerance (Applied to 3D Area Clearance)

Suitable values are required to control the accuracy and amount of excess material to be left
on a component by a toolpath. The parameters used for this purpose are preset and are called
Thickness and Tolerance.

Thickness is the amount of extra material specified to remain on the work-piece after
machining. This can be applied generally (as shown), or independently as separate Radial
and Axial values within the machining options.

_______________ Thickness!
Stepdown I / 1

} r

i

T Component Form
Thickness + Tolerance (Flat Area)

Raster Area Clear example

The Raster Area Clear strategy follows a series of linear moves across the Block limiting to
the Component form at the active Z height. It then, (if required) performs a Profile pass
around the component to leave a constant thickness around the Slice. Other options provide
the abilty to further fine tune the final strategy.

oy
e From the Main toolbar select the Toolpath Strategies icon. &
e Select 3D Area Clearance tab.

2.5D Area Clearance 3D Area Clearance | glisks | Drilling | Favourites | Finishing | Ports

2EE Q

o
2

_Raster AreaClear Model|

e Select the option Raster AreaClear Model to open the following form.
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3. 3DArea Clearance

e Enter the Name

D50T6_A1. L

&

Tool

M D50TE v

Tolerances
Tolerance
Thickness
e Set Stepover to 20.
Stepover
Stepover
Stepdown

e Set Stepdown to 10.

B oundary
G~ e

Limit | Tool Centre

<

Keeping all other values as
default, Apply the form.
After the processing is -

complete Cancel the form. | ™" w4
Cut Direction

[ Final Profile Pass

EvemyZ Alloyance

Trimming | Kesp Inside

[ Area Filker
Filter | Smaller Thar

Thieshold (TDL)

Filter Only Enclosed Areas
Tool Axis
Tl
----- ﬁ MC Programs

;':' Raster Area Clearance [Model Machining]

Mame |DEOTE_AT
Lead In Moves

Type | Plunging + | | Options...

Appraach Outside
Drilling Hales
Input

High Speed Machining
[ Profile Smoathing
Cormer Radiue TOL) _ 0050

tdachine all raster zpans
Mirimize Full ‘/idth Cuts

Maintain Constant Stepover

[[] Rest Machining
Toolpath

Detect b aterial Thicker Than
Expand Area By

Consider Previous Z Heights
2
Sarting % ) Ordening| Pocket  «

Sitple

Twn Way Joned
Fiaster Angle

| taral v| |D.U |

[ 4ppy

J [ Accept ][ Cancel ]

=& Toolpaths

r

v L > dsote
(D Boundaries

STEPOVER
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3. 3D Area Clearance PowerMILL

The Toolpath icon can now be double-clicked to Activate and de-activate the toolpath.
The + symbol can be clicked to open a full record of the data used to create the toolpath.
The dotted red lines represent Rapid moves and the light blue lines are the Plunge feed
moves.

Rapid Move Heights in detail

The Rapid Move Heights form provides Safe Z and Start Z input boxes. Suitable values are
entered to define a safe height (Safe Z) at which a tool can safely perform, horizontal Rapid
Moves above the model as well as (Start Z) where a Rapid plunge move changes to a
plunge Feed Rate. If the Reset to Safe Heights tab is clicked then PowerMILL will set the
Safe Z and Start Z to be a safe distance above the Top of the Model or Block (whichever is
the highest). These Default distances will be Safe Z, 10 and Start Z, 5 and are applied with
the Incremental Heights options switched off (set to Rapid Move Type -Absolute).

u'g Rapid Move Heights E]E]

Abzolute Heights
Safe Area | Plane w

k’ w

Normal
| (00 J oo K 1.0

Safez 100

StartZ |5.0

|

Reset to S afe Heights

Incremental Heights

Rapid Move Type | Absolute -

Absolute (default) sets the plunge feed rate to apply at a specific height above the job. This
is more predictable and reassuring for the machine tool operator but the time take by the
non-cutting (air) moves is inefficient especially in the case of large, deep components.

In the section of the form labelled Incremental Heights, in addition to Absolute, two other
options Skim and Plunge are available.

U'ﬁ Rapid Move Heights EE]

Abeolute Heights
Safe &rea | Plane v

‘,_' w

Momnal
| (00 J |00 K10

>

Safez 100
StatZ (5.0

[ Reset to Safe Heights ]

[ Apply to Active Toolpath ]

Incremental Heights

Rapid Move Type | Skim -

safez |20
Stant Z |50
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Skim enables the downward, rapid feed rate to continue to a specified Incremental Start Z
above the full plunge depth before the slow plunge feed rate ‘cuts in’. Skim then applies a
rapid retract to an Incremental Safe Z above the highest point on the component ‘in line’
with a linear link move to the next plunge position. To cater for all types of machine tool
this move is a (Purple) Skim Feed Rate (G1) as instead of a (Dashed red) Rapid (GO).

GE Rapid Move Heights

Abzolute Heights
Safe Area | Plane v

Safez 100
StatZ 5.0

[ Reset to Safe Heights ]

>

[ Apply ta Active Toalpath ]

Incremental Heights

Fapid Move Tppe | Plunge -

Statz |50

Plunge applies the rapid feed rate all the way down to an Incremental Start Z. measured
from the full plunge depth at which point the slow plunge feed rate ‘cuts in’. The Plunge
option differs from Skim in that all rapid link moves occur at the Absolute Safe Z.

Feed Rates assigned to Toolpath element colour
The Feeds and Speeds form uses the Style and Colour of elements along a toolpath to
register the correct type of Rapid Move or Feed Rate settings.

Fixed (GO0) Rapid moves:- Red Dashed - Toolpath elements

Variable value (G1) Feed Rate moves:-

Cutting Conditions

Spindle Speed (Recommended: 1700 rpm) .
17000 Green/Orange - Toolpath Cutting Feed moves.
. 1pm

Cutting Feed R ate [Recammended: 500 rmm.min)
500.0 Dpanin Pale Blue - Toolpath Plunging Feed moves.

Flunging Feed Rate [Recommended: 50 mm/min]

50.0 i

e Purple - Toolpath Skim Feed moves.

30000 mrn/min

Also, local areas of a toolpath can be assigned with additional Cutting Feed Rate values via
the Toolpath Editing options (See Chapter 8) as a percentage of the nominal value.
PowerMILL will assign a different colour to areas of the toolpath edited to have a new
Feed Rate.
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e Right mouse click over the Toolpath icon in the explorer to open the local
pull down menu.

f- | @) ]
@] MC Programs
E@ Toolpaths
ERVARE 3> D50t6_A1l
&4 Tools D50t6_Al
-A) Boundaries St Fom Start
e imula am I .
""" 3 Pattems Note the toolpath can also be activated or
- Feature Sets | v Actvate deactivated from the Activate switch in the

-1 Workplanes Activate Workplane

L Dm
[]---@ Levels and Set Parameters. .

[l LR PR

Select Settings to reopen the Raster AreaClear Model form.

pulldown menu.

[ ]
e Select the ‘make a copy of the toolpath icon (shown arrowed below).
Tonol @ lead h
[ Create a new toolpath based on this one |
=f
e Select the Rapid Moves Height icon = from the main toolbar.
e Select the Skim option and change the Safe Z to 5 and Start Zto 3 as
shown below.
¥ Rapid Mo 21x|
Safe Area lﬁ
‘Warkplane lﬁ
Start 2 IS.DDDUDE

ReseX\to Safe Heights

|
Apply to Ackye Toolpath |

r~ Incremental Heights

Rapid Move Type |Skim -
sarez| 50
StartZ | 3.0
Accept | Cancel |

e Accept the above form and then click Apply in the Raster AreaClear
Model form and once processing is complete click Cancel to close the

form.

The tool will now plunge locally (pale blue move) from the defined Incremental - Start Z
above each slice and rapid across the roughed areas by the Incremental - Safe Z (purple

move).
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PowerMILL

The toolpath has been recycled with the Skim option set in the Rapid Move Heights form
and now uses Incremental Safe Z and Start Z values.

Statistics
Provides the user with essential information about the Active toolpath and associated
parameters.

¢ Right mouse click on the original toolpath (D50T6_A1) in the PowerMILL
explorer and from the local menu select Activate.

¢ In the same menu select Statistics and a form will open displaying
information relating to the toolpath and associated settings.

3'5:, Toolpath Statistics

[I}. l.] t’;j] Leads and Links
@ NC Programs Length
£ Toolpaths Rand
V)o@
-/ 0@ D505 AL popi a1 i
=9 Tools
- Boundaries Simulate from Start Others
----- F Patterns v Activate Total
1‘_‘? Feature Sets Activate Workplane
-l Cuitting b owves
=2 ‘f Wo.r.l.(:l’an.:sn:h.m Settings... Length Time
Properties Lifts m
Verify 3
[ Estimate ] [ Cancel ]
Truart Salartinn |

Note; In this case the total machining time is displayed as 8 hrs.

e Activate the second toolpath (D50T6_A1_1) and obtain the Statistics.

Note; In this case the total machining time will be around 4.5hrs.

This large saving is achieved simply by using Skim in the Rapid Move Heights form. In the

original toolpath Absolute was used in the Rapid Move Heights form.
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Simulating the toolpath

e Perform both a toolpath and ViewMILL simulation on the final Raster
Area Clearance toolpath.

e Switch the ViewMILL to No Image @ to return to the PowerMILL
session and toggle the ViewMILL On/Suspend < to red (Suspend).

Note:-By toggling back to PowerMILL, the ViewMILL session will still exist in the
background so that any subsequent toolpaths can later be used to continue the simulation.
If the Viewmill session is still set to On, then even though it is set to No Image, the
Viewmill simulation will continue to update parallel with any further, toolpath simulations.

Saving the Project

e From the Main pull down menus, select File - Save Project to update the
stored data.

The Project (D:\users\training\COURSEWORK\PowerMILL-Projects\Spkr-Core) has
now been updated to include the 3D Area Clearance toolpaths.

e Do Not Close the Project as it is to be continued in the next example.

Offset Area Clear example

The Offset Area Clear strategy immediately follows the contour of the both the Block and
Component form at the active Z height. It then progressively offsets across into any
remaining areas of stock.
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e From the Main toolbar select the Toolpath Strategies icon. @
e Select 3D Area Clearance tab.

e Select the option Offset AreaClear Model to open the following form.

@ Offset Area Clearance [Model Machining] 2] x|
e Enter the Name @l [ - e
D50T6 A2 . Tool rLead In Moves
- Iuj [psaTs =] QI Type [Plungng =] _Optiors.., |
rTolerances Approach Outside [+

Tolerance Ir r—Lrilling Hales
e Set Stepover to 20. Fhidmess & oot [E]

g IJ-U @ Oubput Holes Iholes

~ Stepover

i I 10 Stepaver IzD'D —High Speed Machining

T Profile Smoothing

—Stepdown .
Cotner Radius (Towy 0050
|automate | [10.0 =

. Machine Flats ILeveI vl Links ISmooIﬁ ,l
Keeplng a” Othel’ Cut Direct lh o] Smoothing Allowante ——————————
values as default, Boundary &% —

Apply the form Iﬂj I ﬂ »_I Trochoidal Mayes INone 'l
liri: [Tool Centre. 7] 10 % -

e Set Stepdown to 10.

e After the processing is I 1 | B e —
complete Cancel the = | [Toopath -] | I|
form When | after = Detect Material Thicker Than ID.D

ut Direction I imi VI
Curbirecs Cimb Expand &rea By IT

™ Final Profile Pass ——————————
’VIE\,-EW Z vI Allowance. | 1.0 Consider Previous 2 Heights

—I Area Filter - | I -

Filter: I Smaller Than - l
. ¥ .

Threshold (TDL IT Sorting I 3' vI Ordering IF‘ocket VI

Filier Gnly Endosed reas ¥ Type I Al jv

r~Tool Axis Direction I Auto - I
Tzl I'u'erh'ml g PreferencelMinimise Air Moves

Apply | Accept | Cancel I

Lel

I @) |

E@ Toolpaths

j : E:g:_:i . As soon as the Offset Area Clearance (Model) form is opened an

@ ;& >psote_a2  unprocessed Toolpath appears in the Explorer (the default name
il Toale has been changed to D50T6_A2).
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e Perform both a toolpath and ViewMILL simulation on the final Raster
Area Clearance toolpath.

e Select the ViewMILL Suspend icon # and No Image @ to return to
the PowerMILL session.

e From the Main pull down menus, select File - Save Project to update the
stored data.

The Project (D:\users\training\COURSEWORK\PowerMILL-Projects\Spkr-Core) has
now been updated to include the 3D Area Clearance toolpaths.

¢ From the Main toolbar select File - Delete All
¢ From the Main toolbar select Tools - Reset Forms.
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Area Clearance - Area Filter

This option is designed to filter out machining of confined areas that would involve small
movement of the cutting tool. In the following example it is applied to prevent a relatively
large tool attempting to plunge into a deep pocket area where a smaller tool would be a better
choice.

e Open the ‘Read Only Project:-
D:\users\training\PowerMILL_Data\Projects\MountingBlock-Start

e Save Project As:-

D:\users\training\COURSEWORK\PowerMILL-Projects\MountingBlock

e Activate the Toolpath named No-AreaFilter

The existing toolpath is
allowing the cutter to machine
into confined areas. This is
resulting in sudden sharp
changes of cutting direction
and excess loading on the tool.

Right click on the toolpath named No-AreaFilter and from the local
menu select Settings to open the original Offset Area Clearance form.
Select the ‘make a copy’ of the toolpath icon (shown arrowed below).

Tonol ; lead |

[ Create a new toolpath based on this one |

Rename the copy of the toolpath as AreaFilter.
In the form locate the Area Filter section (lower left corner) and input the
settings as shown below (Note; Filter Only Enclosed Areas is unticked).

tooltracks spanning a distance less than the Tool
iameter (TDU) will be filtered out and not appear
in the final Toolpath.

The effect of unticking Filter Only Enclosed Areas
means that the recessed areas running out to the
Block will be included in the filtering process.

Area Filtker

Filter |Sma|ler Than SI
Threshold (TOU)

Filter Only Enclosed Areas
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e Apply the Offset Area Clear Model form and once processing is
complete click Cancel to close the form.

Area Filter has been applied to prevent
the cutter attempting to machine into
confined areas.

There are however a couple of
undesirable spikes on the unfiltered
part of the toolpath. These can be
reduced by applying the Profile
Smoothing option.

Right click on the toolpath named AreaFilter and from the local menu
select Settings to open the original Offset Area Clearance form.
Select the ‘make a copy’ of the toolpath icon (shown arrowed below).

Tanl ! lead i

[ Create a new toolpath based an this ane |

e Rename the copy of the toolpath as AreaFilter-ProfileSmooth.
e Keep the same Area Filter settings switched on, and tick the Profile
Smoothing box with the Corner Profile slider set to 0.200.

High Speed M achining
Frofile Smoothing
Comer Radius (TOU) 0200 ]

Links | Smoath W

e Apply the Offset Area Clear Model form and once processing is
complete click Cancel to close the form.

The previously sharp corners around
the toolpath outer profile have now
been smoothed.
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e From the Main pull down menus, select File - Save Project to update the
stored data.

The Project (D:\users\training\COURSEWORK\PowerMILL-Projects\MountingBlock)
has now been updated to include the 3D Area Clearance toolpaths.

e From the Main toolbar select File - Delete All
¢ From the Main toolbar select Tools - Reset Forms.

Rest Roughing - Area Clear example

It is generally good practice to use as larger diameter tool as possible for the initial Area
Clearance operation. This ensures that the maximum amount of material is removed as
quickly as possible. In many cases however the larger diameter tool may not have full access
to certain internal corners or pockets within the component. As a result these areas will
require further roughing out with one or more, smaller diameter tool before sufficient
material is removed prior to running the Finish Machining strategies.

The Rest Roughing option creates a Roughing Strategy using a smaller diameter tool
referenced to a previously created machining strategy such that tool tracks will only be
produced locally within the remaining material (stock).

¢ Import the model WingMirrorDie.dgk from
D:\users\training\PowerMILL_Data\models.

e Create a Tip Radiused tool of Dia 40 tiprad 6 and Name d40t6.

¢ From the Main toolbar open the Block form and Calculate using Defined
by - Box to the full model dimensions.

¢ Reset the Rapid Move Heights and set the Incremental moves to Skim.

¢ In the Start and End Point form set the Start Point to Block Centre Safe
and the End Point to Last Point Safe.
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e From the Main toolbar select the Toolpath Strategies icon ﬁ
¢ In 3D Area Clearance select the option Offset AreaClear Model to open
the following form.

;-:' Offset Area Clearance [Model Machining] ﬂil
s e Enter Name
MName A
Gl D40T6_D1.
—Tool rLead In Moves

o] s | N e B[ ¢ Select Ramping.
_WEHSJ - approach Outside [& e Select Options

Tolerance [0.1 &l rrillng Heles o = ° Enter:-

’i---g 0.5 @ ‘ Dutput Hales IF Max' Zig -Angle 4!
o Follow Circle, and

1 Profile Smoothing
TStEpdonn Cotner Radius (TOUY '_0-050 AS ShOWﬂ be|OW

; oY 75.0 [ Hich Speed Machining Circle Diameter 0.6

MachneFiats [rovd =] | ' Ramp Opt... [2|[X]
| Stk e ane

Cut Direction | Climb hd —_— ) Max Zig Angle

—Boundary
o - | = ”/i] ; I—_, Follawr | i
£ Trochoidal Moves: | None - I'cle  w
Lirnit ITooI Centre vl 10 % -— | Circle Diameater -m

Trimming IKEED Inside VI I Rest L (TDU)
~Profiing [Fookath = =] Rarmp Length

yihen [fer | Finite [
Deteck Material Thicker Tham I 0.0

Cut Direction ICIimb - Length (TOLY
Expand Area By I 0.0

"I_ Final Profile Pass —————

IEVEFY 7 vl Sllowance | 1.0 Consider Previous Z Heights Zag Ang le

- | I - Independent
—I™ Area Filter
Filter ISmaIIerThan j ey dngle

Sorting I@; 'I Ordering | Pocket =
Treshofd (70w, [2.0 TDU = Tool Diameter Units
Filber @nly. Enclosed|treas, W Type I Al jv
~Tool Axis D"Edjml-““m |
Tool Axis I Vertical ﬁ Prefera\oell'“'linimise Air Moves j
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¢ Input or modify the data as shown in the sections arrowed above and click
Apply to create the Offset Area Clear toolpath shown below.

The Offset Area Clear strategy
using Type All follows both the
contours of both the Model and
Block then gradually Offsets
into the remaining material at
each Z Height.

—~— @

RMB on the toolpath and select
- sound IEMESET G Simulate from Start to bring up

..... 7 Patt - . .
o ¥ Activate the Simulation toolbar
Activate Workplane

S% Levely  setings. The toolpath simulation toolbar will open.

& stock| Recreate Block

e Switch the ViewMill On/Suspend icon from red 9 1o green E on the
ViewMill Toolbar, followed by the Shiny Shaded image icon |"~_*'“|

8| p40Ts D1 v| yi#f[psoTe e A DWPPRAY 1 a X

¢ Press the Play button to start the simulation.

The simulation of the toolpath will start with tool displayed, but this can be controlled by
toggling the light bulb on the tool entity in the explorer pane.

-8 Patterns
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The finished result indicates that the
current tool geometry is not suitable to
fully access some features (arrowed) on
the model.

As a result a further Area Clearance
strategy is required using a smaller tool
to continue locally into the remaining
areas.

This technique is known as Rest
Machining.

9

Suspend ViewMill _2_ B
Switch off the shaded image. L

Rest Machining using a Reference Toolpath

e Create a Tip Radiused tool of Dia 16, tiprad 3 and name D16t3.
e Right mouse click over the Toolpath icon in the explorer.

- | @] 4 /
@] MNC Program:

E»@ Toolpatl

B B 1> Daots_D1

5.4 Tools .

E 3¢l oaors S e Select Settings to reopen the Offset
@ ) >pers | Simibte fiomStart AreaClear Model form.

g Boundaries W Activate

[ Patterns Activate Workplane

EP Feature Sets /

“. Workplanes m @
H EE kp Parameters... |
1

Q Levels and Sets

e Select the ‘Copy toolpath’ icon.

Note; all associated items originally used to create the BRI F T RA T e N L
toolpath will be activated. : E_I
4

Taal Lead In Mave

2w toglpath based on this one
e Activate the new tool, D16t3.
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:d,' Offset Area Clearance [Model Machining] ﬂﬂ
g;g|.l Neme [D16Ts01 % Enter a new name D16T3_D1.
e — : rLead In Moves

[ s el Type [Rampng =] Optons.. | Enter:- Thickness 0.5 Stepover 1.0

e e Stepdown 5.0

rTolerances —
S Tolerance Ir ﬁ rilling Hales o -

{ﬂ - @‘ B The options arrowed control the Rest
_Iibe:olvle;_  pm _T_hgf,:;: ;:::;Tnggi gilachin.ing limits ‘by comparison with
——— S e previously defined toolpath

[Automatic =] 5.0 - D40T6_D1.

Machine Flats ILeveI vl Links [Smooth =

Cut Direct Iﬁ i Smoothing Alowance ——————
-

dtHirection jim 5 % ——

rBoundary A

[ -
Iﬂj I J J Trachoidal Moves |Mone -
Liirnit ITooI Centre vl 10 % N B

Trirmrmir IKee Inside VI A
. E ¥ Rest Machining =
~Profiing [Toolpath x| [pateDt -]
Wik IAﬂer VI
Detect Material Thicker Than ID.D
Cut Direction ICIimb vl

"l_ Final Profile Pass —————————— Expand Area By I 0.0

Every Z ¥ | Alowance | L0 Cansider Frevious Z Heights

™ AreaFilter - | I =

Filter I Smaller Than j

0y [zo Sorting I&ﬁ 'I OrderingIPocket vl ' ' '
Filter Only Enclosed ArE Typelm Type All IS' the Only avallab!e option
~Tool Axis DirecﬁonIAubj vl for the baSIC POWeI‘MILL llcense.

Wl I\i'ertial g Preference| Minimisg Air Moves j
Apply I Accept | Cancel |

~Untick Area Filter.

¢ Input or modify the data exactly as shown above and click Apply to create
the new Offset Area Clear toolpath shown on the following page.
e Cancel the form.
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e Save Project as:-
D:\users\training\COURSEWORK\PowerMILL-Projects\Wing_Mirror_Die.

e Turn ViewMill On (Green) 9 —>|j :

« Select the Rainbow Shaded Image <!
e Select the toolpath D16t3_D1 and Play the simulation.

$[otet3 01 47 v| g o673 Pl DEPPRIE s X

The ViewMILL simulation
shows this next toolpath
shaded in a different colour
where it has machined in
areas the previous toolpath
did not cover

The Reference Toolpath
finished to rough out
material closer to the
component form.

This will reduce the risk of
excessive wear or damage to
tools used for the subsequent
finishing operations.

e Select the Suspend ViewMill icon to return to PowerMILL.
e From the Main toolbar select File - Delete All
¢ From the Main toolbar select Tools - Reset Forms.

EXERCISE:-

Area Clearance with Area Filter and Rest Roughing

¢ Import the Model:-
D:\users\training\PowerMILL_Data\Models\Cowling
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Machining Set Up

e Create the following Tools:-
Dia 20 tiprad 3 named D20t3
Dia 12 tiprad 1 named D12t1

¢ Create and position a Workplane centrally positioned to the top centre of
the model as a more suitable machining datum.

¢ Define a suitable Block using the Box option.

e Apply Reset to Safe Heights in the Rapid Move Heights form.

Area Clearance Strategies

e Create an Offset Area Clearance strategy using the Area Filter options to
prevent the D20t3 tool from attempting to machine into the central
pocket.
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e Create another Offset Area Clearance strategy this time with the D12t1
tool with the Area Filter Options switched off and the Rest Machining
options switched on and referenced to the previous toolpath.

e Save Project As:-
D:\users\training\ COURSEWORK\PowerMILL_Projects\AreaClear-
Exercise

ViewMILL Simulation

e Perform a ViewMILL simulation on both of the Raster Area Clearance
toolpaths with the Rainbow shading option active. This will enable the user
to see exactly where the second toolpath (different colour) is removing
further material from the partially machined block.

The Rainbow
ViewMILL Shading
option displays the
resultant material
removal for each
toolpath as a different
colour.

¢ From the Main toolbar select File - Delete All.
¢ From the Main toolbar select Tools - Reset Forms.
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General information on Area Clearance Machining

The following is reference information for the many different options contained in the Area
Clearance form. This can also be found by using Help.

Thickness

Radial
Thickness

Tool
Q w ||D16T3 v
Tolerances

Tolerance | 0.1

Axial
D D.D Iﬂl /7 Thickness
= = i

| Enables/Disables Axial Thickness|
Stepower | 2.0 T

Thickness

Clicking the Thickness button on the Area Clearance forms opens the Axial Thickness box
allowing the user to set separate values for Radial and Axial thickness. This faclity is also
available on the finishing forms.

Z Heights
If Stepdown is set to Manual on The Area Clearance form, there are five ways of generating
Z Heights; Number, Stepdown, Value, Intermediate and Flat.

Number - divides the block equally into the defined number of Z Heights, the lowest of
which will be at the bottom of the block.

Stepdown - creates a Z Height at the base of the block and then steps up a defined Height in
Z. The setting Maintain Constant Stepdown causes the distance between all levels to
remain constant and will modify the stepdown to create evenly spaced levels as near to the
specified value as possible.

Value - creates a single Z Height at the defined value. You can specify as many Z Heights as
is required, but when using Value you must do so one at a time.

Flat - Identifies flat areas of the model and creates a Z height (+ thickness) at these values.
Intermediate - adds the specified number of Z Heights between existing Z Heights.
Appending Z Heights

Z Heights can be also be used from saved Area Clearance Toolpaths. When a toolpath is
activated the Append button becomes active.
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Profiling

A profile can be performed at each level to remove steps that will be left by the cutter Before,
During, or After a Raster - Area Clearance strategy. Additional profile passes can be
applied when machining either on either Every Z, or the Last Z level with Offset, Profile or
Raster strategies. Note: Offset and Profile strategies inherently follow the component
profile.

When

This determines when the profile pass takes place during machining. There are 4 options

None — No profiling pass is performed

Before — PowerMILL will perform the profiling first and then the raster path.
During — As the raster path is generated it will find profile paths as it goes.
After — PowerMILL performs the profile pass last.

Cut Direction
This determines the direction of the tool. Choosing a single direction will more than likely
lead to more lifts generated.
Any - this allows the cutter to travel in both directions allowing it to climb mill and
conventional mill.
Climb - this will force the cutter to only travel in one direction so that it is always
climb milling.
Conventional — this will force the cutter to only travel in one direction so that it is
always conventionally milling.

Final Profiling Pass
This option is held in the profiling area of the main area clearance toolbar and allows the user
to make an additional, final profiling pass to further reduce tool wear.

Allow tool outside block

The Allow tool outside block tick box is located in the Expert Area Clearance form,
which is opened by selecting the tab midway down the right hand side of the main form.
This enables the first pass of an Offset or Raster pass to be performed to the specified
Stepover, rather than the full radius of the tool.

-

Ramping
This provides a way to lead down onto a tooltrack where it is impossible to approach from
outside the Block at the full machining depth (eg within a pocket).

tj Tool

Ramp Length

| -

! Zig angle

Zag angle
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The Zig angle is the angle of descent along the machining direction as the tool ramps into the
material. There are 3 different types of ramp move following the geometry of the Toolpath, a
Circle, or a Line. If the length of the Zig angle is limited to a finite distance a ramp move in
the opposite direction, Zag angle can be applied.

The Ramp Length is defined as ‘Tool Diameter Units’ (TDU). For example, with a 10mm
diameter tool, A Ramp Length of 2 TDU’s would equal 20mm. Normally the Ramp Length
should be greater than the tool diameter to allow swarf to clear from beneath the tool.

Zag Angle

If a finite ramp length has been specified, then PowerMILL will insert Zag moves. The
default setting for Zag angle has the Independent flag set - which means the angle, is
defined manually. The default angle is 0 degrees. When unset, it will be the same value as the
Zig angle.

If Approach Outside is set, and where it is practical for it to operate without gouging it will
take priority over Ramping.

If the defined geometry for a Ramp move is such that it would cause a gouge then it will be
replaced by a Plunge move.

Machining Flats

The area clearance strategies in PowerMILL have an option that allows the user to control
the way in which flat areas of the model are rough machined. These are found on the area
clearance form under Machine Flats.

Import the model D:\users\training\PowerMILL_Data\Models\Flats.dgk
Create a 12mm diameter End Mill tool and name it EM12

Calculate the Block using the default settings.

Set the Rapid Move Heights and check Start/End Point is set to default;
Start Point - Block Centre Safe and End Point - Last Point Safe.

e From the Toolpath Strategies form, select Offset Area Clearance.
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e Fill in the form exactly as below.

! Offset Area Clearance Form [Model Machining] |EHX\

/\’f:j MName | Flats_Off
£
Toal Lead In Moves
EM12 A4 Type |Plunging % Options...
Tolerances Approach Outside
Tolerance Crilling Holes
Thickness Input
ouputroes [ ]
Stepover

C# |10 Stepaver High Speed Machining

[1Profile Smoothing
Stepdawn “orher Radius (TOWy _ 0.050

[Jsmoothing Allowance

25 %

Boundar
> RESCE Tool Overload
: >

Limit | Tool Centre

Trimming  kKeep Inside [Rest Machining

Profiling Toolpath
When | afte
i etect Waterial Thicker Than Stepdown

Cut Direction | Climb

CIFinal Profile Pass Expand Ares By Automatic |

Every Z Allowance Consider Previous 2 Heights Machine Flats | Off

- -
[ area Filter Lewel

Filter | Smaller Than Cut Direction srea

Threshold {00y [28 | sorting |8 v | ordering Pockst v Boundary
Filter Only Enclosed Areas Type| Al

Tool Axis Direction| Auto v

Tool Axis @ F‘referEnEE|M|n|m|se Air Moves w
[ Apply ] [ Accept } [ Cancel ] ° Apply and then CanCEI the form

It can be seen that with Machine
Flats - Off the toolpath has
ignored the flat surfaces of the
model. It has maintained a
constant Stepdown value and
completely performed area
clearance across the material
Block at each Z Height.

¢ Right mouse click over the Active toolpath and in the local menu select
Settings

Select make a Copy of the toolpath.

Change the Machine Flats option to LEVEL (This is the default).
Change the name to Flats_Level.

Apply and then Cancel the form.
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The Area Clearance toolpath
now removes material from the
Flat surfaces leaving just 1.1mm
this is equal to the thickness
plus the tolerance set in the
form. Where new slices have
been added, the toolpath clears
all the way to the edge of the
block.

¢ Right mouse click over the Active toolpath and in the local menu select
Settings

Select make a Copy of the toolpath.

Change the Machine Flats option to AREA.

Change the Name to Flats_Area.

Apply and then Cancel the form.

The Component is fully area
cleared at the general Stepdown
heights and locally to the edge of
the component Flat areas. This
provides a shorter toolpath
compared with using the Level
option.

e Save Project as:-
D:\users\training\COURSEWORK\Projects\AreaClearFlats
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PowerMILL Recycle Bin

In the explorer Right click over Toolpaths and select Delete All from the
local menu.

Use the same method to Delete All - Models and Stock Models

(Do not apply to the Tools section in the explorer).

i |
From the Main pulldown menus select:- | 1% "

Tools - Reset Forms.

Echo Commands

v Snapping

This restores all default settings in the forms without having to exit and re-enter.

Note: The Model and Toolpaths deleted from the explorer can at this stage be recovered as
they have been transferred to the PowerMILL Recycle Bin. If File - Delete All is applied
from the main pulldown menus all entities by-pass the Recycle Bin and as a result cannot be
recovered. Note: Certain items such as Stock Models cannot be transferred to the recycle bin.

Left mouse click on the Entity Recycler pane to open the Recycle Bin.
bl @ |

-~ Boundaries
=] Q\ Toolpaths
. @39 DaOTE D1

L
. @-2F DI8T3 Recyde Bin

£ g Models Delete
- i@ WingM

Right mouse click over an entity in the Recycle Bin to view the local menu
options to Recover or permanently Delete an item.

Recover a Toolpath from the Recycle Bin and check that it has been
reinstated in the Toolpaths section of the PowerMILL explorer.

Return to the PowerMILL explorer and if necessary, apply Delete All
separately again on Toolpaths and Models. (Do not apply to the Tools
section in the explorer).
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PRO - 3D Area Clearance

Introduction

Projects Similar to those saved earlier during the (basic) PowerMill part of the course will
be continued using previously unavailable options, exclusive to PowerMILL Pro.

Rest Machining using a Stock Model

An alternative method of Rest Machining is the use of a Stock Model instead of a
Reference Toolpath.
Benefits of using a Stock Model compared to a Reference Toolpath are:

¢ The remaining surplus material can be visualised and registered along with the
associated toolpaths.

e A Rest Path based on a stock model will account for all the previous operations on
the stock model not just one area clearance path.

e Operations created to different active Workplanes (3+2) can be used to create a
stock model. Toolpath Rest Roughing is restricted to paths using the same
workplane.

The following example will demonstrate the creation of a Stock Model up to the end of the
toolpath D40T6_D1 at which point it will be displayed as the Rest Material. The Rest
Machining toolpath D16T3_D1 will then be used as the basis for creating a new toolpath but
this time using the Stock Model.

e Open the Project:-
D:\users\training \PowerMILL_Data\Projects\WingMirrorDiePro_Start.

ﬂj‘ PowerMILL Warning: ﬂ

Project "WingMirrorDiePro-Start' is open read-only.
. Itis being edited by user 'dfb' on computer 'DELCAM.COM/CROC',

It can be saved only under another name, using 'Save Project
As..)

?K I

e Select OKin the
PowerMILL Warning form.
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e Save Project As:-
D:\users\training\COURSEWORK\PowerMILL-Projects\WingMirrorDie

In the explorer, Activate the toolpath D40T6_D1.

@' MC Programs
(£-+8 Toolpaths

SVAESE 1> D40T6_D1

/)" & DIET3.D1  D40T6 D1

: ¥ Tools
E‘ o __ U . T6 Simulate from Start
v

D@ g lJomn M
O Boundaries Activate Workplane

e In the PowerMILL explorer right mouse click Stock Models to open the
local menu and select Create Stock Model.

@' Levels and Sets
[ i Models
= Stock Models

Stock Model Names

Deactivate
Draw All
Undraw All

Delete All

¢ Inthe PowerMILL explorer right mouse click the newly created Stock
Model icon and from the local menu select Apply — Active Toolpath
First.

E‘ Stock Models
T em

¥ Groups 1
-2 Macros
v Activate
v Draw
Drawing Options »

Shiow Rest Material
Refresh Rest [Material
Rename

Volume

Export

Caloulate

Apply 3 Block
Active Toolpath First
Active Toolpath Last M)

Set Tolerance
Set Stepover -

e From the same menu select Calculate to create the Stock Model as
shown below.
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e From the same menu again select Show Rest Material to display the
Stock Model as shown below.

54 Stock Models
LR ‘
¥ Groups 1 I
--{ﬂ Macros
v Activate
w Draw
Drawing Cptions L4

Refresh Rest Material r!

e From the same menu again select Drawing Options - Shaded to display
the Stock Model as shown below.
5-& Stock Medels |
& &8 vagos v Activate |
4 ing Options Wireframe
v Show Rest Material
Refresh Rest Material E !
¢ In the explorer Activate the toolpath D16T3_D1.
e Right click the toolpath icon and from the local menu select Settings to
reopen the Offset AreaClear Model form.
[ ]

Select the ‘Copy toolpath’ icon (shown arrowed below).
&:‘. Offset Area Clearance [Model Machining]

<)

"Tool Create a new toolpath based on this one|
[ 11D 1sT3 - A
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¢ Inthe form locate the Rest Machining section (lower right corner) and
change the settings to use Stock Model - 1 as shown below.

¥ Rest Machining

[stockModel = |1 =]

Detect Material Thicker Than IT

Expand Area By |T

Consider Previous Z Heights ——————

% [

e Click Apply to create an alternative (more efficient) Rest Machining
toolpath named D16T3_D1_1.
e Cancel the Offset Area Clearance Form to reveal the following toolpath.

Although the Stock Model has been used to define the area to be machined the new toolpath
is not automatically added to the Stock Model. This is carried out as a second operation if

required.

¢ Right click over the active toolpath, D16T3_D1_1 in the explorer and
select Add to - Stock Model.

i i%ﬁf&?:ﬁi
WEF 1- 01613 01 1)
T It is also possible to Right Click on the named, Stock
S ™™ S Model in the explorer and select Apply — Active
b S :(:.,:Wkw toolpath Last. At this stage the Stock Model will
o e :::M disappear from the screen.
. e
B e S — . ¢ Right click over the named, Stock Model
= ’ in the explorer and select Calculate to
P create the updated Stock Model as
R shown.
v Batch Group

Load Settings Folder

Cbmbinbion
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e From the Main toolbar select File - Save Project to update the Project:-
D:\users\training\COURSEWORK\PowerMILL-Projects\WingMirrorDie

Offset Area Clearance — Offset Type Model

This variant of the Offset Area Clearance is designed for High Speed machining. It provides
a very consistent tool loading at the expense of an increased number of rapid moves across
the component (This is accepted practice in High Speed applications). This strategy if applied
correctly will dramatically help to minimise wear to both the tooling and machine.

The strategy is based on the profile around the component at each Z Height being continually
offset out to the limit of the material Block.

e Import the model Handle.dgk located in PowerMILL_Data\models.

¢ In the explorer - Activate the Dia 16 tiprad 3 tool d16t3.

¢ From the Main toolbar open the Block form and Calculate a material
Block to the full model dimensions. Lock the Z max and Z min values,
enter an Expansion value of 10 and Calculate again.
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¢ In Rapid move heights, click Reset to Safe Heights, and in Incremental
Heights set the Rapid Move Type to Skim.

¢ In the Start Point form set both the Start Point and End Point to Block
Centre Safe. @
From the Main toolbar select the Toolpath Strategies icon.

e From 3D Area Clearance select the option Offset AreaClear Model to
open the following form.

e Enter data in the forms exactly as shown on the next page.

e The Stepdown is to be defined manually as a single level from the Area
Stepdown

Clearance Z Heights Form (If Z Heights already
exist, Delete them by clicking the red cross located to the lower right of
the form).

& L

@t Offset Area Clearance [Model Machining] x| :g — llll
%8| | Name W e |40—

e rleadInMoves — R clow [

Iulj |Dlﬂ3 =] g Type |Ramping j‘ M Circle Diameter l—
Approach Outside [V ety o

r~Tolerances
Tolerance ID. 1 S:l orlingHales ————————— N
Thickness Inpuit | - Ramp Length ———————
Finite [~
’i"'gl I = @ Qutput Holes I
Lenath (TOU) | 2.0
Stepover
r #I 10 Stepover | 2.0 ‘ rHigh Speed Machining————————————
’7 i 1 Profile Smoothing——————————— -Zag Andle
B lm g - Carnier, Radius (THL] ._0-050 Independent.
™ Ifax Angle I'I'.'I'

IMachine Flats ILe-.-'eI 'I Links ISmoaﬁq -
— : Smoothmalauance TDU = Tool Diameter Units
Cut Direction ICIlmb vl ’—r i F&\TJ—
[ Boundary Accept | Cancel |

B3 -
! j I =] i Trochoidal Moves |N0ne E\\
Limit: ITDD| Centre ‘l 10 % - —
&% Area Clearance 7 Heights 2=l
Trimrming IKEEp Inside vl .
- I RestMachinng ————————————— | [ Create PHejghts Type | Height ]
[~ Fromiing
a [Toclpath =i =~ Defined by [Vaue =] [30 23

ke I.-ifter vl
Detect [Material Thicker Tham | 0.0
CutDiracton [cClimb -] Constant Stepdonn 7
S Expand Area By | 0.0 .

™ Final Profile Pass
[ A

w| Allowance I L0 Cansider Frevious Z Heights [ Reference

— /
ITDU'DEﬂ'\ j I j
; - | I -
I AreaFiter — [Apperd Al =] Calaulate
Filter: ISmaIIE| Than j
% Delete By Picking
Threshold (ToUy [1.0 sortng [} :l' Ordering [Focket =] ﬁ :_j X
A
Filter Gy Enclosed &reas ™ P IMUdEl i

Toal Axis
. z Draw [~
’7 Tool Axis IVerhm\ @ ‘ Preference [Ainimise Air Moves gl
Close /

o | et |
. /

e Select Type as Model.

¢ Input Defined by Value 3.0 and select Calculate (After selecting Delete All
existing Z Heights).

e Check the data as shown previously and click Apply then Cancel.
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Note: The toolpath is shown with
the Leads and Links undrawn.

e Select anlso 1 view as shown and right click over the toolpath icon in the
PowerMILL explorer to open the local menu.
e Select Simulate from Start and click the > to run the animation of the
toolpath (select the Esc key to stop the simulation).
H;. l.l i The tool will continuously climb mill, starting each
tool track a distance from the material block to

Dg :Ejlr;i;n;s allow the tool to reach optimum Feed Rate before
i contact. Each pass will benefit from having a
D16t3_hsm1 . .

[]J, :m‘k@ consistent material removal rate. The strategy can be
O Boundiies pigaled further improved using advanced settings to
lllll #§ Pattems progressively smooth away sharp corners and
]j) Feature Sefs Py straighten tool tracks as they offset further away
-4 Workplanes Actvate Workpiane from the component form. A specified deviation
o £ Levels and sets : from ‘Fhe nominal stepover will be required to allow
T or i,

e Right mouse click over the Toolpath icon in the explorer to open the local

pull down menu.
e Select Settings to reopen the Offset AreaClear Model form.
e Select the ‘Copy toolpath’ icon (shown arrowed below).

— rHigh Speed Machining
@ Offset Area Clearance [Model Machining] ¥ Profile Smoothing

i 0.200
Corner Radius (TDU) 1

@ @\l Links ISmooﬁw vl

v smoathing Allowance

25 % ———JI—

Tioal !
’7 [ [Create a new toolpath based on this one]

e With the Offset Area Clearance form open again, tick the Smoothing
Allowance option leaving the slider value as default (25%).
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e Click Apply to create a new toolpath d16t3_hsm1_1 with the improved
25% smoothed strategy.

Compare the 2 3D Offset Area

: Clearance (Type - Model) toolpaths
QN\\\\' noting the progressive straightening of
o >\\\\\\\\\& tool tracks on the second strategy (25%

smoothing applied).

|

)

\\\\\\

f

|

e From the Main toolbar select File — Delete All to delete all data from the
current project.

e From the Main toolbar select Tools
Reset Forms

Draw | Tools Help

6 ] Echo Commands
Resek Forms

(-

-

L]
=

¥ Snapping

This restores the original PowerMILL settings in the forms without having to Close and
restart.

Machining Flats

In PowerMILL Pro it is possible to locally Area Clear machine the flat areas to their exact
height. This allows the user to rough the part first using Machine Flats set to OFF and then
clear the flats in a second operation.

e Open the Project:-
D:\users\training\PowerMill_Data\Projects\AreaClearFlats_Start

ﬂ PowerMILL Warning:

Project 'AreaClearFlats_Start' is open read-only.
l 4 [Itis being edited by user 'dfb’ on computer 'DELCAM.COMJCROC'.

It can be saved only under anather name, using 'Save Project
As...!

e Select OK'in the PowerMILL Warning form.

e Save Project As:-
D:\users\training\ COURSEWORK\PowerMILL-Projects\AreaClearFlats_Example
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¢ Right mouse click on the toolpath FlatsArea and from the local menu,
select Activate before selecting Settings.

¢ Make a Copy of the toolpath.

e Open the Expert part of the form by pressing the arrow at the right.
Select Flat from the Slices options pulldown.

rSlices
[Model =]
Mode!
Feature Set
Boundary
Pattern
File
Toolpath

Hl &

Allow Tog

£l el

"Delete By Picking ——{

e Calculate the slices.
e Apply and Cancel the form.

The Area Clearance now creates only
the Flat areas.

At the moment the cutter profiles
around the edge of the holes. If
preferred the strategy can be changed
to Ignore Holes and pass straight over
them.

e Make a Copy of the toolpath.
e Open the Expert part of the form by pressing the arrow at the right. »
¢ Tick the box next to Ignore Holes.

Flat MaCh‘”‘”EIIAE“‘?”EBIU'OS?;”Q; - The Threshold in TDU (tool diameter units) tells
o TR MR TE PowerMILL what size of holes to ignore. With the tool
Apgitaesn Aotz (TOL) EM 12 selected and the Threshold set to 2, PowerMILL

Flat Tolerance will ignore any hole less than 24mm in diameter.
Ignore Holes

Threshald {TDUY

e Apply and Cancel the form.
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The cutter now passes over the top of the holes without lifting, producing a smoother
toolpath. Note that Ignore Holes refers to the slice definition at the top of the holes. The flat
base of any hole will still be machined if the cutting tool daimeter is small enough to fit the
bore.

If there is a large amount of material remaining on the top of the flat areas, then several
passes at different heights can be made to reduce the tool loading during the Area Clearance.

e Make a Copy of the toolpath.
e Open the Expert part of the form. »

e Select Multiple Cuts.

v Multiple Cuts
e Fill in the remaining options as Mumber OF Cuts |3

shown.
Stepdown IT
Final Stepdown W I 1.0

As the Flats are being machined using several passes it is a good opportunity to finish them to
size on the depth (Axial thickness 0) but still leave Imm on the sides (Radial thickness 1).

i
[ Cr—

[10 J [oo
/

¢ C(Click the Thickness icon to activate Axial Thickness (0).
e Apply and Cancel the Area Clearance form.

3.36 Issue PMILL 9



PowerMILL 3. 3DArea Clearance

The Flat, Area Clearance strategy is
repeated at the 3 specified heights
controlled by the Stepdown options.

Flat Tolerance

It should be noted that by default, the PowerMILL - 3D Area Clearance strategies will only
detect perfectly flat surfaces. Surfaces that are not quite flat dimensionally will not be
recognised unless the Flat Tolerance is set with a suitable value to allow for the deviation.
This option is found on the expert page of the 3D Area Clearance form.

Flat Machining Advanced Settings
Allow Tool Outside Flat [

Approach Allowance (TDL) I 0.058

Flat Tolerance I 0.0

General information on Area Clearance Machining

The following is reference information for the many different options contained in the Area
Clearance form. This can also be found by using Help.

Restrict Tool Overload (PowerMILL Pro)
With Restrict Tool Overload ticked as the tool reaches
gsﬁowl an specified overload situation PowerMILL
[ automatically inputs a trochoeidal path to eliminate full
width cuts. This will occur in corners, narrow channels,
slots, etc and the degree of movement is controlled with
the slider as a percentage value in the form. This option is
only available if Type - Model is active.

Trochoidal Maves IF'.estrin:t Cverload j

10 % g
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4. Finishing Strategies

Introduction to Semi Finishing / Finishing Strategies

Finishing strategies machine the actual component form and where applicable, follow on
from the Area Clearance operation. Suitable values are required to control the accuracy and
amount of excess material to be left on a component by a toolpath. The parameters used for
this purpose are called Thickness and Tolerance.

Thickness is the amount of
extra material specified to
remain on the work-piece after
machining. This can be applied
generally (as shown), or
independently as separate
Radial and Axial values within
the machining options.

It is also possible to assign
additional Thickness values to  Thickness
groups of Surfaces on the
actual model.

Coarse Tolerance Fine Tolerance

Tolerance controls the accuracy to which the cutter path follows the shape of the work-piece.
For roughing a Coarse tolerance can be used but for finishing a Fine tolerance must be used.

Note where the Thickness value is greater than 0 it should always be greater than the
tolerance value
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Raster, Radial, Spiral, and Pattern Finishing.

Introduction.
This section will cover Finishing strategies created by the downward projection of a
Pattern, which include four types, Raster, Radial, Spiral and (user defined) Pattern.

PowerMILL generates the toolpaths by projecting a wireframe form down the Z-axis onto
the model. The standard patterns applied in Raster, Radial, and Spiral are achieved by
entering values directly into the Finishing Form. The resultant Pattern can be displayed by
selecting Preview before executing the command by selecting Apply. The Pattern option
requires a user-defined geometric form (active Pattern), which is projected down Z onto the
model as a toolpath.

Typical previews of the four Pattern strategies are shown below as viewed down Z.

Raster Radial

Spiral Pattern (User Defined)

Radial, Spiral, and Raster finishing operate in exactly the same way by projecting the
standard Pattern down Z onto the model. The more commonly used Raster finishing
strategy will be used as an example in the next section.
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Raster Finishing

¢ Delete All and Reset forms.
¢ From File select Open Project and browse the form, to select the
Project:- D:\users\train\PowerMILL_Data\Projects\Chamber_Start.

= [3) Projects
%5 | chamber_start This time the example starts from an existing Project.

e Select OK on the form that appears informing that the source Project is
read-only.

:gfl PowerMILL Warning:

Project 'chamber_start' is open read-only.

r lb It is being edited by user 'dfb’ on computer 'DELCAM.COM/CROC",
It can be saved only under another name, using 'Save Project
As.)

y L= ]

The model and tool stored in the imported Project are displayed.

e From File select Save Project As:-
D:\users\training\ COURSEWORK\PowerMILL-Projects\chamber

e Calculate a Block to default Box — Model settings.

i g aster Finishin
e Select the Toolpath Strategies icon from the W &S Ereser Fshing

top toolbar.

| 2.5D Area Clearance | 30 Area Clearance | Driling | Favourites | Finishing |P0rts |

£330 Cffset Finishing Q, I:I
QCDnstant Z Finishing
!»Corner Along Finishing Prresvie
pCorner Pencil Finishing
FCorner Stitch Finishing
Pattern Finishing
%Radial Finishing
i ter Finishing
2} 3piral Finishing
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e Select the Raster Finishing icon then OK.

i Raster Finishing Form

PowerMILL

Mame | Raster_basic |

Perpendicular Pags « « e
Perpendicular Pass [

Shallow Angle

Optimiza Parallel Pass [

-~ Tolerances- -
: Tolera

CTENTESE e

Art Radius

Boundary -

e
Trimmming [keep nside ] ;¢ arc it

B . arc Radius (TDUY 0,050 _
Leads and Links -~ et =
: lierrilits

- COrners =

- Tool Axis -

Dloraw

[. Apply ] [ Accept ] [ Cancel ]

e Name the toolpath
Raster basic.

e Enter the Tolerance
as 0.02 and
Thickness as 0.

e Enter Ordering - Two
Way.

The default tolerance of 0.1
will give a fairly coarse
surface finish. For a finer
finish a lower value such as
0.02 is used. A thickness of 0
will machine the material to
size, within the tolerance.

e Select a tool Stepover

of 1Tmm.

e Apply and Cancel the
Form.

On closer inspection the toolpath
contains sharp changes in
direction.

Selecting the Arc Fit option in the form can eliminate these.

¢ Right click over toolpath Raster_basic in the explorer and select Settings

from the available menu.
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e Select the Copy Toolpath icon from the form.

MName | Raster_arcfit |

sge[00 | Rename the toolpath Raster_arcfit.
Start Corner

Perpendicular Pass
Perpendicular Pass (]

.| e Tickthe box Arc Fit and edit the Arc Radius to

Optimise Paraliel Pass 0.1 (Use keyboard <«— = to fine tune to exact
Ordering valu e)
[00_ ] The Arc Radius (0.1) is multiplied by the tool diameter
S (12mm) to give a final radius of 1.2mm.

Arc Fit[Y] This option is particularly good for HSM (High Speed
Machining).

Arc Radius (TOUY

e Press Apply and Cancel.

e Zoom into the same area as previous to see the changes.

\Y/

c
1«

Before Arc Fit After Arc Fit

Where the toolpath is stepping over it is lifting up to the Safe Z height each time. This is
wasting time putting in these unnecessary lifts. To make the toolpath more efficient the
Leads and Links can be altered.

e Select the Leads and Links icon from the top toolbar. .@ .|

e Select the Links tab on the form. '

&¥ Leads and Links 2lx|

Z Heights I First Lead In | Lead In I Lead Dutl LastLead Dutl ExtensionsiLinks I

ShortiLong Threshold [ 10.0 short [Cradar Arc =l e Change the Short links to Circular

Retract and Approach Moves ———————— Long Ih Arc
Morg [Toa e o] | ot [5om 2]
¥ Automatically Extend i
[ Maximum length | 250.0 \
RevectOtnce [00 e Change the Long and Default links
Approach Distance ID.D to Skim.
| &rc Fit RapidMoyes ——————————
Arc Radius (TOWY IT

¥ Gouge Check
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e Apply Links and Accept the form.

Most of the lifts have been eliminated hence saving time and a
circular arc has joined the links between adjacent toolpath
tracks.

The next stage is to Simulate the latest, Active toolpath, Raster_arc fit.

It | @] <]

----- @ MC Programs

£ Toolpaths To Simulate the toolpath,

o) ¢ B Raster_basi rlght_cllck over the toolpath
SV 1> roster orcit icon in the explorer area,

=47 Tools it and select Simulate from
- k) > b2 Start.

-’ Boundaries

..... 7 Patterns v .ﬁ.ch'uate

- Feature Sets Activate Workplane

..... “ Worknlanes

When the Simulate from Start is selected the toolbar will appear at the top of the screen, and
the toolpath can be Simulated using the Play button.

| [Raster_arcit v gi[oni2 v| DI04l 1> <4 pb KAPM PN

When the simulation has finished it will be observed that the tool remains at the end of the
last retract move. To send the tool back to the Start Point either press the Home key on the
keyboard or select the Go to beginning button on the Simulation toolbar.

To simulate the cutting moves locally and in more detail, it is possible to attach the tool to
any position along the toolpath and use the Left/Right Arrow keys on the keyboard to make
the tool move backwards or forwards along the toolpath.

e Position the cursor at the required start point along the toolpath and right
click to open the Toolpath pull down menu.

Note; When the menu is accessed directly from the toolpath in the graphics area, the first

option is Simulate from Nearest Point instead of Simulate from Start.

e Select Simulate from Nearest Point.
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Simulate from Mearest Point

v Activate
Activate Warkplane

Settings...
Parameters...

e Use the Left and Right arrow keys to move the tool forwards and
backwards along the toolpath.

Pattern Finishing

This technique requires a user defined Pattern for projection onto the model as a toolpath.
This option can be used for applications such as scribe lines, lettering, and non-standard tool
strategies. A Pattern is created either from within PowerMILL or as imported Wireframe
data.

¢ Delete All and Reset forms.
¢ Import the Model:
D\:users\training\PowerMILL_Data\Models\swheel.dgk.

The component is circular as a result of
which the Block - Z Minimum and Z
Maximum will be developed as a Circular
billet.

o

e Select the Block icon from the top toolbar.

Il
Defined by I Cylinder - l f_

Linits . e Select Defined by — Cylinder.
Min Max Leng
X |-62.49933 & 6243993 & 1249999 &
. : — :,mgggl :124 — The default Radius value represents the best
' El N ' = cylindrical fit around the component achieved when
2leo [ Tec @l =0 Bl e Caleulate button is clicked
o o
r~ Cylinder Parameters ]
e Select Calculate.
CentreYID.D %-l % =% \\
~Estmate Lints ¢ To provide more stock on the base
roeence [o.1 e [Pt <] Modify the Min Z value to -1, Lock the
Expensan [0 value, and Accept.
Draw V' Opadty J—

Accept | Cancel |
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e The Block can be displayed as wireframe or of variable Opacity up to
solid, depending on the position of the Opacity slider switch.

Before the Pattern finishing strategy is created, a preliminary Area Clear strategy is
required to remove the bulk of the material, leaving 0.5mm, followed by a Semi Finishing
Strategy leaving 0.2mm prior to the final Finishing.

The object of this Pattern exercise is to consolidate some of the training covered earlier as
well as allowing the user to simulate the Pattern strategy at the correct stage in the overall
machining process.

e Define a tool of Diameter 10 and Tip Radius 1, Named D10T1 with Tool
Number 1.

e Define a Diameter 6 Ball Nose tool Named BN6 with Tool Number 2.

e Activate the D10T1 Tip Radius tool.

¢ In the Rapid move heights :—ﬁ select Reset to Safe Heights.

e Calculate an Offset AreaClear Model toolpath using the following
parameters: Name - RoughOp1, Tolerance 0.1, Thickness 0.5, Stepover
5.0, Stepdown 1.0, and Cut Direction Climb.

e Simulate the toolpath in Viewmill to
give a result similar to as shown left.

e Activate the BN6 Ball Nose tool.

e (Calculate a Spiral Finishing toolpath
using the following parameters:
Name — SemiFinishOp1, Tolerance
0.02, Thickness 0.2, Stepover 1.0,
Centre Point X 0 Y 0, Radius - Start
62.0 and End 0.0, and Direction
Clockwise.

e Simulate this new toolpath in Viewmill.
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¢ Right click over the Semi Finish toolpath in the explorer and select

Settings.

¢ In the Spiral Finishing form select the Copy icon.

e Enter a new Name - Finish, change the Thickness to 0.0 and Stepover to
0.5 then Apply and Close the form.

e Simulate the final toolpath in Viewmill to give this result.

A Pattern finishing strategy will be
now applied to machine the text,
Engraved into the component.

A suitable, pre-defined Pattern will be imported for use with the strategy.

¢ Right click the Pattern icon in the explorer and select Toolbar....

5;] ®® ‘When Toolbar is selected off the Pattern menu it loads a new
MNC Programs . . .
& Toolpathe toolbar into PowerMILL. The toolbar contains icons to create an
T U oo empty Pattern and insert different types of wireframe entities.
v = ene

O bounares The toolbar can be removed from the screen by clicking the small x
7 T on the right.

SRS

§ FEalre  patterns

g- waorkple
£7 Levels
g Models

& sock v

SF Groups
=8 Macrog,. Pattern Names 3

e " I pH COCCORL| PR ¥

Undraw All

Create Pattern

Edit L3

Create Folder

Delete Al

e Select the Create pattern icon |ﬂ .

=

e Click on the Insert file into active pattern icon =
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¥ o

Files of type: | Dieleam Wireframe [*.dak.” psmadel:doc. det | %

4. Finish Machining Strategies

PowerMILL

e Double click the Patterns folder and
then select Engrave.dgk.

Z2][X]
@ e Select the eg button.
e Select Open.

_m'h‘k-_uj | - J

Tolerances
Tolerance I 0.02 &l

value.

Create a Pattern Finishing toolpath.

@ Pattern Finishing

2]

Name I EngraveOp1

[ Drive Curve
Lse Toolpath 7

Pattern |1 vl ml
Ordering IPatbern vl

Pocket Machine [+

The Pattern is made up of 2D geometry and is
positioned at the bottom of the Block. This will be
projected along Z through the 3D model form to
create a single toolpath with a negative Thickness

Define a Ball Nose
tool with Diameter 1
called BN1 and make
this Tool Number 3.

Select a Pattern
Finishing strategy.

Enter the Name —
EngraveOp1.

Enter the Tolerance
as 0.02 and
Thickness as -0.4

Select Pattern 1 (if not
already selected).

With Automatic set
the pattern will be
Dropped / Projected
onto the model.
Select Apply then
Cancel the form.

Thickness U [ Lower Limit
""Dl I_U'4 g Base Position IAummaﬁc vl
fcial Offiset ID.D
[~ Stepover
Stepover I | - Gouge Avoidance
Gouge Check W
r~Boundary Strategy ITI'a-:e vl
I\,Jlj | ] | Upper Lt T~ [0.0
Trimming IKeep Inside j ~Multiple Cuts
[Made IOf'f 'l
rLeads and Links
Lead In lNone— [awimunn Stepdawn I 1.0
Hurnber OF Cuts = I 10
Lead Out INone
Shart Links ISaFe
Long Links ISaFe
Tool Axis
Tool Axis I\i'erﬁal ﬁ
Preview [~ Draw
Apply I Accept Cancel |
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By entering a negative Thickness the tool will machine into the previously finished surface.
This is frequently used for engraving, or to achieve a spark gap when machining part of a
component as an electrode.

¢ Open the Leads and Links form and Apply the Short, Long and Default
Links to Skim.

The Pattern has been de-activated to
enable a better visualisation of the
toolpath.

e Save Project as:-
D:\users\training\COURSEWORK\PowerMILL-Projects\ PatternMachining
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Pattern Exercise

The same imported Pattern will be used to engrave text into a telephone handset.
The Pattern, ‘Engrave’ used earlier will be out of position, but can be moved using the
options on the Pattern - right click menu.

Right Click Models on the Explorer and Select Delete All.

Use File - Examples and load the model phone.dgk.

Deactivate Toolpath EngraveOp1.

Reset the Block, Rapid Move Heights and the Tool Start Point.
Generate a Pattern Finishing toolpath leaving all values as before.
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3D Offset and Constant Z Finishing

In this chapter 3D Offset and Constant Z finishing strategies will be applied to a model that
consists of a combination of flat and steep areas plus a pocket with vertical walls. A
Boundary will be created and used to limit the 3D Offset toolpath to the flatter areas leaving
the remaining steep areas to be machined using the Constant Z strategy.

3D Offset Finishing

3D Offset Machining defines the tool Stepover relative to the 3D surface shape providing
consistency over both flat areas and steep sidewalls. In this exercise applying this toolpath to
the complete model without using Boundaries would not be recommended. Although this
toolpath maintains a constant Stepover there is nothing to prevent the tool plunging with a
full width cut into the deep pocket area.

e Delete All and Reset forms.
e From File — Open Project and in the form browse to:-
D:\users\training\PowerMILL_Data\Projects\Camera_Start

GE PowerMILL Warning: ﬂ

Project 'CameraStart_Pro' is open read-only, The PrOjeCt is Locked and cannot be
l % Itis being edited by user 'dfb’ on computer 'DELCAM.COM/CROC', . g .
modified unless saved as a new file (or
IAtscallw be saved only under another name, using 'Save Project the Original PrOjeCt’S LOCk flle iS
deleted).

e Select OK to load the existing Project into PowerMILL.
e From File — Save Project As:-
D:\users\training\COURSEWORK\PowerMILL_Projects\Camera_Example

The Project already contains
an Offset Area Clearance
strategy along with any
associated Settings.

This model is a good example where it is a better option to use more than one finishing
strategy. 3D Offset (for shallow areas) and Constant Z (for Steep areas) will be used and
they will be they will be kept separate using a Boundary.
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e Activate the existing Offset Area Clearance, Toolpath and Simulate the
toolpath in Viewmill.

The Viewmill simulation should look
something similar to this.

o Define a Ball Nose tool with Diameter 10 called BN10.

Use of Shallow Boundary to define specific Machining Areas

Specific Finishing strategies are more effective on either

L [ I_‘ = LY
2R Boundaries| | Steep or Shallow parts of the 3D component model. For
? e — example, Constant Z finishing is most effective on steep
4 Workgane Toobar.. sidewalls while Raster Finishing is most effective on
i-£7 Levels and Boundary Block shallow areas.
@ Models | Baste e e Boundary. | Rest A Shallow Boundary will be created to discriminate the
.‘ StockMode  Boundary Names b Selected Surface : . s s .
B oy | areas most suited to the individual machining strategies
: Balch Process Shouette Q used. This type of Boundary is calculated taking into

o & Maros Invalidate Al
(MR collson sefe account the Active tool.

AL dim

There are several other types of Boundary options available to suit various applications and
these are covered later in Chapter 6.

¢ Right click on the Boundaries icon in the explorer and select
Create Boundary -> Shallow.

1. Shallow Boundary |E|[Z|

Upper Angle
Lowwer Angle
Tolerances
Tolerance ¢ |nput a Tolerance 0.02.
Radial Thickness

txial Thickness ° TICk the Use Axial Thickness bOX and enter

Use Axial Thickness

T@l Radial Thickness 0.5 and Axial Thickness 0.

¢ Input the Name - ShallowBN10.

[CILimit Boundary

[ automatic Collision Checking

[eo ]

[ Apply ][ Accept ][ Cancel ]
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! Shallow Boundary [2|[X]
‘-_i'_JLName | ShallowBh10 .

Upper Angle | 30.0

|_A Shallow Boundary defines segments from areas on the
model that are defined by an Upper and Lower threshold
angle. It is therefore specifically suited to steep walled and
shallow surface machining techniques.

Lower Angle 0.0
Tolerances

Tolerance | 0.02

Radial Thickness | 0.5

. axial Thickness | 0.0 With Radial Thickness set to 0.5 the stock thickness left
Use axial Thickness on the sidewalls from the roughing will not be machined at
Taol this stage.

)~ | v

e Make sure that the correct tool is Active, in
this case BN10.

ClLimit Boundary

[ sutomatic Collision Checking

e Apply and Accept the form.

apply [ accept ][ cancel |

With the model and toolpaths undrawn the Boundary should look something like this. It is
made up of numerous segments each one dividing the model into steep and shallow areas.
Any of which can be selected and individually deleted at any time (only before being
assigned to a toolpath).

2

e Select the Toolpath Strategies icon from the top of the screen.
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e Select a 3D Offset Finishing strategy from the form then OK.

@ 3D offset Finishing 2]
%@ Mame |3DOf'fSEt_BNID ° Enter the Name
| - [ 3DOffsetBN10.
Tool
r Spiral [
1] -] lere =@ —— i Select Direction
Tolerances tO Climb
Tolerance ID-UZ &l Patternl 'IE
T Start an Pattern I e Enter a
[ﬂ [0 4  EEEE Tolerance 0.02.
[ Stepover e Entera
swor 10 T Thickness 0.
r~Boundary %

Ig j [shallowtni10 ‘%I—Q- Notice that the newly

e S| —— | created, Active
—Boundary is

~Leads and Links automatically selected
LeadIn [None for use. If a different
leadout o Boundary is required it
. : can be selected from
ShortLnks. [Skan the pull down menu.

Long Links ISkiITI
7 e Select the Leads
__and Links icon
Tool Axis

o and set the Lead
Tool Axis [Vertical ﬁ In & Lead Out to
None, and Short

Links & Long
Links to Skim.

Presiew I~ | Draw

Apply I Accept | Cancel

e Apply and Cancel the form.

The toolpath is calculated following the
contours of the Boundary segments and is
produced only on the shallow areas of the
model.

Further improvements can be made to this
toolpath with respect to the Links between
toolpath tracks. At the moment they are all
at Safe Z.

]
e Select the Leads and Links icon from the top of the screen.
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e Select the Links tab and change the Short Links to On Surface, the Long
and Default Links to Skim.
e Apply and Accept the form.

The toolpath has now is now more
efficient with the rapid moves at
skim height and the short links
being forced onto the surface.

e Simulate the 3D Offset toolpath in Viewmill.

Constant Z machining
Constant Z machining projects each tool track horizontally onto the component at fixed
heights defined by the Stepdown.

STEFPOVER
- STEPOVER
=
=
]
g
[ T
'_
[na)
-1
e
E#

As the component surface becomes shallow the actual tool step over increases until it
becomes non-existent on flat areas.

It is possible within the Constant Z finishing form to apply a variable stepdown by applying
a Cusp tolerance in conjunction with a max and min stepdown. While this will generally
provide a more consistant stepover relative to the angle of the model it will not help at all for
very shallow or flat areas.
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& New [THE

| 2,50 rea Clearance | 3D Area Clearance | Driling | Favourites | Finishing | ports |

al___|]

B corner Along Finishing Previen
& cormer Pencil Finishing
[E% cormer stitch Finishing
[EZpattern Finishing
[R.adiel Finishing

[E= Raster Finishing

[Elspiral Finishing

£ 3D Offset Finishing

—

Select the Constant Z
Finishing strategy.

&% Constant Z Finishing 21l

MName ICDnstantZ_BNlD b Enter a Name aS
@ ConstantZ_BN10.

_TOOIIHJ | J ﬁ spiral [
F ] +| [enuio M
. e Set a Stepdown of 1.
Tolerances Minimum Stepdown | 1.0
sl 002 b_\l Calculate Using Cusp I~
EN?D o A e Enter the Tolerance as
—= I Cusp Height: ID.I 0'02
[ Stepaver: Corper Correction ————————— |
Stepoyer I J ArcFit [~
I s s 1y The Actz.ve Boundary w11}
[ e automatically be selected in the
Trimming [Kesp Outside | Pocket Machine ¥ form.
Additional Stock 0.0
rLeads and Links

leadmn [Ramp oecson [ans ] e Set the Direction to

= Climb.
Short Links IShm—
Long Links ISkim
LT e Set the Trimming to Keep
R Outside.

rTool Axis

Tool Axis I Vertical ﬁ

Preview I~ Drav

— - e Apply then Cancel

By using the Boundary Trimming
option Keep Outside, the toolpath is
correctly limited to the steep areas of
the model.
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If the Boundary had not been used the toolpath
would have looked like this.

It can be seen that the parts of the toolpath on the
shallow areas have an excessive Stepover.

To further improve the new toolpath the Leads and Links will be modified.

21 .
ZH ml td] LeadIn |Lead Out | Last Lead Out | Extensions | Links | - ¢ SeIeCt the Leads and Llnks .I.
N e B | icon at the top of the screen.
Distance IIJD— Distance IT
angle [90.0 fnge J00
Radis [20 Redis 00
U e o || e Select the Lead In tab and change
v Allow start points to be moved - -
& st ot the 1% Choice to Horizontal Arc
[W mm—‘ Left, Angle 90.0 and Radius 2.0.
Anguiar Threshold [50.0 |
¥ Gouge Che .
Cuuyi:L::dDut | Copy from Lead Qut | Apply Lead Ins | b ClICk the bUtton copy to Lead OUt'
Apply I Accept | Cancel |

7 Heights | First Lead In I Lead In | Lead Dutl Last Lead Outl Extensions  Links I
ShortjLong Threshold IIU.U Short | Skim -
~Retract and Approach Moves ———————————— Long |Skim hd
Along [Tool Axis ~ ol I—LI .
pefasim ¢ Select the Links tab and change the
™ Automatically Extend .
[ Y Short, Long, and Default to Skim.
Retract Distance ID.D
Approach Distance ID.D
I | arc Fit Rapid Moves ——————
frc Radius (L)) [0.25°

[V Gouge Check

Apply Links

Accept | Cancel I

e Apply and Accept the form.

The tool now leads in and out of the toolpath with a horizontal arc.
If the tool lifts it will only lift by the skim distance taken from the
first page of the Leads and Links form (Z Heights tab).

The Rapid moves at skim height are purple in colour while the
plunge moves are light blue.

Issue PMILL 9 4.19



4. Finish Machining Strategies PowerMILL

e Simulate the toolpath in Viewmill.

e Save the Project (D:\users\training\ COURSEWORKI\Projects\camera)
but do not Close.

Other Constant Z Options

Corner Correction to control whether changes of toolpath direction are Arc fitted,
Sharpened or unchanged (None).

The Pocket Machining option if ticked will allow independent machining of local features
such as pockets completely from top to bottom. If unticked the whole area of the component
will be machined at each separate stepdown height.
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Post Processing and NC Programs.

At this stage we will post process a single toolpath from the explorer as an NC Program.

tb' l.l of I All of the toolpaths that have been created in this chapter
@ NC Programs should appear in the explorer like this.
-+ Toolpaths This example will illustrate with the output of one single

v § @ toolpath — Rough Opl to be output as a post-processed
m-/ | § £ 300ffset BN10  ncdata file.
&+ § B8 Constantz_BN10

¢ Right click over toolpath Rough Op1 in the explorer.

E--@ Toolpaths

HVRPT. cougho0:|

@V § B 300ff  pochopt
m-v') a Const
=4 Tools Simulate from Start
e ¢ U > 02 o e Select the Create Individual NC
B ¢ L) BN Activate Workplane Programs option.
[—]O Boundaries )
' O Shallo Settings...
_____ #8 Patterns Parameters...
ﬁ? Feature Sets Recreate Block
[ Workplanes Select Surfaces
[]---g? Levels and Sets Draw
- Models Drawing Options 3
‘ Stock Models Colour »
----- ¥ Groups
-8 Macros Rename
Save as Template
Add to 3
Create Individual NC Programs K
v Batch
Load Settings
=0 NC Programs An NC Program is created called Rough Op1 and contains the

=, [ roughopl  toolpath.

¢ Right click over the NC Program and select Settings.
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1 NC Program : RoughOp1 4] The path to where the program will be
output.
Marne | Roughiopl |[ options... |
Output File | C:fternpNCProgrars,/ % [ncprogram]. tap | .
Machine Option File | C:/fdcam/config/ductpost/heid426.opt | Befo're pOSt ‘pI‘OC§SSIHg can occur the
T e required option file (*.opt) must be
Program Mumber Tool VYalue eleCted'

Toolpath “umber | Jiameter | Tip ele  Dverhang | Tool ID Type [} Select the folder |Con to open

Roughiopl 4 23 3 125 D25T3 TIPRADIUS

up the Select Machine
Option Filename form.

< | 3

Tool Change| On New Tool Tool Numbering | &s Specified
Tool Change Position | after Connection +

Toolpath RoughCpl

Toal
ID| D253 Taol Murmber Gauge Length | 125.0
Cutter Compensation ! Select Machine Option Filename
Length Off Radius | Mone w
l:l l:l éﬁ Look in: | 5 ductpost & D ¥ -
] fictia.opt S |heid4n0.opt =] kryle.opt
- ] fidian. opt ] haid42. opt =] maho.opt
Arc Fitm coolant | Standard 3 | ge2000m,opt 2| heid.apt ] matsura.apt
- e #|h3z.0pt #|heidiso.opt =] mazak.opt
Orilling Cycle Ou utw ——— | ]hisS.opt &]hurca.opt | Mazak-Laser ¢
g Cy tp - @ #|haas.opt ] incon.cpt ) mitsu.opt
\ | 2 .
Flle name: | heidd00.0pt
write | [ epply ] [ accept | [ Close _E Fiosctpe: [Macte Dpton e Castrames)

Select the Heid400.opt and then Open.
e Select Write at the bottom of the NC Program form.

e Close down the subsequent form, which confirms the output using Bl

The contents of the output, NC Program can be viewed by double clicking on it in the
Windows C:\ Temp\NCPrograms folder and view it in WordPad.

=T

File Edit Wiew Insert Format Help

Dl Sl s &lslalo| &

BEGIN PGM 1 HMH il
TOCOL DEF 1 L+0,000 R+0,000
TOCOL CALL 1 Z 31500,000

L E+4Z,000 RO F533535

L X-49,806 T+39,5803 F9555 MO3
L E+437,000 MOS

9 L E+431,179 F500 M5S0

10 L E-49,151

11 CC E-49, 181 Y+32,732

12 C X-44,181 Y+37,732 DR-

13 CC XE-42,110 Y+39,803

14 C ¥X-39,181 Y+39,803 DR+

15 L ¥+109,803

16 CC E-36,681 T+109,803

M -1 mn b O

4.22 Issue PMILL 9



PowerMILL 4. Finish Machining Strategies

Corner Finishing.

Introduction.

Corner Finishing strategies are mainly used to remove material in corners that could not be
removed by larger tools in previous paths. There are 3 different types of strategy: Pencil,
Stitch Corner, and Along Corner. The Pencil strategy creates 'single pass' machining along
sharp internal corners while the other two perform local machining of the entire area of
material inaccessible by a larger tool (Rest Milling).

All Corner Finishing strategies allow a Threshold Angle to be specified. The Threshold
Angle - determines the angle, from the horizontal, at which steep and shallow portions are
split when you select a type of Steep or Shallow. This avoids problems associated with the
tool running up or down steep slopes. For instance the user could apply a stitch strategy to
track across the steep areas and parallel strategy for shallow areas. Also a higher feed rate
could be used on the shallow areas and a lower feed rate on the steep areas, which if applied
first is more likely to be taking a heavy cut.

THRESHOLD ANGLE
7
7

HORIZONTAL PLANE

Corner Pencil Finishing
This option produces single pass tool tracks along the intersection between sharp internal
corners of the component surface.

e From the File pull down menu select Delete All and from the Tools pull
down menu select Reset forms.

e From File — Open Project and in the form browse to:-
D:\users\training\PowerMILL_Data\Projects\CornerFinish_Start

e Select OK to load the existing Project into PowerMILL.

I
j, e Camarnch sert s nen e oy The Project is Locked and cannot be
L Tt i e 'dft’ ter DELCAM.COM/CROC. L .
Fheng Ry ee A on o / modified unless saved as a new file (or the
It can be saved only under another name, using 'Save Project .. . . .
As... original Project’s Lock file is deleted).

e From File — Save Project As:-
D:\users\training\COURSEWORK\PowerMILL-Projects\CornerFinish
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e Selectan Iso2 view. | @J@ © E_Ejd
W Gl

Reset the Rapid Move Heights from.

Open the Toolpath Strategies form

Corner Pencil.

Input Name as Pencil_Shallow.

Select Output - Shallow.

ﬁ Corner Pencil Finishing 2=l

“f}?_}gl MName I Pendil_Shallow

rTool H I J Direction ICIimb 'I
I'i' j BN10 - QI
_I Output IShaIIow 'I

Tolerances
Tolerance [0.02 &l Threshold Angle [30.0

Thickness Detection Limit | 165.0
0 oo 4 |

[ StepovEr

7

and from Finishing select

Stepover I _l

Boundary

-l =

Trimming IKeep Inside VI

rLeads and Links
Lead In INone
Lead Out INone
Short Links ISafe
Long Links ISafe

E
Tool Axis
Tool Axis I Vertical

Presiem I~ | Craw

Apply I Accept I Cancel |

e Select Apply to generate the Shallow slope machining only.

The toolpath is produced. The steep area is not
machined.

e Simulate the toolpath.
¢ Right click over the toolpath in the explorer and select Settings.
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e Change the Output option from Shallow to Steep.
e Apply the pencil machining toolpath (in the Steep areas only).

e Select the Copy toolpath icon from the form.

Only the steep area is machined.

e Simulate the toolpath. Rename the toolpath as Pencil_Steep.
¢ Inthe main toolbar select File - Save Project.

The contents of the Project will be updated:-
D:\users\training\COURSE WORK\PowerMILL-Projects\CornerFinish

Corner Along Finishing

All the Corner Finishing
strategies, (except for Pencil) are
based on machining the area
between the Reference tool (2) and
the Active tool (1). 430

=3

650 ref fooll

In this example the main finishing N
tool is a 12 Ball nose (reference) to 1 v
be Corner finished with a diameter

5 Ball-nose.
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Open the Toolpath strategies form and from Finishing select
Corner Along Finishing.

Define a dia 5 ball nose tool named BNS5.

In the Reference Area, select the tool BN10.

Change Output to Shallow.

Set Cusp to 0.03.

Check Direction is set to Climb

Input Name as CornerAlong_Shallow.

i@ Corner Along Finishing 2l

el

~Tool . ) Iﬁ
Direction | Climb -

|+ Jons | ézl
IHJ I Output IShaIIow vI

rTolerances ) =
M aximunn Passes 10
Tolerance IEI.DZ S:l r I
Threshold Angle I 30.0
"ﬁidmess

Mame |C0rner.ﬁ.long_5hallo'..\-

W] Jo.0 Y cusp [0.03
_-l Q Overlap IDD—

[~ SEEpOVER Detection Limit I 165.0
Stepoyer I |
o Remove Deep Cuts ¥

Reference

Boundary Lse boolpath reference [

Hj I J J Tonlpathl j
Trirnming IKeep Inside vI

Tool
~Leads and Links “H j fen10 =]

Lead In I None

Lead Out I MNone

Short Links | Skim

Long Links I Skim

r Tool Axis
Toal Axis I'u'ertiml g
Presiem | [~ Graw

Apply I Accept Cancel
e Apply the form and Cancel.
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Animate the toolpath and note that
it has machined the shallow areas
from outside to inwards in a Climb
milling direction.

The Leads and Links need to be
improved.

e Open the Leads and Links

form E‘] "and Set all the
Links to Skim.

&'ﬂj Leads and Links 2 x|

7 Heights I FirstLead In Lead In |Lead Outl Last Lead Outl Extensions I Links |

1st Choice |[Egl=1F-ls 2nd Choice lm

e Select the Lead In tab. Ostanc |00 gz
Angle [90.0 pncle [0.0

Radius | 4.0 Radius IT

e Select Vertical Arc and fill in the
Values ShOWn 0.0 Overlap Distance (TDU) Ranip Options. .

¥ Allow start points to be moved

¥ Add leads to short links

L4 CI'Ck Copy tO Lead Out Angular Threshold W

’47 Add leads at tool axis discontinuities

¥ Gouge Check

o Apply an d Accept . Copy to Lead Out | Copy from Lead Qut | Apply Lead Ins
Apply I Accept | Cancel |

The Vertical Arc lead
provides a smoother
transition onto the work
piece with the tool already
moving at the specified
cutting feed rate.

e Open the Leads and Links form changing the Lead In/out from Vertical
Arc back to None and Accept (ready for the next toolpath).
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Corner Stitch Finishing

e From the Finishing strategies form, select Corner Stitch Finishing.
e Change Outputto Steep.

fy. Corner Stitch Finishing 2 x|
(ﬁ;)g| | Mame ICornerSﬁtd1_Steep
ool - Direction | Climb -
2 [c—D7 s
output [Seen 3]
Tolerances
Tolerance ID.DZ gl Threshold Angle |3D.D
Thickness Cusp ID.D3
| i (8}
’V—Dl &0 g Qverlap ID.D
—Stepover Detection Limit I 165.0
Stepoyer I | Remayve Deep Guts W
Reference
—Boundary Lse: bonlmath reference [T
IUlj I j e | Tolpath Iﬁ
v

Trrmming IKeep Inside l Tool
I':' | BN10 -
rLeads and Links ’7 EI T I J

Lead In I Mone

Lead Out INone
Short Links ISkim
Long Links ISkirn
Tool Axis

Tool Axis | Vertical m

Presview | I~ Draw
Apply I Accept Cancel

e Apply the toolpath and Cancel.

This time only the steep areas have been machined.

If required, it is possible to change the Direction and/or
order of individual tool tracks via the Toolpath - Edit
options.

¢ Right click on the toolpath and select Edit >
Reorder.
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' Toolpath Listing 2 X

Start point =nd paint _ength ~
86,33, 23.41, -14.22 00,49, 22,67, -14.22  6.15
g27.86, 23.27, -14.99 901.70, 2257, -14.99  6.02
29,13, 23.15, -153.76 02.86, 2247, -15.76  5.91
90.36, 23.04, -16.54 03.96, 22,39, -16.54 5.78
01.52, 24.94, -17.21 05.03, 22,32, -17.31  5.68
02.64, 24.86, -18.08 06.07, 22,25, -18.08 5.60
93.73, 24.78, -18.85 97.06, 22,20, -18.85  5.49
94,75, 24.71, -19.62 958.02, 22,15, -19.62  5.43
93,75, 24.66, -20.40 93.94, 22,11, 20,40  5.35
96.72, 24.61, -21.17 09.84, 22,08, -21.17 5.28
10 o97.64, 24.57, -21.94 100,70, 22.06, -21.94  3.22
11 98,35, 24.53, -22.71 101.55, 22,04, -22.71 3.16
12 99.40, 24.51, -23.49 101.68, 22.04, -22.82 4.82

L nn R R R T T

o Select Alternate

directions_ 13 1AM S 94 AR 27 TE A0 ED T NA 7 00 A aS
2 Heights | FirstLeadIn | Lead In | Lead Out | Last Lead Out | Extensions ~Links | / In the Leads and Links form
Short/Long Threshold | 10.0 Short |Circu|ar T Set ShOI’t LI n kS tO C ircu |al’
Retractand Approach Moves —————— | Long lh Arc .
Along ITDD| Axis vl Default lh
[ Automatically Extend —————————————
’7 IMaximum length I 250.0
Retract Distance | 0.0
Approach Distance | 0.0
= | &rc Fit Rapid Moyes
Arc Radius (TOW) [ 0.25

¥ Gouge Check

Apply Links |
Apply I Accept | Cancel |

The steep areas now run in a zig-zag direction rather
than one way and this time the Short links are
defined as a Circular Arc.

¢ In the main toolbar select File - Save Project.

The contents of the Project will be updated:-
D:\users\training\COURSEWORK\Projects\CornerFinish
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Exercise

Create Finish Machining for an existing Rough Machined Project

e Delete All and Reset forms.

e From File — Open Project and in the form browse to:-
D:\users\training\PowerMILL_Data\Projects\ChainsawDie_Start

The Project is Locked and cannot be modified unless saved as a new file (or the original
Project’s Lock file is deleted).

e Select OK to load the existing Project into PowerMILL.
¢ From File - Save Project As:-
D:\users\training\COURSEWORK\PowerMILL_Projects\ChainSawDie-Ex

Activate the existing Ball Nose tool - BN12

e Create a Shallow Boundary with Thickness 0.

e C(Create a Constant Z finishing strategy limited to the Steep areas and a
3D Offset finishing strategy limited to the Shallow areas.

e Activate the existing Ball Nose tool - BN6

e Create a Rest Finishing strategy using Corner Along - referenced to the
larger BN12 tool.

e Perform a full ViewMILL simulation.

e Save the Project to update.

Ilustrations of typical Finishing Strategy solutions and corresponding ViewMILL solutions
are shown on the next 2 pages.
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@]J ML Programs
=-+&> Toolpaths

# v ¢ & DETI0P
¢ & D12T1-0P1

x-v

# v ¢ B Bl ZinCZ-0P1

# v g £ BN1Zfin-3D0I-0P1

#-v 7 B! > BNGfin-CnrAlong-OP1
= Tools

& ¢l pasT3

a ¢ L oen

w g l)eNz

# .l >BNB
=-{7 Boundaries

5 BN12fin-CZ-OP1

el = R T,

BN12fin-3DOff-OP1

BN6fin-CnrAlong-OP1
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BN12fin-CZ-OP1

BN12fin-3DOff-OP1

BNo6fin-CnrAlong-OP1
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PRO - Finishing Strategies

Further Corner Finishing strategies

In PowerMILL Pro two further Corner Finishing strategies are available. These include:-
Corner MultiPencil (offsets tooltracks outwards from the Pencil intersection) and Corner
Automatic (a combination of Stitch and Along). The option Output - Both also appears in
all five of the Corner Finishing strategies. This creates separate groups of toolpath segments
on both sides of the Threshold Angle.

¢ Delete All and Reset forms.
e From File — Open Project select the read-only Project :-
D:\users\training\PowerMILL_Data\Projects\CornerFinishPro_Start

@ PowerMILL Warning: x|

. Project 'CornerFinishPro_Start is open read-only,
Itis being edited by user 'dfb' on computer 'DELCAM.COM/CROC".

It can be saved only under another name, using 'Save Project
As...!

e Select OK in the PowerMILL Warning form.
e Save Project As:-
D:\users\training\COURSEWORK\PowerMILL-Projects\CornerFinishPro_Example
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Corner MultiPencil Finishing

e From the Toolpath strategies form, select Corner MultiPencil Finishing

u‘ij{:orner MultiPencil Finishing x|
Mame | Corner-MultiPend
Direction ICIimb vl
o e Change
o BT Output back to
Tolerances .
Maximum Passes [ I 10
Tolerance ID.D}‘_ &l Sha"OW
Threshold Angle I 30.0
Thickness
’7""D| IU.D (6] | Cusp ID.D3
Cverlap ID.D
[ Stepaver Detection Limit W
Stepover: I |
Separate Regions [
Boundary Remove Deep Cuts v
[ |v - | Reference
IU J I J = Use toolpath reference [~
THmming IKeep Inside vl
Toelpath I j
rLeads and Links Tool
Lead In INone “Ulj IBNJD j
Lead Qut INone
Short Links | Skim
Long Links | Skim
Tool Axis
Tool Axis I\l'ert'ml g
Presiew | I~ Draw
Apply I Accept | Canicel |

e Select Apply but do not close the form.

MultiPencil appears to be very
similar to the Corner Along
strategy. There however
fundamental differences one
being the toolpath segments in
Corner Along are offset from
the outer profile inwards,
whereas in MultiPencil the
toolpath segments are offset
outwards from the true
intersection.

Issue PMILL 9



PowerMILL

4. Finish Machining Strategies

Select the Copy Toolpath icon from the form.

:-;'I Corner MultiPencil Finishing

el

Iﬁlj [ | QI

rTolerances

Tolerance I 0.02 &l
Thickness
( &

ﬂ [0.0
Stepover I J
r~Boundary

- Stepover
2R =l
Trimming IKeep Inside vl

rLeads and Links

Lead In INonE
Lead Out INone
Short Links ISkirn
ngtis [

Name | Corner-MultiPenc_ag0|

Direction lm
Output [Shalow =]
Maximum Passes [ IIE'—
Threshold Angle [20.0
cp [o05

Overlap IDD—

Detection Limit [165.0
Separate Regions [

Remove Deep Cuts [v

21X

tH

 Reference
UUse toolpath reference [

Toolpath Iﬁ
Tool
“H j [Er10 |

14
Tool Axis

Tool Axis | Vertical ﬁ

Presie | [~ Draw
Apply |

&cceptl

Cancel

Apply the form and Cancel.

e Change the
Threshold Angle
to 90.

This has the effect of
creating an unlimited
Shallow machining area
for the toolpath. Using
these settings the same
strategy would be created
if the Quitput - Both is
applied. If Output - Steep
is applied no toolpath
would be created.
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Corner Automatic Finishing

e From the Toolpath strategies form, select Corner Automatic Finishing.

@# Corner Automatic Finishing 2]

%@| | Mame | Corner-Automatic

Tool irecti i -
Ti Iﬂj IBNS j ﬁ Direction ICIlmb I ° Change output
Output Im to BOth

Tolerance IF S:l Threshold Angle IF o Change the
"Thidmess Cusp IF ThreShOId

Tolerances

W] foo 4 _— Angle back to
30.

Stepover Detection Limit I 165.0
Stepmyer I | Remove Deep Cuts [V

—Reference

—Boundary Use toolpath reference [
IElj I j ,_l Toolpath I j
Tirimning Im ool
rLeads and Links (Iﬁlj IBNID j
Lead In INone
Lead Out INone
shortlinks [skm
Long Links ISklm—

Tool Axis
Tool Axis I Vertical m

Presiew [~ Draw

Apply I Accept | Cancel |

e Apply the toolpath and Cancel.

This strategy automatically uses
Along for the Shallow areas and
Stitch for the Steep areas.
However, due to it being all one
toolpath, it is not so easy to
control the Leads and Links or
the Reordering.
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Deep Cut Prevention

In cases were the Reference Tool is too large to machine all the way down a deep pocket the
excessive stock remaining could cause a smaller Corner Finishing Tool to overload and
break. A tick box option is available in the Corner Finishing strategies (Except Corner
Pencil) to Remove Deep Cuts. The user would then locally apply a more suitable strategy
such as Constant Z Finishing into the deep areas.

¢ Delete All and Reset forms.
e From File — Open Project select the read-only Project :-
D:\users\training\PowerMILL_Data\Projects\RemoveDeepCut-Start

- | @] |

E*@ Toolpaths

w4 >D12T1-RGH1
- [ & EM5-RGH2
=) (3 68 BN10-FINT

[—]'-Flh' Tools
@ g L) >p12m
L e

: L] BN

9 | | BN Project 'RemoveDeepCut-Start' is open read-only.
'CJ B ‘d - M It is being edited by user 'dfb' on computer 'DELCAM/CFET'.
ounaaries

_____ ﬁ Patterns It can be saved only under another name, using 'Save Project As...'
Feature Sets
&

- Workplanes
- x 14_', = MC-datum
£ Levels and Sets
-l Models
. DeepCorner
‘ Stock Models
..... (¥ Groups
-2 Macros

e Select OK in the PowerMILL Warning form.
e Save Project As:-
D:\users\training\COURSEWORK\PowerMILL-Projects\RemoveDeepCut

Note: The existing 3 strategies in the above Project are as yet, unprocessed (Calulator icon).

¢ Right mouse click on Toolpaths in the explorer and from the local menu
select Batch Process.

O ootz
=-/) @@ Toclpaths o . .
& E¥ b The 3 strategies will be processed in sequential order.
VS
=47 Tools Create Toolpath...
- U Toolpath Names 3
T v
' |_| Batch Process I
e @ LT Trumlidata Al
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e Activate the first Roughing strategy D12T1-RGH1 and from it’s local
menu select Simulate from Start.

e Open a Viewmill simulation session and simulate each toolpath in
sequential order.

The Pale Blue area shows where the Dia 10
Ball Nosed tool has successfully machined.
The deep pocket (Purple) is inaccessible and
still includes large steps down the side wall.
This excess stock could cause a smaller
finishing tool to break if it attempts to Corner
Finish down the pocket. To prevent this, the
Remove Deep Cuts option will be used as
demonstrated below.

e Select the No Image icon ﬂ on the ViewMILL toolbar to display
PowerMILL only in the graphics area.

e Activate the BN4 tool.

e From the Toolpath Strategies form, select Corner Along finishing.

@ Corner Along Finishing 2=
@| m Name IBN4—fIN1-DeepCut
Tool . . Iﬁ
Direction |Any -
- lee =/ T
QOutput |Both -
Tolerances .
—— IF &l Maximum Passes [~ I 10
90.0
R — Threshold Angle I
lr_gl I_IZI.D @ Cusp |0.|:|z
Overlap ID.IZI
[~ Stepaver Detection Limit I 165.0 Unt|0k Remove
I L~
Stepayer _l Remove Deep Cuts [~ & Deep Cuts
Reference

—Boumfll'f:ry I J Use toolpath reference [~

Iﬂj d Tonlpath I j

Trimming IKEED Inside 'I
Todl . BN10
~Leads and Links “H j [noe— =] Reference Tool
Lead In IBoxEd

e Enter the data exactly as shown above and select Apply.
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The Corner Finishing has operated
all the way down to the base of the
deep pocket.

Due to the excess stock this could
cause the cutter to break.

e Re-open (Settings) the Corner Along finishing.form for the existing
strategy and select Make a Copy.

¢ Rename the strategy as BN4-fIN1-NODeepCut and ensure that the
Remove Deep Cuts box is ticked before selecting Apply.

The Corner Finishing has not
occurred in the deep pocket that is
inaccessible to the BN10 reference
tool

e Save the Project.

Exercise

e Create a material Block defined by a Box, locally around the Pocket
Surfaces (selected).

e Using the same BN4 tool, create a Constant Z finishing strategy to step
down the sidewalls.
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Constant Z Finishing — Additional Stock option

The Additional Stock option causes a Constant Z strategy to ignore the Pocket machining
setting below the point where the width of a deep, angled slot reaches a specified width.
Above this point the tool will continuously machine down each angled face in turn. Below
this point the tool tracks will alternate in descending, height order from one face to the other.

¢ Delete All and Reset forms.
e From File — Open Project select the read-only Project :-
D:\users\training\PowerMILL_Data\Projects\CZ_AddStock-Start

:gil PowerMILL Warning: |

Project 'CZ_AddStock-Start' is open read-only.
! It is being edited by user 'dfb’ on computer 'DELCAM/DFBY',

It can be saved only under another name, using 'Save Project As...'

Select OK in the PowerMILL Warning form.

Save Project As:-
D:\users\training\COURSEWORK\PowerMILL-Projects\CZ_AddStock-EX1

e Right mouse click on the Toolpath named Roughing and from the local
menu select Activate to reinstate the original Block.

e Right mouse click on the Toolpath named Roughing and from the local
menu select Simulate from Start.
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e From the top Pulldown menus select (tick) View - Toolbar - ViewMILL to
open the ViewMILL toolbar (if not already open).

File | view Insert Draw Tools Help

Resize to Fit F& N ‘ o ‘
@ Zoom to Box... Jle*" % =
@ From » j0tip2 7 D
—— Is0 4
——  Tool » =
Hz Rotation Anchor 4
_E Refresh Crl+R
B Blank Selected cl4
Blank Except Ctrl+
; EBlank Toggle Ctrl+y
£+ Unblank Cirl+L
Dizlogs b Viewing Alt+v
-4 ViewMill
Snapshot...

e On the ViewMILL toolbar switch the Red sphere icon to Green to connect
the simulation to ViewMILL.

ol DleveEHeda] |l

vy H| @ x

sl | —

e Select the Rainbow Shading option in the ViewMILL toolbar and then
select Play in the simulation toolbar.
DT Al 1D << Db KAPA

jl i ull

The Roughing strategy has not fully machined a large volume of stock towards the base of
the slot. This will have to be removed as part of a Constant Z finishing strategy.
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e Right mouse click on the Toolpath named 0_AdditionalStock and from
the local menu select Simulate from Start followed by Play in the
simulation toolbar.

The existing Constant Z finishing strategy is ploughing into the stock that was inaccessible
to the previously simulated Roughing toolpath. The excessive loading is likely to result in
tool breakage. To avoid this problem the Constant Z strategy will be modified to include the
Add Stock option

e Inthe ViewMILL toolbar select the No Image (PowerMILL only) view.’i

e Right mouse click on the Toolpath named 0_AdditionalStock and from
the local menu select Activate followed by Settings to open the original
Constant Z finishing form.

e Select the ‘Create a new toolpath based on this one’ option.

e Rename the new Toolpath as 8AdditionalStock and in the Additional
Stock box input the value 8.0 before selecting Apply.

Pocket Machine [v The choice of the selected Additional Stock value requires

" user intervention in estimating the width of the slot, just
Additional Stock IS.EI . . :
above the depth of material accessible to the Roughing

Direction I Climb - I strategy.

Repeat the ViewMILL simulation, starting with the Roughing strategy as
before but then following with the new Constant Z strategy that has the
Additional Stock value of 8.0 included.
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The new Constant Z finishing strategy Pocket machines continuously down each side of the
slot up to the depth where the width of the slot is equal to TDU + 8. The strategy then
continues but with the Pocket option ignored for the remaining tool tracks, which alternate
between each side wall in descending order.
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3D Offset Finishing

e Open the Project:-
D:\users\training\PowerMILL_Data\projects\CameraStart_Pro.

:-j PowerMILL Warning:

& Project'CameraStart_Pro’ is open read-only.
F lé Itis being edited by user 'dfb’ on computer 'DELCAM.COM/CROC",
It can be saved only under another name, using 'Save Project

as...

e Select OK to load the existing Project into PowerMILL.
¢ From File — Save Project As:-
D:\users\training\COURSEWORK\PowerMILL_Projects\Camera_Pro

e Right click over toolpath 3DOffset_ BN10 in the explorer and select
Settings from the pull down menu.

e Select the Copy icon on the form.

&% 3D Offset Finishing 2l x|
¢ Rename the toolpath as
% — [ 3DOffsetBN10_Spiral.
( IH_L’ i - QI‘ Masimum Offsets [~ |1u5u—w‘\\ . .
Tderancesm pamlﬁ_[%l [ ] TICk the bOX Splral.
A — Start on Pattern [
hﬂ o= wanfas = | ® Leave all other values the
e same then Apply and Cancel
( e ﬂ‘ the form.
Trimming W

The Spiral option is ideal for HSM (High
Speed Machining) applications where
ideally toolpaths should be as continuous
as possible with the minimum sudden
changes direction. Leads and Links are
greatly reduced using this method.
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Optimised Constant Z Machining

This strategy is a mixture of Constant Z and 3D Offset machining. Where the model is steep,
Constant Z is used and for other areas, 3D offset is used.

Closed Offsets if ticked will cause the 3D Offset areas of the machining to be ordered to
occur from outside to inside. The reverse applies if Closed Offsets is unticked.

e Deactivate the Shallow Boundary, ShallowBN10 in the explorer.

N
e Select the Toolpath Strategies icon from the top of the screen. ﬁ\'

e Select an Optimised Constant Z Finishing strategy from the form then
OK.

5 e Enter Name -
o0 |8 Name | OptConst7-BN10
azﬁ[‘ e [Opcre OptConZBN10.
rToal )
= Spiral [
Iﬂj IBNIU j ﬁ Closed Offsets |7<\ L4 Se|eCt Closed
rTolerances Direction ICIimb vl [ Offsets
Tolerance ID'UZ &l [™ Use Separate Shallow Stepover
Thidness Sheloy stepover [S0 e Set the Direction to
e Y Climb.
Stepover
sugover [10 | LA e Input a Stepover
value of 1.
-Boundlary
|§H| = B e Make sure no
Trirring . |Keep Inside v Boundary iS
rLeads and Links se l eCted .
Lead In INone
leadout [Nore e Enter the Tolerance
Short Links ISkirn as 0.02.
Long Links ISkirn
L e Resetthe Lead In
r~Tool Axis and Lead Out tO
Tool Axis I\ierﬁml g None_
Preyiey | [~ | Braw
e Apply and Cancel.
Apply I Accept Cancel
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Optimized Constant Z has performed well in this example but it does take longer to
calculate. Sometimes it is better to use Boundaries with a combination of 3D Offset and
Constant Z.

e Select the Leads and Links icon from the top of the screen to bring up the
form and select the Links tab.

S5 . Ghange the ShortLong
ZHeights | FirstLead In | Lead In | Lead Out | Last Lead Out | Extensions  Links | Threshold to 2.
Shortflong Threshold [2.0 | Short [onsurface  ¥]
[ Retract and Approach Hoves Long [Sm =I|| e Change the Short links
s =l'| oefaut[Som | to On Surface.
™ Automatically Extend ———————————
{ Masimum length [250.0 « Change the Long and
RetractDistance [0.0 | Default links to Skim.
Approach Distance [0.0 |
[ et Rapid Moves ¢ Tick the Arc Fit Rapid
wrcRadus () [05 Moves box with an Arc
Radius value of 0.5

| Gouge Check

wyis ||| © Apply and Accept the
form.
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Arc Fit Rapid Moves

Both the Constant Z and 3D Offset parts of the toolpath currently use a Imm Stepover. By
ticking the box Use Separate Offset Stepover it is possible to apply a different, larger
Stepover value to the shallow areas created with the 3D Offset strategy used in this hybrid
form.

Interleaved Constant Z

This is an alternative strategy to Optimised Constant Z with different options which include
a user defined Threshold Angle between the Constant Z, and 3D Offset areas of the
toolpath as well the option to specify an Overlap value between them.

e Select Interleaved Constant Z from the Finishing strategies form.
e Enter data exactly as shown in the following illustration.

e Enter Name as
@ Nane [ rereaiedcz B0 InterleavedCZ_BN10.
Toal
EREE =l B e Inputa Threshold
— OffetOver [20 Angle value as 50.
Tolerance |0.oz &l Direction ICIimb v[
Thickness Order [steepFirst v e Input an Offset
{ﬂ o0 & T Overlap value of 2.
[™ Use Separate Shallow Stepover
Stepover e Set Order as Stee
Stepover I 0 ﬂ ’7 ShallowStepaver I 5.0 First_ p
rBoundary
=g 1B
Trimming W

e Apply and Accept the form.
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The user more has control over the extent of the 3D Offset and Constant Z components of the
hybrid Interleaved Constant Z strategy.

Optimised / Interleaved Constant Z with separate Shallow Stepover

Both Optimised and Interleaved, Constant Z have an option to apply a separate, larger
Stepover across the Shallow areas. This is designed to provide more efficient machining
with a Tip Radiused Tool, where the Shallow areas are perfectly flat. The Steep walls are
machined using the tip radius with a fine Stepover and the flat areas using the base of the
tool with a large stepover.

Delete All and Reset forms.
¢ From File — Open Project select the read-only Project :-
D:\users\training\PowerMILL_Data\Projects\ADV-Opt-ConstZ-Start

&?," PowerMILL Warning:

& Project 'ADV-Opt-ConstZ-5tart is open read-only.
/ Ié Itis being edited by user 'dfb’ on computer 'DELCAM/SCZ',

It can be saved only under another name, using 'Save Project
as...

=1

e Select OK to load the existing Project into PowerMILL.
e From File — Save Project As:-
D:\users\training\COURSEWORK\PowerMILL_Projects\ADV-CZ-example
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¢ Right click over toolpath D16t3-OptConstZ in the explorer and select
Settings from the pull down menu.

The component form
includes 2 Flat areas
which are currently
machined with the same
small stepover as the
angled walls. For more
efficiency, an option is
available for a larger
stepover to be
independently applied to
the shallow (Flat) areas.

e Select the Copy icon on the form. m

@&# optimised Constant Z Finishing 2|
4@ |.l Mame | D16t3-0OptConstZ
_TDOI Sﬂd |7

Hlj IDlm =l Ql Closed Offsets [v

e Direction ICIimI:: 'I
Tolerance IU-UZ &l |,|7 Use Separate Shallow Stepover ————

"j‘bess m Shallow Stepover IB-U
wid| 0.0 2
I~ Stepover

lizEl el

Trimnmning I Keep Inside j

e Tick The Box named Use Separate Shallow Stepover and input a
Shallow Stepover of 8.0 before selecting Apply and Cancel.
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Optimised Constant Z
provides an option to
create spiral tool tracks
suitable for High Speed
Machining applications.

e Apply an Interleaved Constant Z strategy using the same cutting tool and
the same basic settings as the previous Optimised Constant Z toolpath.

:w.' Interleaved Constant Z Finishing ilil

@l m MName IDthErInterIeavedCZ

—Tool
— Threshold Angle | 0.0
[ —D |
Offset Overlap IT
Taolerance IU.UZ &l Direction ICIimb vI
"Thidmess Order ISteep First vI

 Tolerances

_D| f[oo @ Additonal Stock [ 0.0

" ¥ Use Separate Shallow Stepover

Shallow Stepover I 8.0

~Stepover

Stepover IU-E il

One drawback with the
Interleaved Constant Z
strategy is that there is no
Spiral option. This would
make it less desirable for
High Speed Machining
applications
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Flat Machining

¢ Delete All and Reset Forms

¢ Import the model:-
D:\users\training\PowerMILL_Data\Models\Flats.dgk.

e Create a 20mm diameter End Mill tool named EM20.

e Calculate the Block and set the Safe heights.

e Open the Offset Flat Finishing form and fill in as below.

It should be noted that where a flat area is adjacent to a vertical face Flat finishing the tool
will rub against the vertical face which is likely to result in deflection. It is recommended in
these situations that a different Radial Thickness be applied to prevent contact with the
walls.

&7 Offset Flat Finishing 21 x|
(ﬁ8| Name | FlatFinEM20 e Name the
~Tool toolpath
ILHj IEMZD ﬂ g Flat Tolerance ID.D FIatFinEM20
Allow Tool Outside Flat W
[ Tolerances 1 Ignore Holes
Tolerance [0.02 Stl Threshold (DU 20
Thickness
. . 0] High Speed Machining—————
IVM g ID ° Q T Profile Smoothing ———————————
CHmre Carner Radius (THL) _D'DSD
Stepover I 12.0 E‘\‘
i p—— Ty oh = e Select the Use
i 1 Smoothing Allowance H
[istance I 1.0 p_— — AX.Ial
Thickness
Cut Direction ICIimb vl .
~Leads and Links T RestMachining icon.
Lead In |None ITooIpath = | =l
Lead Qut INone Detect Material Thicket: Than I 0.0 b Enter Separate
Short Links | Skim Expand Area By I 0.0 Th ICKness
h values for
inks [k .
enatinks. | o Radial 0.3 and
Approach Outside [V IF AXiaI 0
19
~Boundary
ZE]| 5
Trimming IKeep Inzide vl
Tool Axis
Tool Axis I“'Eftitﬂ ﬁ
Preview | [~ Draw
Apply I Accept | Cancel |

e Apply and Cancel the Offset Flat Finishing Form.
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The Flat areas have been finish
machined apart from between the ‘D’
shaped and oval Bosses as well as
at the base of the holes due to the
20mm diameter tool being too large.
We will now use a smaller tool to
Rest machine these areas.

e Create a 10mm diameter End Mill tool named EM10.
e Copy the toolpath Flat Fin EM20 and fill in the form as below.
&% Offset Flat Finishing 20|
@| | Name |FlatFinRest Name FlatFinRest
e Fiat Tolerance [0.0
[AREE =
Allow Tool Qutside Flat [v
[ Tolerances I Ignore Holes
Tolerance [0.02 gl o Threshold (U220
Thickness I D
“ﬁ 03 Q = @ A Profile Smoothing
CREe Corner Radius (TOUY _D'DSD
Stepover IE-U ﬁl .
tiks [smooth <] |_Tick Rest
e T Smoothing Allowance .-
Distence [T0. - | Machining.
Cut Direction | Climb - e
~Leads and Links W Rest Machining
leadIn |MNene [ Toolpath =l [FetFiem0 =]
~
lesdout [Nene petectmstera T n [0 |1~ Reference Toolpath
Shortlinks [Sam Expand Areaby [00 FlatFinEM20
Long Links ISlm'l
Approach Outside v |n.05
'y
Boundary
EEl =
Trimming IKeep Inside vl
~Tool Axis
Tool Axis |'-ferﬁ<zl Ig
Preview [~ Draw
apply | Accept | cancel

e Apply and Cancel the form.
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Q Q Q The bottoms of the holes and the area

behind the boss have now been finished as
shown in the Z view below.

Leads and Links - Arc Fit Rapid Moves

PowerMILL Pro contains a couple of additional options in the Leads and Links form.
These include On Surface link moves and the ability to Arc Fit rapid moves (provided the
machine tool controller will support it).

/ If the Short links are set to Skim and Arc Fit
Rapid Moves is set, then arcs are added to the
rapid moves.

This option is ideal for applications where it is
desirable to avoid sudden sharp changes in
direction; for example (High Speed
Machining).

Changing the Order and Direction within Toolpaths

For toolpaths containing internal link moves, the order and direction of the tool tracks can
be changed. For example, if a machining sequence starts at the bottom of part, progressing
upwards, reversing the order will change the tool track sequence to start at the top of the part
and progress downwards. In this case the direction in which the tool travels is unchanged. It
is also possible to apply Reorder and/or Reverse to selected tool tracks within a toolpath.
Typical reasons for applying Reorder and Reverse to toolpaths include minimising fresh air,
tool movements, or to comply with the recommended tooling specifications (it is often a
requirement in High Speed applications for the toolpath to both climb mill and track
upwards).

During applications where the base of a deep slot is to be climb milled, a uni-directional
Raster Finishing Strategy will track across parallel, starting flush with one sidewall and
tracking towards the other. By locally editing the order and direction a more desirable
strategy can be created where tracking starts along the centre of the slot and progresses, climb
milling, separately outwards towards both sidewalls.
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Changing the Order/Direction of tooltracks

¢ Delete All and Reset forms.
e Open the read-only Project:-
D:\users\training\PowerMILL_Data\Projects\EditToolpaths_3

i'yj. PowerMILL Warning:

Project ‘EditToolpaths_3' is open read-only.
Itis being edited by user "dfb’ on computer ‘DELCAM.COM/CROC'.

It can be saved only under another name, using 'Save Project
As..)

e Click OK in the PowerMILL Warning form and Save Project As:-
D:\users\training\ COURSEWORK\PowerMILL-Projects\PunchForm_3

The Project contains a Dia 10 Rad 3 Tipped Tool, and a 3D Offset finishing toolpath
controlled by both Boundary and Pattern segments.

¢ Animate the toolpath using the Slow setting.

Observe the current direction and ordering of the strategy considering potential
improvements. For example, the lower area machining would benefit from climb milling
inwards towards the component form and the pocket machining could start central and climb
mill outwards towards the sidewall.
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e Either right click over the toolpath and from the local menu select Edit -
Reorder or select Toolpaths - Toolbar to activate the following Toolbar.

e Click on the Reorder Toolpath icon on the Toolpath Toolbar.

1 RGP EEBRR|[CNSSE N 0
Note the selected segments are shown highlighted in the form.
&% Toolpath Listing 21l
pd
=
L
Reverse order i
=
X
Reverse direction —— ———
/ E‘ 78.06
Alternate direction % 65  32.97, 4.52, 25.. 3230, 3.7, 2. 7537 72
66 -32.30, -3.76, -25... -31.66,-3.00,-2... 689.14 69
67 -31.88, -3.00, -25... -30.97,-2.25,-2... ©282 58

Each segment is listed in order of execution. If a toolpath segment is selected on the list the
corresponding segment is highlighted in the graphics area (and vice versa). As a result it can
be modified or moved to another position in the pecking order.

The icons to the left hand side of the form are used for changing the order and direction of
selected segments. If nothing is selected, the buttons when pressed will alter the whole

toolpath. The 2 icons to the lower left of the form are Automatic Reorder L_J and

Automatic Reorder and Reverse@ . These can only be applied to the whole toolpath and
not on selected tool tracks and are designed purely to minimise air moves (which in many
cases could be produce a result which is detrimental to the order or direction of tool tracks).

e Select all the tooltracks in the lower area and select Reverse Order. This
part of the strategy should now climb mill inwards towards the main
component form.

e Select the tooltracks in the central pocket and again select Reverse Order
followed by Reverse Direction. This part of the strategy should now climb
mill from the centre of the pocket outwards.

Note:- Extra care is required when using the Spiral option in the selected finishing strategy
as these are continuous tooltracks and can only be reversed and not internally reordered (If a
spiral track is created to Upcut outwards then it can only be modified to Upcut inwards).

e Do not close the Project down yet as it will now be used to demonstrate
both the Parametric Offset Finishing and Surface Finishing strategies.
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Surface Finishing

Surface Finishing creates a strategy that follows the surface curves on a selected Surface.
Note:- The strategy will not run parallel to any trimmed, surface edges.

e Create and Activate a Dia 10, Rad 1, Tiprad tool named D10t1.
e Select the upper surface on the punch form.

e Open the Surface Finishing form and fill in as shown below.

&% Surface Finishing 2|
@Ea Name | TopSurface
Tool rSurface
’V [ «||p10oT1 - éj‘ Surface Side | Outside -
Surface Units [Distance -
[~ Tolerance:
Tolerance [0.02 &
ttern
Thickne:
Pattern Direction |U -
Eijca 8 P
= Spiral [~
Stepover Ordering [Two Way -
Stepover |0.3 Limits ————
( ur v
Ty Start lT foo
- =)
Trimming |Keep Inside L2 End |10 e
rLeads and Links ——————————————— Start Comer | Max U Max ¥ -
LeadIn [MNane
Sequence [None -
Lead Qut |Nane

e Apply and Close the form.

In the resultant toolpath the
natural, order of the tool tracks
and link moves across the 2
narrow areas is not very efficient.
This will be fixed by applying
suitable toolpath Edit - Reorder
options.
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e From the local toolpath menu (Right mouse click), select Edit — Reorder

and in the form, click the Automatic reorder and reverse icon.
. ¢

- The Toolpath follows the curves of
S the selected Surface.

The toolpath illustrated has been
created with 1mm Stepover to help
with visualisation.

It has also been edited using the
Automatic Reorder and Reverse
option to eliminate as many air moves
as possible.

To further improve the efficiency of this strategy, several of the tool tracks on the upper flat
area can be deleted to take advantage of using a bigger Stepover for the Dia 10mm flat area
of the tool used.

e From the main pull down menus, select Draw - Cursor - Tool to help with
the visualisation for the next action.

e Select groups of 6 tool tracks leaving the single tool track outside each
set (as shown below left).

s Pl ey

Tool outline displayed to visualise
suitable Stepover (Draw - Cursor - Tool).

¢ From the local toolpath menu (Right mouse click), select Edit - Delete
Selected Components to remove the selected tool tracks.
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Surface Finishing Exercise

The direction of the curves on the selected surface will dictate whether the tool tracks are
aligned along or across the model form.

e Activate the D10t1 tip radiused tool.
e Create a Surface Finishing strategy with the pocket sidewall surface
selected using a 1mm Stepover (as shown below).

Due to the natural direction
based on along or across the
surface, the tool tracks run up
and down the sidewalls.

This is not the correct choice
as it is required to step the tool
tracks down the sidewalls.

e Recycle the above Surface Finishing strategy and change the Pattern
Direction option from U to V and Apply the form.

The Toolpath now follows a
direction, parallel to the base
of the selected Surface.

Note that the tool tracks do
not run parallel to the trimmed
top edge of the sidewall
surface.

Note:- A spiral option in the form of a tick box is available in the Surface Finishing form to
apply a continuous tool track down closed pocket or upstand areas.

4.58 Issue PMILL 9



PowerMILL 4. Finish Machining Strategies

Flat Finishing

These strategies finish flat areas only, the definition of this being controlled by a Flat
Tolerance value. Where applicable, they are usually run immediately after the main 3D Area
Clearance operation. The Project imported for the next example already includes a
preliminary 3D Area Clearance strategy.

e Delete All and Reset forms.

¢ From File - Open Project select the read-only Project:-
D:\users\training\PowerMILL_Data\Projects\FlatFinish_Start

@ PowerMILL Warning: Xl

4. Project FlatFinish_Start' is open read-only.
i lé Itis being edited by user 'dfb' on computer 'DELCAM.COM/CROC'.
It can be saved only under another name, using 'Save Project
As...'

e Select OK in the PowerMILL Warning form.

e Save Project As:-
D:\users\training\COURSEWORK\PowerMILL-Projects\3AxisSwarfExample
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PowerMILL

Offset Flat Finishing

¢ |nthe explorer - Activate the Dia 16 End Mill (EM16).
e From the Toolpath strategies form, select Offset Flat Finishing.
e Fill'in the form exactly as shown on the following page and select Apply.

@ Offset Flat Finishing

It

_Twlj*_[lj B =l QI

rTolerances
Tolerance I 0.01 b_.bl

2|
Name I EM16Flats-al

Flat Tolerance I 0.0

Allow Tool Qutside Flat [V

Ignore Holes
Threshold (TOL) I 2.0 ‘

Thickness.
~High Speed Machining
W Toco &
IV—DI Profile Smoothing————————————
Cotniet Radius (TDW) 0,050
Stepover I 10.0 A
Links ISmooih vl
’-r Final foun Smoothing Allowance
Distance I 1.0
‘ ’—r 25% —
Cut Direction ICIimb VI
~Leads and Links 1 RestMachinng——————————————————
Lead In IHon'zonizI Arc IToolpath j I j
Lead Out I Horizontal Arc Detect Material Thicker Than I 0.0
Short Links I Skim Expand Area By I 0.0
Long Links ISkim
Approach Outside [~ |0.05
~Boundary
&~ 7))
Trimmming IKeep Inside VI
~Tool Axis
Teol Axis [Vertical g

The Offset Flats
finishing strategy will
appear as shown
above. In this case
suitable Leads have
been applied
retrospectively:-
Lead In/Out - (1**
choice) Horizontal
Arc - 2™ Choice)
Pocket Centre and
Extensions — In/Out -
Vertical Arc
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The original imported Project contains both an Offset Area Clear roughing strategy and an
Optimised Constant Z finishing strategy. It is recommended that Offset Flats (EM16Flats-
al) is run directly after the 3D Area Clearance (D16¢3-al). For this reason, it would be a
good idea to move it one place upwards in the explorer - toolpaths area.

In the explorer, move the cursor over the Offset Flats toolpath
(EM16Flats-a1) and with the left mouse key depressed, drag it to the
new position.

= @ Toolpaths
: ) 'fmatam

- "" 'ln D1BT3-al "™ e - EMi16Flats-al

Perform a ViewMILL simulation on all 3 toolpaths to check that method
and result of material removal is acceptable.

The Offset Flats strategy is shown above nearing the end of it’s ViewMILL simulation.
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Raster Flat Finishing

¢ From the Toolpath strategies form, select Raster Flat Finishing.
e Fill'in the form exactly as shown below and select Apply.

&% Raster Flat Finishing 2lx

@l Name |D16t3-22

_TWILHJ IEM16 jﬁ HatToleranceID.[J

Allow Tool Qutside Flat [+

Ignore Holes
Tol [o.01 &l |
erance ’-r Thresheld (TOUY | 2.0

"Thidmess

_Dl [00 @ Ordering [Pocket 7|

 Stepaver Style ITwo Way Joined 'l
SE I I 1o *l Raster Angle

T Final Stepdown IManuaI j ID'D
Distance | 1.0

r Tolerances

High Speed Machining

Profile Smoothing ——————————
Cut Direction IAny VI 0,050
Catmer Radius (TOW) .

rLeads and Links

Lead In IHor'izosz Arc
Lead Qut |Hon'zonm| Arc ~ RestMachining—————————————

Toolpath - -
Short Links. ISkim I J I J
Deteck Materal Thicker Than IT

Long Links ISkirrl
Expand Atea By IT

Approach Outside [~ |0.05

iy
r~ Boundary

=] =)
Trimming I Keep Inside - l

~ Tool Axis
Tool Axis [ Vertica m
Preview I~ Draw

Apply Accept I Cancel

Raster Flat strategy
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5. Toolpath Leads and Links

Introduction

If a tool is allowed to start machining directly on the end of a tool track, it first ploughs
though the remaining stock depth before suddenly changing direction to run along the tool
track. This is likely to result in machining marks, vibration, and excess wear both on the tool
and machinery. To avoid sudden loading on the tool, appropriate Lead moves (at cutting
federate) on and off tool tracks can be applied.

Fresh air (Link) moves between individual tool tracks can add a significant amount of extra
time to a machining operation. This can be greatly reduced by applying alternative, Link
move options.

Link Move

Approach Move

< Default Leads and Links.

\

Rapid Retract

>

Plunge Feed

8]

The Leads and Links options “*' ' are selected either from the Main toolbar or from
within the Finishing strategies forms. They can be applied retrospectively to a toolpath.

ﬁ Leads and Links ed |

Z Heights IFirst Lead In I Lead In | Lead Dut| Last Lead Out| Extensions | Links |

Skim Distance

Plunge Distance

= | <_|5.|:|

Incremental Distances |Previ0us Z-Height j

Radial Clearance | 0.0

v Gouge Check [%

Apply Links
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Z Heights

Skim and Plunge distance provide variable control of rapid move heights within a
component. These operate in conjunction with Safe Z and Start Z to minimise slow and
unnecessary movement of the tool in fresh air while machining the component form.

Skim distance — An incremental distance above the model at which rapid moves occur from
the end of one tool track to the start of the next. The tool rapids across the model clearing the
highest point along its route by the Skim value.

Plunge distance — An incremental distance above the local component surface where a
downward rapid movement of a tool changes to plunge rate.

Lead In/Lead out Moves

Lead In controls the tool movement onto the start of a tool track and Lead Out the
movement away from the end of a tool track. Lead In moves available include None,
Vertical Arc, Horizontal Arc, Horizontal Arc Left, Horizontal Arc Right, Extended
Move, Boxed and Ramp. The same options exist for Lead Out moves apart from the
omission of Ramp.

\‘. Link Move Ilustration shows:-

/! \é — Lead In/Out - Vertical Arc and

f : Incremental - Skim - Link moves.

Toolpath colour codes:-

[ N\ Purple - Rapid Skim Feed Rate G1
po vertiealare T 21€ Blue - Plunging Feed Rate G1
= teadot ~ Green/Orange - Cutting Feed Rate G1

Dotted Red - Full Rapid GO

Vertical Arc
Lead In

Leads and Links are effectively extensions to tool tracks and as result must be gouge
protected. To prevent gouging, the Gouge Check flag should be ticked (default) on the
Toolpath Leads and Links Form. Any Lead that would result in a gouge will not be
created. The following examples illustrate different leads and links, and unless otherwise
stated, Gouge Check should always be set.

If any instances occur where the 1st Choice cannot be applied then the software will apply
the 2nd Choice. If neither option is valid under gouge check conditions then the Lead will be
locally applied as None.

The Current settings of Leads and Links are included in the creation of new machining
strategies. Alternatively they can be applied later to the Active toolpath in the explorer.
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Example
e Delete All and Reset forms.

e From File select Open Project and select the readonly Project:-
D:\users\train\PowerMILL_Data\Projects\LeadsLinks-Start

Z

A message informing the user that the
Project is ReadOnly will appear.

To continue, a copy of the Project will
be created to allow the user to make
changes (Save As).

e From File select Save Project As:-
D:\users\training\COURSEWORK\PowerMILL-Projects\LeadsLinks-example

[ | @] ]

@ MNC Programs The Project contains 1 Roughing toolpath and 3 Finishing
E@' Toolpaths toolpaths. The following example will illustrate the
BV, & D2t3gh retrospective addition of suitable Leads and Links to the 3

BB finishing toolpaths.
- BV, 8 Bre-fin2

B D BNG-fin3

e Select an ISO2 view. " ©

¢ Right click on the Toolpath BN6-fin1 and select Activate.

e Open the Leads and Links form. ]EJ;

Vertical Arc Leads

Vertical Arc Leads create a circular movement downward at the start and upward at the end
of each individual tool track. By default, the additional moves will not occur in instances
where a Gouge would be caused (Gouge Check box ticked).

- Tangent
VoSS

\ “~~._ Angle

\ S~

\

Toolpath Radius
Segment
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ZHeichts | FirstLeadIn LeadIn |Lead Out | LastLead Out | Extensions | Links |
1st Choice Ih‘ert’cal Arc j 2nd Chaice INone j
Distance ID.D [jskance. IT
Angle IF Angle IT
Radius IG-U Radius IT
[in Ao it Frran P |

e Select the Lead In tab and for 1st Choice input an Angle 90.0 and Radius
6.0 before clicking Apply at the bottom of the form.

There is now a Vertical Arc leading onto
most of the tool tracks. If the required
Lead Out is to be exactly the same as the
Lead In and vice versa the Copy to Lead
Out option allows easy copying of the
settings between the two.

The Leads in this area have remained
unchanged as any Vertical Lead In/Out
using the current Radius value would
gouge the model if allowed to appear.

e Select the Copy to Lead Out button.
|
v Gouge Check /

Copy to Lead Out | C

e Apply the form to update the Active toolpath.

Where the operation is gouge free a
Lead Out move, similar to the Lead
In is applied at the end of each tool
track.

The Leads in this area have
remained unchanged as any Vertical
Lead In/Out using the current
Radius value would gouge the
model if allowed to appear.
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ZHeights | FirstleadIn Lead In | Lead Out | LastLead Out | Extensions | Links |

1st Choice I'u'erh'cal Arc j 2nd Choice I'u'erh'cal Arc j

Distance ID-U Distance ID-D
Angle IQD.EI Angle IQEI.D
Radius IS.D Radius |4.III

| 0.0 COverlap Distance (TDL) R Opions.. . I

e Select the Lead In tab and for 2nd Choice input Vertical Arc with an
Angle 90.0 and a reduced value Radius 4.0.

e As before, select the Copy to Lead Out button before clicking Apply at the
bottom of the form.

PRETI Wherever it is gouge free the 1st
R Lo Choice of a Radius 6, Vertical
Vo N Arc, Lead In/Out is applied.

If this is not possible without a
gouge occurring, then the 2nd
Choice of a Radius 4, Vertical
Arc is attempted.

If neither the 1st or 2nd Choice is
possible without a gouge
occurring, then no Lead In/Out
will be applied to that part of the
toolpath.

Horizontal Arc Leads

This produces circular leads on the horizontal plane, and the Radius and Angle value is
similar to that for Vertical Arc. This type of lead is frequently used for toolpaths running at
constant Z, or with only small changes in Z height.

Tangent
\ T~~._ Angle

~

Toolpath Radius \
Segment
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e Right click on the Toolpath BN6-fin2 and select Activate.

e Select an ISO1 view. TR

e Open the Leads and Links form. =

e In the top Pull down menus select Tools - Reset Forms to return the
Leads and Links settings to default.

ZHeights | FirstLeadIn LeadIn |Lead Out | LastLead Out | Extensions | Links |
1st Choice |Hu:urizu:unta| Arc j 2nd Chaoice |Nnne j
Distance ID.D [istane I'I-.'I-
Angle IF Angle IE'—
Radius |3-D Radius I'Z'-'Z'
IF Owerlap Distance (TDU) Ramp Gptiens, .. |
T3 Al mbmrd mmimde b b e

e Change the 1st Choice Lead In to be a Horizontal Arc with Angle 45 and
Radius 3.0 then select the Copy to Lead Out button before selecting

Apply.

- E‘:‘.“‘«Wt There is no need to input a 2nd

o \i L :IE \K\ choice as the Horizontal Arc -

N AN Leads In/Out have appeared on all

0o e ‘_:"“ N kN the tool tracks. With Horizontal Arc

norL RN H\\ set, PowerMILL decides whether to

Ei ' . : AN use Left or Right hand arcs. They are

" RN also calculated to comply with the

'é' '''' ---~—~E—- '“'--———~-___ii~f¢\§»\ Gouge Check flag. If it is not

“{T}’ ¥ h ! possible to apply the specified lead

due to a gouge situation it will remain
as the default vertical move unless
the Gouge Check flag is unchecked
(not recommended).

e Inthe 1% Choice - Lead In input Distance 5 and Apply the form.

An additional (Distance) extension
move is added to the tool track before
o the original Lead In option ‘kicks in’.

B
S
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Extensions

Extensions provide the option for the user to add an additional lead move option onto the
existing Lead In/Out. As an example, a Vertical Arc - Extension will be added to the Lead
In/Out moves.

e Select an ISO2 view.
¢ In the Leads and Links form, select the Extensions tab and for both the
Inward and Outward options, input a Vertical Arc with an Angle 90.0 and

Radius 5.0. 3

ZHeights | FirstLead In | Lead In | Lead Out | Last Lead Out  Extensions | Links |

Inward | Vertical Arc i Qutward |Vertical Arc |
Distance [0.0 Distance [0.0

ande [200 ange [30.0

Radus [5.0 Radus [5.0

e Apply the form.

S 2
,’T<Y
' X

A Vertical Arc Extension has successfully been
added to all of the Lead In/Out moves.

Links

A Link is the movement from the end of a tool track to the start of the next. To provide for
more efficient movement of the tool across the component the height of the link moves that
connect adjacent tool tracks can be reduced to be closer to the local model form.

Short/Long Threshold - This defines the distance limit up to which the Short - Links apply.
Any move from the end of a tool track to the start of the next, which exceeds this distance is
defined as a Long - Link move.

For Short links the available options include Safe Z, Incremental, Skim, On Surface,
Stepdown, Straight, and Circular Arc.

For Long links the available options include Safe Z, Incremental, and Skim.

Safe links apply only at the start and end of a toolpath the available options being Safe Z,
Incremental, and Skim.

For users with a PowerMILL PRO licence:-

Where a machine control system will permit arc fitting of rapid moves the Arc Fit Rapid
Moves box can be ticked along with a suitable Radius based on the active tool diameter
TDU (Of particular benefit to High Speed Machining).
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e Activate the toolpath bn6-fin1 created earlier in the Leads section.

e Open the Leads and Links form. @]

e Inthe top Pull down menus select Tools - Reset Forms to return the
Leads and Links settings to default.

e Select the Z Heights tab to access the Skim and Plunge Distance boxes.

A N 3 .
&3 Leads and Links 2| The values will be left as
ZHeights | FirstLead In | Lead In | Lead Out | LastLead Out | Extensions | Links | default for the time being.

The Skim Distance is the
Incremental height at which

SkimDistance . the tool clears the model form
Plunge Distance
[50 | B between tool tracks.

The Plunge Distance is the
Incremental Distances | Previous Z-Height =l|| Incremental height at which
the tool rapids down to before
using the Plunging Feed Rate.

Radial Clearance | 0.0

e Select the Links tab to access the Link move options.
2| x|

Z Heights I First Lead In I Lead In I Lead Outl Last Lead Dutl Extensions  Links I

ShortfLong Threshold I 3.0 shart ICircuIar Arc vl

Retract and Approach Moves Long ISkim vl
Along ITDD| Axis VI Default lﬁafﬁ -

v Automatically Extend
’7 Maximum length IZSD.D

e Input the Short/Long Threshold as 3 (Link move distances less than this
value will use the Short link option and those greater will use the Long
link option).

e Select Short as Circular ad Long as Skim and leave Default as Safe.

e Apply the form.

Note that the distance between the
ends of adjacent fool tracks is greater
than the Short/Long Threshold value
in several areas of the toolpath (Skim
Link moves apply).
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e Change the Short/Long Threshold to 5 and Apply the form again.

Note that by increasing the value of the
Short/Long Threshold the number of
Short Link Cicular Arcs has greatly
increased.

The remaining lift and plunge moves
would benefit from Vertical Arc Lead
In/Out moves but not the existing
Circular Arc Links. This can be
achieved locally by selecting the
individual lift or plunge moves and then
applying the Leads and Links form.

Applying Leads and Links locally to individual tool tracks

e With the Shift key depressed, select the individual vertical moves where
the Long (Skim) and Default Links (Safe) have been applied.

2 )/
— A .
| : % The selected link moves to be
D modified are coloured dark
__1'%\__ yellow in the illustration to
—| assist with visualisation. In

reality, any selected item in the
! graphics area will be coloured
' bright yellow.

¢ |nthe Leads and Links form select the Lead In tab and select 1st Choice
as Vertical Arc with Angle 90 and Radius 5.

e Select the Copy to Lead Out tab and then Apply the form.

Z Heights | FirstLead In Lead In | Lead Out | LastLead Out | Extensions | Links |
1st Choice I'u'erﬁu:al Arc j 2nd Choice INnnE j
Distance IUU— Distance I?
Angle IF Amale IT
Radius IEU— Radius IT
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| 5 The existing Circular Arc -
£ Links remain unchanged while
:}I’ all of the selected vertical link

moves are applied with a
Vertical Arc - Lead.

e From File select Save Project to update the stored Project.

Additional Short Links options

In addition to Safe, Incremental, and Skim the following additional options are available in
the Short Links section. These additions are not available in the Long Links options.

On Surface
This links the tool tracks with a gouge free, direct move that follows the surface form.

Stepdown
The link move remains at a constant height and performs a gouge checked, move over to the
start of the next tool track where it then feeds down onto the surface.

Straight

In this case the link is a gouge checked, direct linear move to the start of the next tool track.

Circular Arc
This links the tool tracks with a gouge free, circular move that follows the surface form.
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Exercise

e Activate the toolpath BN6-fin3 and Apply the Leads and Links as
follows:-

Links:-
Long/Short/Default - Skim

Lead In:-
1st Choice - Ramp (Options - Max Zig Angle 4 and Ramp Height 1)

Lead Out:-
1st Choice - Vertical Arc - Angle 90 - Radius 3 and Overlap Distance 0.2

Overlap Distance continues the cutter before or after the natural end point (Along the
original toolpath) by a specified distance based on the Tool Diameter (TDU).

The finished Leads and Links will be as shown above.
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6. Boundaries

Introduction.

A Boundary consists of one or more closed (wireframe) segments, the main application
being to limit machining strategies to specific areas of the component. Earlier in the course
Boundaries have been utilised to limit machining strategies so that they occur in more
compatible areas of the component. For example Constant Z finishing is more effective on
Steep sidewalls and Raster finishing on Shallow areas.

There are several standard options available for Boundary creation.

O '
6 Level Create Boundary Block
@ stocq Pt b e

¥ Group:  Batch Process

Silhouette
8 Mago:,  Invalidate Al

Coflision 5afe
Deactivate Stock Model Rest
Draw All Contact Paint
Undraw Al Contact Conversion

Boolean Gperation,

User Defined

Thickness...
Edit 3

Create Folder

Delete All

User defined Boundary

This type of Boundary is created from several options via an additional sub-menu. While all
other main Boundary options involve interaction with other PowerMILL entities the User
Defined options generally involve direct conversion of existing wireframes.

C;Namell

~Insert B
Insert File @l

Boundary lﬁ _I .
potem ] | Boundary, Pattern, and Toolpath icons are greyed out but

O - become active on the selection of an entity. s
Model
o g Inserts the edge of the selected model.
S Enables free form or coordinate segment input.
Opens Composite Curve generator.
Opens Wireframe Modelling.

Wireframe modeling £\|

Model Tolerance I 0.1

Edit éj
s
Clear hﬁi

Edit

Apply I Accept | Cancel |

e From the main pulldown menus select File - Delete All.
e From File Import the model:-
D:\users\training|PowerMILL_Data\Models\cowling.
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e Select the surfaces defining the central pocket and fillet.

e In the explorer right click over Boundaries and select Create - User
Defined and in the User Defined Boundary form left click the Model icon

(arrowed above).

A Boundary segment is created
around the edge of the selected part
of the model.

e Select a View from top (Z) and switch off the Shading retaining the
Wireframe view.
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e In the explorer right click over Boundaries - Create Boundary - User
Defined and in the User Defined Boundary form left click the Sketch

icon. sketeh @

The Curve Editor toolbar (shown below) will appear above the Graphics area.

= e R I

B RRE /KB | kN6,

¢ In the Curve Editor toolbar select the Curve editor options icon. ﬁg

@ Options 21x]

- Tolerances .

E3-Toopaths Intelligent Cursor

[+ Tools

._ View ~ [ Use the Inteligent Cursor 7]_

__ Impert Curves v

[~ NC Programs Models ¥

[- Setup Sheets Inside sutface patches W

[~ Unit System

[ Curve Editor heatrcs
- Curve Fitting Tolerances Workplanes [#
- Inteligent Cursor Elack [#

f

e Select Intelligent Cursor and untick the Use of Intelligent Cursor box to
enable full ‘free form’ sketching to occur.
e Accept the form.

¢ In the Curve Editor toolbar, select the create Continuous Lines option. ﬁ|
e Using the left mouse key, snap points to create a sketched Boundary.

Note: Do not attempt to close the
segment by trying to snap the ‘final
span’ back on to the start point. Use
the Close segment icon to achieve an

exact match. :]|

e Forany invalid points, sequentially remove using the Undo icon ﬂ and
to insert the final span select the Close segment icon. :]

Points can also be input as exact Incremental values, using X Y Z coordinates in the data
input box, located in the Continuous Line toolbar.

[
Z0J & | > 20 g~ 2000 x|
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e Once the segment is closed, exit the Continuous line toolbar by selecting

the small cross at the far right.
Z0J ¢ @

¢ In the Curve Editor toolbar, select the Accept changes iconﬂ to
accept and close the Sketch Boundary session.

e With the segment selected, right click on the new Boundary and in the
local menu click on Edit - Spline to open the following form.

|
[0 v K

e Enter a value of 0.5 before selecting the green tick to apply and close.

N

The Boundary segment is splined through the polyline points where doing so maintains the
original form to within a maximum deviation of 0.5. In instances where this is not possible a
tangency will remain either side of the point.
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Selected Surface Boundary

A Selected Surface Boundary defines one or more segments where the active tool looses
contact with the selected surfaces. The segments represent the tip of the active tool.

e Create a Ball Nosed tool of Diameter 16 with the Name bn16.
e Select the surfaces defining the central pocket including the fillet.

the explorer right click over Boundaries and select the option Selected

Surface.
%-l @ Name lz—
Top ™
Rall Over ™

[ Tolerances
Tolerance IT
Thickness [0.0
fcial Thickmess IT
@ Use Axial Thickness [

Tool

Iﬁlj |Bns |

1 Limit Boundary
& Inside Lirniting Baundary:

] Gutside I 'l
| Automatic Colision Checking

Halder Clearance IIII.IZI
Shank Clearance I 0.0

Apply I Accept | Cancel |

e Using the above settings Apply the form to create the above Boundary
segment.
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Shallow Boundary

This type of Boundary defines one or more segments where the model drops through a
specified Threshold Angle downwards from the horizontal plane. It is designed to
differentiate steep and shallow areas where Constant Z and Pattern strategies are
respectively, more effective. The Boundary is calculated relative to the Active tooling
parameters.

e In the explorer right click over Boundaries and select the option Create

Boundary - Shallow.

| o .
S—— Typical area more suited to a Pattern strategy (above 35 degrees).
%_l ), Name [3

Upper Angle l?
Lower Angle IT
rToleranees———————————————
Tolerance IT
Thickness ID.D
Y Al Thickness I':-.E-
Q Use Axial Thickness [~
Tool
IH j [ers =l

1 Limit Boundary
& Inside Lirnitirig Boundars:

| Dutside I 'l
I Automatic Colision Checking

Holder, dlearance IE-.E-
Shiank Cearance III-.E-

Typical area more suited to a Constant Z strategy (below 35

Ay | Accept | cancel | degrees),

e Using the above settings Apply the form to create the above Boundary
segments.

Silhouette Boundary
This type of Boundary defines the 2D the outline around the selected model adjusted to the

contact point of the tool along Z.

e Select the following surfaces on the model (use the Shift key to enable
multiple Selection).
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¢ Right click over the model in the graphics area and in the local menu
select Edit - Delete Selected Components.

e With the shutout areas now deleted, right click over Boundaries in the

explorer and select the option Silhouette.
. MName |3

On Model V¥

~Tolerances

Tolerance ID.]
Thickness ID.D
fial Thickness IIJ.I]

1
Q Use Axial Thickness [~

Tool

Igj E5 =l

1 Limit Boundary
& Inside Limiting Boundary,

€ Gutside I 'l
I Automatic Colision Checking
Holder Clearante I 0.0
Shank Clearance I 0.0

Apply I Accept | Cancel |

Rest Boundary

This type of Boundary defines the area inaccessible to a specified Reference tool. It also

requires an (smaller) active tool to be specified otherwise it will not generate segments.

¢ Delete all existing Boundaries (In the explorer, Right click on
Boundaries and from the local menu select Delete All).
e Create a Ball Nosed tool of Diameter 8 with the Name bn8.

¢ In the explorer right mouse click over Models and select Delete All to

remove the now (incomplete) component.
¢ Import the original (complete) Model back into the Project
(D:\users\training\PowerMILL_Data\Models\cowling).
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e In the explorer right click on Boundaries.
e Select Create Boundary and select Rest to open the Rest Boundary

form. 2]
%J{_-‘:l: MName |3

Detect Material Thicker Than I 0.2

Expand Area By I 0.0
Tolerances
Tolerance ID.I
Thickness ID.EI
g il Thickness IEI.EI
Q Use Axial Thickness [~
rToal
[EE—
Reference Tool

Iﬁlj [Bru1s i

1 Limit Boundary
% Inside Limiting Boundary

) Qutside I 'I
| sutomatic Collision Checking
Holder Glearance I 0.0
Shank Elearance I 0.0

Apply I Accept | Cancel |

e  Modify the values in Expand Area to 0, enter bn8 as the Tool, and bn16
as the Reference Tool and click Apply to create the following Rest
Boundary.

e  Accept the form. ,_I/

Select a View down the Z Axisl and Undraw the model.

L@

The above Boundary identifies areas on the component that are inaccessible to the bn16 tool
geometry to be locally machined with the bn8 tool. On closer inspection the central pocket
area would be more effectively machined with a flat bottomed tool and a smoother more
continuous toolpath will be achieved if the 2 spurs were removed from the outer segment, to
be machined later as a separate toolpath.
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Block Boundary

This Boundary option creates segments as a profile around the Block definition.

In Rapid Move Heights - Reset to safe heights.

Use the default Start and End Point settings.

Calculate a Block, Defined by Box with Type Model.

In the explorer right click over Boundaries and select the option Block.
21 x]

(= MName I 1
Block
’7 Type IBox @l

The resultant 2D Boundary is defined around the outside edge of the Block at Z0.
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Editing Boundaries

e In the explorer right click the Boundary (1) icon to open the local pull
down menu and select Edit — Copy Boundary to create a copy named
(1_1).

e In the explorer right click over the new Boundary and Rename as
master.

e In the explorer click (off) the light bulb adjacent to the copy (master) to
remove it from view in the graphics area.

e Delete the 2 inner segments on Boundary 1 by boxing over them with the
left mouse (select) and press the Delete key on the keyboard.

The next stage is to remove the two spurs (arrowed) which will be carried out after an
explanation of the Boundary Editor Form.

Boundary Editor Form and Pull Down menu

Once created, a Boundary can be modified through a series of editing options accessed from
the Boundary Toolbar via the Edits icon. Alternatively the form can be accessed by right
clicking the actual Boundary in the Explorer and selecting Edit — points in the local pull
down menu.

Mode IDeIete Paint j

Move Point To
Move Point By
Insert Paint

| Accept |

The Mode options provide various Point editing functions as described below.
Delete Point - Selects individual points on a boundary segment to be deleted.

Move Point To — Selects a point to move to absolute X, Y and Z co-ordinates or indicate the
position with the Left mouse button.

Move Point By - Selects points to move incrementally by X, Y and Z values.

Insert Point - Selects two points on the boundary between which to insert a point.
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e Right click over the original Boundary icon (1) in the Explorer and select
Edit — points in the local pull down menu.
e Select the Mode — Delete Point and Zoom into one of the spurs to provide

easier access.

For improved access to close proximity,
points Zoom in closer as required.

e Box around the main area of the spur and Apply the form to delete the
selected points (Individual points can be selected or deselected if left
clicked with the Ctrl key depressed or for select only using the Shift key).

e Repeat the procedure on the other spur (as shown on the following page).

Further editing options can be found by right clicking over a Boundary either in the graphics
area or in the explorer then selecting Edit.
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EYL K]
ﬂ MNC Programs
& Tookpaths
-4 Tools
=) Boundaries
R @i
ogd g
4 Patter
of Featn  Copy
o Workp Paste
=& Leveks
=i Model
& stock
7 Graup
) k=i Macro:

v Activate
Activate Workplane

Settings...

Recreate Block
Select Surfaces

v Draw
Add to Folder
Rename
Select All
Deselect
Save
Insert P
Faints. .
Calrulate
i Arc Fit Selected
Rermove from Folder Spline Selected
Delete Baundary Polygonize Selected
Flatten
Offset 30

Offset 2D (Round Corrers)
COffset 2D (Sharp Corners)

Select Duplicates
Select Area

take Invalid

Copy Boundary
Copy Boundary (selected only)

Delete Selected Components

PowerMILL

Boundary |3 'I
Active Workplane I VI

Transform Copy |

Distance ID-D
Angle ID-D

~Scale
S@ @ E Scale I 1.0

r~ Mirror in Plane "Transform To—]

Transform:-

r~Relative Position

% V¥ 2z

Rotate

X ¥ &

&)

Accept |

Move — moves the selected boundary or segment by a
specific distance in X, Y or Z.

Rotate — rotates the selected boundary or segment around
X,YorZ.

Scale — scales the selected boundary or segment by a
specific amount.

Mirror — mirrors the boundary in the XY, YZ or XZ
plane.

Workplane Transform — moves the boundary so that it is
in the same place relative to the workplane as it was to
the global transform.

Points — displays the Boundary Editor Form.

Arc Fit Selected — Arc fits along selected boundary segments.

Spline Selected — Splines a curve through points on the selected boundary segments.

Polygonize Selected — Converts a curved boundary segment into a series of straight lines.

Flatten - This option flattens the boundary making it 2D.

Offset 3D - This offsets the boundary by the distance specified along the component

surfaces.

Offset 2D - This offsets the boundary by the given distance whilst flattening it automatically.

Select Duplicates — selects all duplicate segments of the boundary and can be used
effectively in conjunction with the Delete Selected option.

Select Area — Selects segments Greater Than, or Less Than the Ratio of the Tool

Area.

Make Invalid — De-calculates an existing Boundary.
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e Select the outer segment of the Boundary (1) and Right click on it’s
Boundary Icon in the explorer to open the local pull down menu.

. Patterns
ﬁ? Feature 5¢
i Workplane
[ Q Levels anc
- Models
. cowlini
& stock Mod
+--# Groups
£ Macros

Y - -] |

3

Copy
Faste

v Activate
Activate Workplane

Settings...
Parameters...

Recreate Block

Select Surfaces
v Draw

Add o Folder

Instrument

Rename

Select Al

Deselect

Save

Insert 3
Calculate

Undo Last Edit
Redao Last Undone Edit
Clear History Buffers

Unlock Boundary

Curve Editor...

GE Spline fitting tolerance

|0.1

Transform...

Paints...

Arc Fit Selected

Spline Selected

Polygonise Selected

Flatten

e Select Edit — Spline Selected entering a tolerance value of 0.1 in the form
before clicking the Green Tick to apply.
e Re-select the outer segment to visualise the effect of the Spline option (as
shown above right).

The Selected Segment has now been Splined (curve fitted and repointed within the specified
tolerance value) to produce a smoother form with any unnecessary points removed. This will
improve the quality of subsequent operations such as offsetting of the boundary.

¢ Right click on the Boundary icon in the explorer to open the local pull
down menu again.

e Select Edit - Offset 3D entering a value of 1 in the form before clicking the
Green Tick to apply (All Boundary segments are Offset relative to the

surface normals of the component as shown below).
Y- 5| |

i 8 patterns
1_‘:9 Feature Set
- Workplanes
Q Levels and &
é @ Models
. cowling
-4 Stock Modek
/ Groups
-8 Macros

Copy
Paste

v Activate
Activate Workplane

Settings...
Parameters...

Recreate Block

Select Surfiaces
v Draw

Add |bo Folder

Instrument

Rename

Select Al

Deselect

Save

Curve Editor...

Insert L3

Transform...

Calculate

Foints. ..

Undo Last Edit
Redn Last Lndone Edit
Clear History Buffers

Arc Fit Selected
Spline Selected
Polygonise Selected

Unlock Boundary

Remove from Folder
Delete Boundary

Flatten

Offset 2D (Round Corners)
Offset 2D (Sharp Corners)
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¢ In the explorer click (on) the light bulb adjacent to the copy of the original
Boundary (master) created earlier (It will be displayed alongside the
edited Boundary (1) as shown above illustrating the effect of the 3D
Offset). %“-.

e Select the Toolpath strategies icon
select the Finishing options.

21|

' 2.5D Area Clearance | 3D Area Clearance | Blisks | Driling I Favourites  Finishing IPorts |

to open the following form and

Offset Finishing I @l Q‘ I
Constant Z Finishing
!Corner Along Finishing ~Preview

- Corner Pendl Finishing
< Corner Stitch Finishing
FE Pattern Finishing

[ dradial Finishing

|=— Raster Finishing
{2 |Spiral Finishing

0K I Cancel |

e Select 3D Offset Finishing to open the following form and enter data
exactly as shown below.

@¢ 3D Offset Finishing x|
_6‘;@| | Mame IbnS_al
[Te - Spiral [
Ii:jl j fBns =& zl
Mawximunn @fsets [ I 10
Tolerances
Tolerance ID-DZ &l Patternl vl Ql
Thickness Start on Pattern [
ID.D 5]
’7_@" Q Direction ICIimb vl
Stepowver
Stepover IU-5 _,Ll
rBoundary

EE|; 3 9)
Trimming IKeep Inside vl

e Apply the form to create an alternative form of Rest machining using the
modified Rest Boundary (1) as the limit for the 3D Offset strategy
bn8 a1.

¢ As soon as the toolpath has been created Cancel the above form.
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e Undraw the Toolpath (bn8_a1) and Boundary (1) by switching off the
respective light bulb symbols in the explorer.

e Select the outer segment of the displayed Boundary (master).

e Right click the Boundary icon (master) in the explorer to open the local
pull down menu and select Edit — Copy Boundary (selected only) to
create a new Boundary (master_1) consisting of the outer segment only.

e Open the local pull down menu again and Rename the copy as (2).

e In the explorer click (off) the light bulb adjacent to the Boundary (master)
to remove it from view.

L.

e Right click over the Boundary icon (2) in the Explorer and select
Activate followed by Edit — Points in the local pull down menu.
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Select the Mode — Delete Point and select all points on the remaining
segments apart from the upper spur.

Apply the form to delete selected points as required (in stages) gradually
zooming into the upper spur for easier access (as shown below).

»
»

Once the above rectangular form remains Zoom onto the lower end.

In the Explorer right click the Boundary icon (2) to open the local pull
down menu and select Edit - Points.

Select the Mode — Move Point By and select both points at the base of
the upper spur and enter X0 Y-1 Z0 in the form (as shown below).
Apply the form to incrementally move the selected points a distance of
Y-1 to provide additional overlap into the Boundary (1).

Mode IMDVE Point By j
X |0.0 ¥ [-10 z |00
Apply | Accept |
____‘—'-——_____'___,_————_
Press Accept. @ 9

6.16 Issue PMILL 9



PowerMILL 6. Boundaries

e Resize the View. @I

e In the explorer right click the Boundary (2) icon to open the local pull
down menu and select Edit — Copy Boundary to create a copy (2_1).

e Using the local pull down menu again, Rename the copy as (3).

e In the explorer right click the Boundary icon (3) to open the local pull
down menu and select Edit — Transform — Mirror in Plane ZX.

The 2 separate spur boundaries can be Appended together either dynamically within the
Explorer or by using the Insert option in the local pull down menu. This example will use
the first method.

e Move the cursor over the Boundary (3) icon in the Explorer, depress the
left mouse key and keep it down.

e Depress the Ctrl key on the keyboard and also keep it down while the
cursor is moved to the right (Observe the small circular symbol with a
diagonal line across it along with a ghosted image of the Boundary icon).
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e Still keeping the left mouse key and Ctrl key depressed, move the cursor
up and across to the Boundary (2) icon.

¢ Release the left mouse key first followed by the Ctrl key (a copy of
Boundary (3) will have been appended into Boundary (2)).

¢ In the explorer right click the Boundary icon (3) to open the local pull
down menu and select Delete Boundary.

"
e Select the Toolpath strategies icon & to open the following form and
select the Finishing options.

_ 21|
' 2.5D Area Clearance I 3D Area Clearance | Blisks I Driling I Favourites *rinishing |Ports I

£ 3D Offeet Finishing E@ QL |

&= Constant Z Finishing

| corner Along Finishing Preview

L. Corner Pendi Finishing

k== Corner Stitch Finishing

Pattern Finishing
Radial Finishing

\ OK I Cancel |

e Select Raster Finishing to open the following form and enter data exactly
as shown below.

@&# Raster Finishing 2=l

@' Name |bnd_a2

—Tool Elj IBNB j ﬁ — IT

Start Cormer | Upper Right j

Tolerance ID.DZ &l  Perpendicular Pass
Thickn Perpendicular Pass [T
ickness
’7 Dl II:I.I:I Hd Shallow Anale I 30.0

optimise ParallelFass [

rTolerances

rOrdering
Stepover I 0.5 |
ne A One Way Grouped j

~Boundary arc Radius I 0.0
Carners

Trimming IK.EED Inside vI ArcFit [

Ao

e Apply the form to create a local finishing strategy using the modified Rest
Boundary (2) as the limit for the Raster strategy bn8_a2.
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The machining strategies have been localised and the tooltrack shape controlled with the help
of edited Boundaries originating from a single Rest Boundary.

e Save the Project As:-
D:\users\training\COURSEWORK\PowerMILL-Projects\Boundary-tests
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Creating Blanking Surfaces using Boundaries

Blanking planes are used to cap holes and pockets in a model to prevent the tool from
machining those areas. There are three types of Plane than can be created in PowerMILL.

1. Block - allows the creation of a plane at a specific Z Height after the material Block
had been defined.

2. Best Fit — creates two planes, one touching the boundary at its highest point and the
other through its lowest point. The planes are parallel to the best fit plane (the plane
that has the smallest maximum distance from the Boundary).

3. Projected — creates a plane parallel to the X Y axis of the active workplane. The
plane will have the Z Height of the highest point of the boundary.

Example
e Delete the current model, toolpaths and boundaries.

e Import the model:-
D:\users\training\PowerMILL_Data\Models\pockets.dgk

e Define the Block to Min/Max limits.
e Select the top surface of the model (shown shaded).

e Create a User Defined Boundary, select the icon Model and Accept the
form.

[:;Namell

Insert

Insert File @l
Boundary I vI |

Pattern I vI |
Toolpath I "I |

Model & q
setch (7% | The boundary produced has 3 inner segments. For this
. — example only the two smallest segments are required.
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e Select the two highlighted segments by dragging a window over them.

¢ Right click over Models in the explorer, and select Create Plane -
Projected.

Two blanking planes are
created as shown.

e Select File- Delete All and Tools - Reset Forms.

In the Models area of the explorer, a new model called Planes has been created.
To delete the planes simply right click over Planes and select Delete Model.

Exercise

e From Examples, open the model bucket.dgk and generate 4 surface
planes to cover the foot recesses on the upper base surface.
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7. Levels and Sets

Introduction

Levels and Sets provide a more specific method for controlling whether groups of model
components are selected or displayed within the PowerMILL, graphics area.

Any selection of component parts in the imported CAD Model can be Acquired to a Level
or Set. Once assigned to a Level or Set, model components can be collectively selected,
undisplayed, deselected, or displayed using the local menu options. The subtle difference
between Levels and Sets is illustrated during the following worked examples.

Level Creation

e From the main pulldown menus select File - Delete All.

e From File - Import Model select:-
D:\users\training|PowerMILL_Data\Models\CowlingWithClamps.dgk

The imported model includes clamps which must be avoided by all machining strategies
created in the Project. Also, the clamps are not to be included during the calculation of the
Block.

To make the model selection process easier, a new Level, Named Clamps will be created
and all clamp Surfaces will be acquired to it. Another Level, Named Splits will be created
and all 6 of the split Surfaces will be acquired to it.

e Create a Dia 16 + 3 Tip Radiused tool named D16t3.
¢ In the explorer right mouse click on Levels and Sets to access the local
menu and from it select Create Level.

=] Q Levels and Sets
o Levels and Sets
(=g Model

@
‘ Stack Create Set
¥ Group Deactivate

=8 Macro Draw All
Unidraw &l

Delete Empty Levels and Sets
Delete All Except Non-Empty Levels
T
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= Q Levels and Sets
'I Q General
&2

'

= Q Levels and Sets

e Rename the new Level as Clamps.
e Create another new level and Rename it as Splits.

All model components are currently Acquired to the default General Level.
If the original CAD model has components already assigned to different Levels then these
will be recreated in the PowerMILL Project on Import.

Acquiring model entities to a Level

¢ Inthe explorer left click on the light bulb on Level Clamps to switch it off
(If any items are acquired to this level they will be currently undisplayed).

e Inthe Graphics Area use the Shift key and Left mouse button to
accumulate the selection of all the surfaces that define the clamps.

e In the explorer right click on the Level Clamps and from the local menu
select Acquire Selected Model Geometry and observe that the clamps
disappear from the view (The Level is switched off).

e Select the 6 Surfaces defining the split face and acquire them to the level
named Splits.
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e Switch offthe level named Splits to prove that the correct surfaces have
been acquired (as shown below).

e Switch on alllevels (The clamps and split faces will reappear).

A Selected Surface - Boundary will be created to protect the clamps from being
inadvertently machined.

¢ In the explorer right mouse click on the level named General and from the
local menu click on Select Surfaces (The main component surfaces
excluding the split faces will be selected).

e While still in the explorer right mouse click on the level named splits and
from the local menu click on Select Surfaces. (The split face surfaces
will be added to the current selection).

e Calculate a Block using the default Box and Model options.

e Use default Rapid Move Heights and Start and End Point.

@ Block 21|
Defined by IBox vl ,':‘-_’.-lé‘/g L ﬁ
~Limits
Min Max Length
x [-100.0 %J [190.0 %J [2s0.0 %J
v [-50.00316 %J [ 50.00551 %J [ 1000088 %J
z [400 %J [30.0 %J [70.0 %l %\S\
—Cylinder Parameters
Cenitre # I 45.0 Diameter ID.EI CE
Centre  [0:001175 ﬁ @
~Estimate Limits
Tolerance ID.I Type IModeI vl
Expansion IU-U Calculate
Draw || Opadty |———

Accept | Cancel |

The Block will be created to the dimensions of the selected surfaces.
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e Left mouse click in the graphics area away from the model to deselect
all entities.

¢ Inthe explorer right mouse click on the level named General and with
the Ctrl Key held down left mouse click on the level named Splits.

= Q’ Levels and Sets
0 Q’ General
'I @' Clamps
i siics
o W Madale

Both the selected levels will be highlighted in the explorer.

e Right mouse click on one of the highlighted levels and in the local menu
click on Select Surfaces (All surfaces excluding the clamps will be

selected).

e Create a Selected Surface Boundary with Radial Thickness 2 ,using the
current selection to produce the following segment.

&7 Selected Surface Boundary. E|r‘5__<|

B] & ene

Top ] E

Roll Ower [

Tolerance
Radial Thickness
Azxial Thickness

2]
Use Azxial Thickness

M DI6T3 v

Tolerances

e Manually select the surfaces defining the central pocket (including the

e Right mouse click on the existing Boundary and from the local menu
select Insert — Model to add a new segment (Shown above right).
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¢ In Toolpath Strategies - Finishing select Raster Finishing and input the
data into the form exactly as shown below.

&7 Raster Finishing

Mame El :
Tool [
= r angle [ 1350 |
:EJ" |D16T3 v| ngle | 1350 |
Start Corner | Lower Left
n|=raTcrsE .
Talerance : 0.1 1 Perpendicular Pass
Perpendicular Pass [
Thickness
lo0 1 '
oo |
Skepover J
| — Qrderin
Stepover | 1.0 1 2 [Twowar B
Ml | T Way v
Boundary ArcRadius [ |
r T Wi [ [ s s e s B =]
[
T — Corners
Trimming | Keep Inside - arc Fit []

e Apply and Accept the form to create the following finishing toolpath.

. The outer boundary
segment provides a 2mm
clearance around the clamps.

Switching Off a Level

¢ In the explorer switch off the light bulb on the level named General.

Only the Clamp and Split
Surfaces will be displayed in the
graphics area.
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¢ Right mouse click on the toolpath and from the local menu, select
Settings to re-open the form.

e Select Make a Copy before selecting Apply and Accept to generate a
copy of the same Finishing strategy.

If a Level is switched
off, PowerMILL will
still create toolpaths
over the acquired,
un-displayed part of
the model.

Sets

A model entity must always be acquired to a level but can only exist on one specific Level at
the same time.

Sets differ from Levels in that the same model entities can exist on more than one Set at the
same time or none at all.

From the main pulldown menus select File - Delete All.
e From File - Import Model select:-
D:\users\training|PowerMILL_Data\Models\YogurtTray.dgk

e Manually select all surfaces defining the 9 pockets.
e Create a Set and rename as AllPkts-Set.
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Right mouse click on the Set, AllPkts-Set and from the local menu select

[}
Acquire Selected Model Geometry.
B Q = Q Levels and Sets
; g ie Levels and Sets " é? ceneral
& g Mo kel %% > AlIPKEs-Set
[+ voohurt b
e Manually select all surfaces defining the bottom left pocket.
)
!’4 ] The selected Surfaces will soon
’, AT be acquired to two Sets at the
"}‘__,_ 4 same time.
e
| ‘.!."
R
e C(Create a Set and rename as Pkt1-Set.
e Right mouse click on the Set, Pkt1-Set and from the local menu select
Acquire Selected Model Geometry.
e Switch offboth Level - General and Set, Pkt1-Set. = £ Levels and Sets
e Switch onthe Set, AllPkts-Set. ¢ Gereral
£ > AllPkts-Set
¢ £ Phet-set

All surfaces acquired to
AllPkts-Set will be displayed.
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o Switch offthe Set AlIPkts-Set and then Switch on the Set, Pkt1-Set.

All surfaces acquired to Pktl-Set are displayed. These are also included
as displayed when the Set, AllPkts-Set is switched on and Pkt1-Set is
switched off. This illustrates that model entities can be acquired to
different Sets at the same time.

e Switch off the Set, Pkt1-Set and then Switch on the Set, AllPkts-Set.

e Right mouse click on the Set, AllIPkts-Set and from the local menu click
on Select Surfaces.

e Create a new level and rename it as AllPkts-Lev.
In the explorer right click on the Level AllPkts-Lev and from the local
menu select Acquire Selected Model Geometry.

e Switch off all Levels and Sets except AllPkts-Lev.

All surfaces acquired to
AllPkts-Lev will be displayed.

¢ Create a new level, rename it as Pkt1-Lev, and switch it off.
¢ Manually select all surfaces defining the bottom left pocket.
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¢ In the explorer right click on the Level Pkt1-Lev and from the local menu
select Acquire Selected Model Geometry.

=-£7 Levels and Sets

g £ General
1 £ = AllPkts-Get
y &5 Pre1-Get
9 Q AlPkts-Ley
v & [Ny
= BB Hodel Pkt1-Lev
+ i@ yoghurt tray
& stock Modsls Activate
_F Groups Draw
-8 Macros Rename

select Al

Select Wireframes
Select Surfaces
Deselect

Acquire Selected Model Geometry

All surfaces defining the bottom left pocket disappear from the view on being acquired to the
(switched off) level Pkt1-Lev. This illustrates that unlike Sets, it is not possible for model
entities to be acquired to more than one Level at any one time.

e Switch on Level Pkt1-Lev and the bottom left pocket surfaces will be
displayed again.

Note:-

When using a combination of Levels and Sets on the model it is good policy to keep the Sets
visually, switched off. If a particular set needs to be selected then this is achieved by right
mouse clicking on its icon in the explorer and using one of the Select options in the local
menu. This will prevent confusion if the user switches a Level off only to find the included
items are still visible due to a set containing the same items being switched on.
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8. Editing Toolpaths

Toolpaths

Any information stored in the PowerMILL explorer including toolpaths will be lost upon
exiting the program, unless saved in a Project.

Options Form

The default options for Toolpaths can be tailored to suit the user application. They are found
in the main pull down menus under Tools - Options followed by selecting the ¥ next to
Toolpaths to access the relevant options. The main options applicable to Toolpaths are as
illustrated below:-

20
o= Raise Dialogue - Opens the machining form
_ complete with settings on activation of a toolpath.
- Selection Raise Dialog [~
i Caleulation
Drawing
T Cutting/Connection Moves - enables the selection

" of cutting or connection moves in the currently active
utting Moves [V
Connection Moves ¥ toolpath‘

22l Auto Activate - The most recent toolpath is
[ automatically made active.
- Activation . 3 1
st _Jwaaser | Save on Calculation - Automatically Saves the
~Drening active Project on the creation of a toolpath.
zix| These options control the visual size of the Tool

i CET | Axis Length and Contact Normal Length
:;ha\::g:n Tool Axis Length [ 10.0 dlSplayCd
Contact Normal Length | 10.0

Some of the options located in the Tools options also relate to Toolpaths:-

12 Feed Rate Plunge Factor -When loading the
:;E'jfﬂ”;&s Feeds and Speeds cutting feed rate from a tool, the plunge rate is set
# Toolpaths . .
5 Tooe as the defined Factor of the cutting feed.
I Fcs oo 1 Auto Load Feed Rate — Sets the cutting Feed Rate
v awlaredie v | defined with the tool as well as the percentage
Bipot wwtesogpsict” | Plunge Factor on tool activation.
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Editing Toolpaths

The toolpath editing options are accessed in the PowerMILL explorer by right clicking on
the Active Toolpath and selecting the Edit pull down menu, as shown below.

£ nC Programs ansform...
= TMID?;“S -Lrimit.F.o
v e 1 Divide.
vy EER corder...
VIrEBs 2 r’!nvEdStBrthnts.‘.
-¢ t B4 T omuemromsat ool A
¥ Tools Update Feed Rate Inside Boundary... . .
o il ——— . ! Note; It is also possible to access the menu by
w7 Patterns Activate Workplane CNC Cutter Compensation Full Radius Repair. .. . . .
T e L§ft mouse clicking over the Active Toolpath
B D ieebenase | Mk displayed in the graphics area.
(=i Models Recreate Bock Set Named Parameter
& stockModels | Select Surfaces Set Start Point
(¥ Groups Draw Set End Point
-5 Macros Drawing Options »  SetRapid Moves
Colour 13 SetFeed Rates . . . . .
Renane fa::"‘“‘m - X Alternatively a toolbar is available containing
Save s Tenplate G : i : ;
- *| icons to access editing functions for the active
) E;f[a:e Individual NC Programs - tOOlpath.
Load Settings Copy Toclpath
Statistics... Explode Composite Toolpath
:::”’ES ,  Combine Composite Toaipath
W Replace Tool
Delete Selected Companents

Urlock Toolpath

Remove from Folder
Delete Toolpath

Right click on Toolpaths in the explorer and from the menu, select Toolbar.

RN Tooipotis
V)i

Toolpaths |
ook |
I

Create Toolpath. ..

----- @ MC Programs |

A D eATIVEST| & | Eresermng - | T B FTK

The toolpath toolbar will appear at the top area of the screen. The options will only be
available for use while a Toolpath is Active.

ﬁ Transform Toolpath e |

Edit >Transform

Toolpath |z ﬂ
Active Workplane |1 =l | The transform option allows the user to Move,
Active ¥ oraw v | Rotate, and Mirror toolpaths relative to an active

Transform Copy [ Workplane.

—Relative Position

3 % =2 Distance I':'-':'
Rotate

EY @ weefo

—Mirror in Plane
E

=t st et

Accept |

"Transform To—

LS
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Relative Position Transform — Move
X ¥ & Distance - The Move function allows a selected toolpath to be
moved a user defined Distance along a selected axis.

Transform — Rotate

Rotate The Rotate function allows the rotation of a selected

X X & Ange toolpath by a user defined Angle around a selected X Y or
7, axis.

, , Transform — Mirror
r‘i'rmrzlg F'!!arge This provides 3 options to Mirror a selected toolpath across the XY, XZ
;—.J (s ol or YZ planes. This is useful for creating toolpaths for a right-handed
component from a toolpath calculated for a left-handed component, or

vice-versa. It will also be necessary to mirror the model and re-apply leads and links if the
new toolpath is to be verified to check for gouges.
It is important to note that when a toolpath is mirrored the cutting direction effectively
becomes reversed.

For the following example a single toolpath will be created and the Transform - Move
option applied to produce toolpaths for the remaining cavities.

e Delete All and Reset forms.

e From File — Open Project browse the form and select the Project:-
D:\users\training\PowerMILL_Data\Projects\EditToolpath_1

The Project contains a multi
cavity and a Dia 8 Ball Nosed
tool.

A toolpath will be created in the
lower left cavity that will be
limited to a Selected Surface
Boundary.

Save Project As:-
e D:\users\training\ COURSEWORK\PowerMILL-Projects\Transform

e Calculate a Block to Min/Max Limits and Lock &Ed to the global
coordinate system.
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e Select the surfaces defining the bottom left pocket shown below.

BB coundarics| I
----- % Patterns Boundaries
[;j;f e ootr.. * Right click over Boundaries in the
1€ Leveks and TR Slock explorer and select Create
[+ il Models Paste asnew Boundary Rest Bou ndary - Selected SU I‘faceS .
‘ Stock Mod: Boundary Mames »
""" ¥ Groups Batch Process ET{l_o_i_

o oaa

%J@ Namell

ol Om ; » Select the option Roll Over.
Tolerances
Tolerance IW
Thickness [0.0 | e Enter a Tolerance 0.02.
fxial Thickness IT
@ Use Axial Thickness [~
—_ A Selected Surfaces - Boundary defines the limit where the
|ﬁ| | [en10 =l selected tool and associated parameters would lose contact
with the selected surfaces while simultaneously

compensating for any adjacent unselected surfaces.
The option creates Boundary segments based on the total

1 UmitBoundary ————— selection and not individual surfaces.
% Inside Lirniting Baurdary,

) Outside I ‘I
| Automatic Collision Checking
Halder Glearance I 0.0
Shianh Clearance I 0.0

Apply I Accept | Cancel |

e Apply and Accept the form.

e Select a Constant Z Finishing strategy.
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§# Constant Z Finishing el |
158 | - | ore [Pockers e Enter Name — Pocket1.
*-}_;8 N Pocket1
[ Tool _ Spiral [T
Iﬂj IBNID j g [~ Stepdown
derances Minimum Stepdown [05 e Set Tolerance 0.02.
TCEes ID'DZ b_\l Calculate Using Cusp [~
Thickness ) =
’7@ IF @ [aximum Stepdown I 5.0
- Cusp Height: I 0.1
- Stepaver: Corner Correcion———————————————— |
Stepover I _l ArcFit [
1, 050
—Bountflary arc Radius (TOW) =1
R [—D
Trimming IKeep Inside vl Pocket Machine W
AddiforalStock [ 0.0
e i [ oesen[as =] | o Set Direction— Climb.
Lead Out INone
Short Links [Skim o Set all Links to Skim.
Long Links ISkim
2
Tool Axis
Tool Axis I\l'Ertiml g
[ preven | o e Apply and Cancel the
Apply I Accept | Cancel | form'

This toolpath will be transformed
to create toolpaths for the
remaining pockets.

e From the PowerMILL explorer — Toolpaths - Pocket1 local menu select
Simulate from Start, and click the Play icon P in the Simulation
toolbar.

Note that the tool is travelling in a climb mill direction and the sequence of cutting is also
from the top of the job to the bottom. It is advisable, before transforming toolpaths, to create
a Master copy of the original.
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¢ Right click over the toolpath ‘Pocket1’ in the explorer and select Edit -
Copy toolpath ‘Pocket1’ and Rename the copy as ‘Master’.

¢ Right click over the toolpath ‘Pocket1’ in the explorer and select Edit -
Transform from the menu to open the Transform Toolpath form.

Toolpath |Pocket1 =]
orkplane I 1 j
e Set Relative Position - Distance 80. Active [

¢ Tick the Transform Copy option.

Draw
Transform Copy W

—Relative Position ~
e Select move Along X. ¥ Y2 #Z2  Distance |BD-D
rRotate
| ||:|.n
e Accept the form. X ¥ & o
—Mirror in Plane Transform To —
YEE | L@
Accept |

A copy of the original toolpath has been created and transformed along X by a distance of
80, with the name ‘Pocketl_1°.

The yellow icon next to the toolpath indicates that it has = _\(\)5 Toolpaths

not been gouge checked directly to the model. ¥, 1 g Mastar
ikl |- Pocketl
? 8 Pocketl 1

¢ In the explorer Activate toolpath Pocket1_1.

¢ Right click over the toolpath Pocket1_1 and select Verify > Toolpath.
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@# Toolpath Verification
Check
Check Against
| Models j | j
Scope I All - I

—Iv Split Toolpath
Output Safe Moves [
Output Unsafe Moves [V
Reorder Toolpaths [

CQwerlap ID.D
Minimum Length ID.EI

Head Clearance IGDU.D

—I Verification Thickness
Y

| ID.I:I
Replace Tool I vl

r—Collision Options
Shank Clearance IIII.EI
Holder Clearance IIJ.EI

v Calculate Collision Depth
Adjust Tool =

Draw Unsafe Moves v

ﬂppivl

v Split Moves

Accept |

8. Editing Toolpaths

e Select Gouges for the Check option.

There are two options in the Check area, Collisions or
Gouges.

The Collisions option will only perform a collision
check if a shank and holder have been defined along
with the tool.

The Gouge option performs a collision check on the
basic tool (the shank and holder are not taken into
account).

In the Scope area the default option All can be changed
if required to focus on a particular type of feature on the
toolpath from; Cutting Moves, Connection Moves,
Leads, or Links.

e Apply the form.

An information box appears informing the user, that in this instance, no gouges have been
found. The icon also updates indicating the toolpath is gouge checked.

ﬁl MC Programs

- £ Toolpaths
A v | 8 Master
# v | 8 Pocketl

Ov’ ' > Pocketl_1

& PowerMILL Informal

B

:l Mo gouges were found

e OK the information window and Accept the toolpath verification form.
¢ Right click over the toolpath ‘Pocket1_1’ in the explorer and select Edit —
Transform from the menu to open the Transform Toolpath form.

e Using the previous settings with Transform Copy ticked, enter a Distance
80 followed by move Along X.

ive Position

[Tﬁ%;&

Distance | 80.0
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The two new toolpaths can
be Appended to the
original toolpath if
required.

Note — It is important to Append toolpaths in the order that they are required to run, and
toolpaths can only be Appended if they share the same Tool and Tool Axis.

e Activate toolpath Pocket1 and undraw (switch off lightbulbs) on toolpaths
Pocket1_1 and Pocket1_1_1.

-4 Toolpaths

w8 Master
YIRSl |- Pocketl
vy 8 Pocket1_1
vy & Focketl_1 1

e To Append click with the left mouse keeping it held down over toolpath
Pocket1_1, then press the Ctrl key also keeping it held down while
dragging the mouse over toolpath Pocket1.

[ e Ry

A plus sign (as above) will appear if the toolpaths can be Appended.

¢ Release the left mouse button first followed by the Ctrl key (The order is

important.
=

'./ \..' Are you sure that you wish to append the toolpaths . . . . .
e This form will appear requesting confirmation for the

== Append action.

e Select Yes from the above form.
e Append toolpath ‘Pocket1_1_1’ to the first toolpath ‘Pocket1’.
¢ Delete toolpaths ‘Pocket1_1_1’ and ‘Pocket1_1’.
e Draw (light bulb) toolpath Pocket1 to view all three toolpaths.
te- [ @) <]
@ MNC Programs
E@ Toolpaths

v § 88 Master
SRR rocicis
-4 Tools

[]--O Boundaries

-4 Patterns

1—_‘? Feature Sets

-4 Workplanes

[]---@ Levels and Sets

- Madels
‘ Stock Models

- # Groups
-3 Macros
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o . ?

« Right click over the toolpath Pocket! in ™= e 2l
the explorer and select Edit - Toolpath [Pocket 1 =
Transform from the menu to open the Active Workplane [1 =
Transform Toolpath form. _

Active v Draw v

e Tick the Transform Copy option. Transfom Copy |

—Relative Position

» Set a Relative Position of Distance 80. %_ﬂ @ ostance [00

 Rotate

e Select move Along Y. X ¥ & Angle [0.0

—Mirror in Plane

"Transﬁ:rm To—

Le

---------------

Toolpath |Pocketi_1 % =
Active Workplane I 1 j
Active [~ Draw

Transform Copy W

"F‘.Elah’ve Position

3% S5 =2 DisEnceIBU-U

e Select the newly transformed toolpath Pocket1_1 in the Toolpath drop
down menu and move a Transform Copy by a Distance of 80 along Y.

e Accept the form.

=

- @) |

@ MC Programs
214> Toolpaths

e Append these new

--? ? aMaster tOOIpathS |nt0 the
| SR> pocken original toolpath
4 0 Boundaries (Pocket1) as before
.10 Patterns -
P rateeses and Verify to gouge
38 eatses check.
- Models
= ‘ Stock Models
- e e Delete toolpaths
- Macros

‘Pocket1_1_1’and
‘Pocket1 1.

e Save Project As -
D:\users\training\COURSEWORK\PowerMILL-Projects\Transform
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Edit > Limit...

Edit - Limit provides a series of options to retrospectively trim a toolpath to a Plane,
Polygon or Boundary.

Edit - Limiting - to a Plane

Edit - Limit - To a Plane allows the user to select a plane at specified distance across the X,
Y, or Z Axis. Alternatively there is an Arbitrary option which allows the user to specify an
origin point aligned with a direction vector in terms of X, Y, Z for the Limiting plane.

X Plane Y Plane Z Plane
@ Toolpath Limit 2l x
Limit to IPIane VI
rPlane
Type IPIane X vl
Paint
x [-40.0 v [o.0 z|-2s0
~Normal
#|1o v f0.0 z fo.0
Eoundary
Boundatsy: I 'l —
Brojection Plane | Active Workplane |+
Delete Original [~ Save IInner vI
Reorder |
Apply | Cancel |

Edit - Limiting - fo a Polygon

Polygons with any number of sides can be sketched using the left mouse button. This allows
complex areas to be defined, with the option to save the Inside, Qutside, or Both sides of the
polygon. N.B. before making a polygon ensure that the snap filter is set to pick Anywhere.

/
f \ / 3
{ \ { \
| /
{ \
\ \\
\ f

Limit to Polygon - Inside
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Edit - Limit - fo a Boundary
This provides the option to limit the toolpath to areas defined by an existing Boundary.
Again the option exists to save the Inside, Outside, or Both toolpath areas.

¢ Delete All and Reset Forms.
¢ Open the model:-
D:\users\training\PowerMILL_Data\Models\handle.dgk.

\ /

e Calculate a Block to the Max/Min Limits of the model and lock the Z Min
and Z Max, then input expansion 10 before applying Calculate again.

e Define a Dia 10mm Ball Nose named BN10.

e Inthe Rapid Move Heights Form click Reset to Safe Heights.

e Set the Start Point to Block Centre Safe and End Point to Last Point
Safe.
e Select a Constant Z Finishing strategy and enter data exactly as shown
below before selecting Apply.
§# Constant 7 Finishing 21
s ! lame: I—
T )%| | N 1
[ Toal Spiral [T
Iﬂj IBN = j Q ~ Stepdown
~Taolerances Minimum Stepdown ID‘2 The StedeWIl Wlll be Val'led
olerance | 0.01 . . .
. s | L Calauete Using Cusp ¥ within the Maximum and
{ _El‘l T;U— & Maximum Stepdown [ 10 Mil.limum Value_s 'in an attempt to
Cusp et [0.01 achieve the specified Cusp
[ 2ereer Corner Correction . Height. This enhancement will
EROVELR ArcFit [~
- Al e still not be effective on flat or
[Boundary e P (o) == nearly flat areas.
ZH] =
Trirmmir Ilfee Inside - Pocket Machine v
L Additional Stock |—n.n
[ees t:::l n INWE— Direction IClimb Vl
Lead Out INune
Short Links ISkirn
Lang Links I Skim
9
[ Tool Axis
Tool Axis IVerh‘ml ﬁ
Freview | I~ Draw
1 ’WI Accept Cancel
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As is clear in the above illustration the Constant Z finishing strategy created is not suitable
for shallow areas of the component. As a result a Boundary will be created and the toolpath
will be retrospectively limited to the steep areas.

e Select the main upper surface on the model, right click on Boundaries in
the explorer and from the local menu click the option Selected Surface to
open the following form.

@4 Selected Surface Bounda 2]
%J @ MName I 1
Top I
Roll Over [~
Tolerances
Tolerance ID.DI
Thickness I 0.0
U Axial Thickness IIII.III
g Use Axial Thickness [
Tool
Ul = [en1 ~|

1 Limit Boundary
& Inside Lirniting Baundatsy:

] outside I 'l
| Autamatic Callision Checking
Holder Clearance I 0.0
Shank Clearance I 0.0

Apply I Accept | Cancel |

e Enter data exactly as shown above before selecting Apply and then
Accept the form.
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e In the explorer Right mouse click over the Active toolpath and in the
local menu select Edit - Limit - /imit to Boundary.

e Enter data into the form exactly as shown below before selecting Apply to
create a copy of the toolpath limited to outside the Boundary.

¢ Toolpath Limit 2|
Limit to IBnundary vl

= Flane
- Point
% Jo.o ¥ | 0.0 z |20
= Mormal
4 B i z oo
Boundary
Boundary Il 'I
Frojection Plane I.-'-\ct've Workplane 'I

Delete Criginal [ Save IOLIhEF "I

Reorder [v

Apply | Cancel |

The toolpath has been retrospectively limited to the outside of the Boundary.

Delete Original
The Delete Original flag, if ticked causes the deletion of the original toolpath once the new
toolpath has been created.
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Changing the Order and Direction within Toolpaths

For toolpaths containing internal link moves, the order and direction of the tool tracks can
be changed. For example, if a machining sequence starts at the bottom of part, progressing
upwards, reversing the order will change the tool track sequence to start at the top of the part
and progress downwards. In this case the direction in which the tool travels is unchanged. It
is also possible to apply Reorder and/or Reverse to selected tool tracks within a toolpath.
Typical reasons for applying Reorder and Reverse to toolpaths include minimising fresh air,
tool movements, or to comply with the recommended tooling specifications (it is often a
requirement in High Speed applications for the toolpath to both climb mill and track
upwards).

During applications where the base of a deep slot is to be climb milled, a uni-directional
Raster Finishing Strategy will track across parallel, starting flush with one sidewall and
tracking towards the other. By locally editing the order and direction a more desirable
strategy can be created where tracking starts along the centre of the slot and progresses, climb
milling, separately outwards towards both sidewalls.

e Delete All and Reset forms.
e From File — Open Project select the read-only Project:-
D:\users\training\PowerMILL_Data\Projects\EditToolpath_2

&'-j. PowerMILL Warning:

& Project ‘EditToolpaths_2' is open read-only.
i lé It is being edited by user 'dfb’ on computer 'DELCAM.COM/CROC'

It can be saved only under another name, using 'Save Project
Az,

L= 1

e (Click OK to close the PowerMILL Warning form.
¢ In File - Save Project As:-
D:\users\training\ COURSEWORK\PowerMILL-Projects\Punchinsert_1
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¢ Inthe explorer - Toolpaths area right mouse click over the Active
toolpath bn12-finish-a1 and from the menu select Simulate from Start.

The Tool Climb Mills across the
form stepping downwards to the
base before stepping up the other
side. The toolpath will be
Reordered so that the tool
Climb Mills down both sides of
the form.

¢ Using the left mouse key, select all tool tracks on bn12-finish-a1 beyond
the centre of the form (Light Grey in the above illustration).

¢ In the explorer right mouse click over the Active toolpath bn12-finish-al
and select Edit - Reorder to open the following form.

] Toolpath Listing,

(=]
PN
|
=
X
Py
12

# Stark paint End paint Length Points
51 30000, -7.75, -19,71  -30.00, -7.75, -1...

All existing tool tracks (identified
by number) are listed in the current

order of machining.

Note: The selected tool tracks are
highlighted (blue) in the form.

B A T Y . r f R R PR hhhhphp

- P
e Click on the Reverse Order Icon = to reverse the sequence of the

selected tool tracks.

o (Click on the Reverse Direction Icon |_<]| to reverse the direction of each
selected tool track.
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The Order and Direction of the toolpath has been edited so that it Climb Mills in 2 groups of
sequential tool tracks from the outer edges of the form towards the centre of the base.

Note: Vertical Arc Lead In and Extended Move Lead Out have been applied to the above
toolpath to identify the directional differences.

e Save the Project:-
D:\users\training\ COURSEWORK \powerMILL-Projects\Punchinsert_1

Moving the Start Points

The start points on the tool tracks can be moved to provide a more suitable position for
applying leads. This is achieved by defining a line that crosses the new start positions on the
toolpath.

¢ Delete all and Reset forms.

¢ Open the Project:-
D:\users\training\PowerMILL_Data\Projects\limiting-example and select
an ISO1 view.

The toolpath start point needs to be
moved from here.

To here.
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e Select a View Down Z.
e Right click over toolpath 1 select Edit > Move Start Points and left click
two points as shown.

/ Click first point.

<+— C(Click second point.
=~
¢ Press Return on the keyboard to accept.

L IE J This has moved the start position.

Feeds and Speeds

The contents of the Feed Rates form can be modified and retrospectively applied to the
Active toolpath by selecting Apply.

&% Feeds and Speeds 2%
| Toolpath Properte [ Tool Properte:
Toolpath: D1ZT1-RGH-al Tool: D121
Type Diameter: 12.0 mm
Roughing -
) number of Flutes: 1
Operation
General - Gverhang
| ToolMaterial Proper te [~ Cutting Condition:
Surface Speed (Recommended: 67.86 mjmir) Spindle Speed (Recommended: 1800 rpm)
- G750 v L= | N
n r Eeed/Tonth B ded: 0.22 mm) | Cutting Feed Rate (Recommended: 400 mmifrin)
[0.222222  mm [+00.0 mmjmin
Axial Depth of Cut Plunging Feed Rate (Recommended: 40 mmjimir)
@ 0.0 mm ’@ 40.0 omjimin
Radial Depth of Cut Skim Feed Rate
3| oo mm 3000.0 o it
T~ Working Diameter
Depth of Gut Surface Slope Coolant
0.0 mm 0.0 B rene =

™ overhang Compensation

Reset | mpoly | Aceept | cancel |

Check the feed rate values assigned to the named toolpath in the explorer to verify that they
have changed.
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e Delete All and Reset forms.
e From File — Open Project select the read-only Project.-
D:\users\training\PowerMILL_Data\Projects\ExtraFeedrates-Start

e (Click OK to close the PowerMILL (Read-only) Warning form.

e In File - Save Project As:-
D:\users\training\COURSEWORK\PowerMILL-Projects\ExtraFeedrates-example

e Undraw the Model, Block, Workplane, and Tool to display just the
Toolpath and 3 Boundaries.

e Activate both the Toolpath and Boundary 2.

e Right mouse click on the Toolpath and in the local menu select Edit -
Update Feed Rate Inside Boundary.

‘E Enter the percentage of feed rate change ®

. v

e Input the value 50 and click on the Green tick to apply the percentage
difference from the nominal Feed Rate within the Active Boundary.

The toolpath is split into two different coloured
areas that are allocated a separate Feed Rate as a
percentage of the original. In the imported
Project the Cutting Feedrate assigned to the
toolpath is 450 mm/min.
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Activate both the Toolpath and Boundary 3
¢ Right mouse click on the Toolpath and in the local menu select Edit —
Update Feed Rate Inside Boundary.

iﬁ Enter the percentage of feed rate change [EI

100 { x

e Input the value 100 and click on the Green tick to apply the percentage
difference from the nominal Feed Rate within the Active Boundary.

The central part of the Toolpath area, clear
of the side wall has been changed back to the
nominal Feed Rate value by inputting 100
(%) in the form.

e To see the actual Feed Rate values assigned to the coloured areas of the
toolpath left mouse click - twice on the Light bulb adjacent to the
Toolpath in the PowerMILL explorer.

= @ Toolpaths

In this case the nominal Feed Rate is 450 mm/min and the modified section near the
intersection of the Base and Sidewall of the pocket have been reduced by 50% to 225
mm/min. The colour of the values displayed in the Information form is the same as the new
colours specifying the corresponding areas of the toolpath.
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Safe Z and Start Z Positions

The contents of the Rapid Move Heights can be modified and retrospectively applied to the
Active toolpath by selecting Apply to Active Toolpath.

—Absolute Heights

Safe Area |Plane 'I
‘orkplane I 'I

Mormal
{ 1 o0 7|00 K [10

safez | 10.0
Start 2 [ 5.0
|
I

e

| Reset to Safe Heights

Apply to Active Toolpath

r Incremental Heights

Rapid Mave Type IAbsqute vl

Safiels I —
Starh 2 I 5.0

Accept Cancel I

Editing Tool Start and End Point Positions

The contents of the Start and End Point form can be modified and retrospectively applied to
the Active toolpath by selecting Apply Start / End Point.

Start Point | End Point |

&l

Use |First Point Safe =

Method

overtide Tool sxis [T

@' Approach Along ITDD| Axis vl

v

Approach Distance I 5.0

— Coordinates
x | 859999 v |97.2352 7 [10.0

~Tool Axis
I |0.n JIU.U KIl.U

| Apply Start Point |

Apply | Accept | Cancel |
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9. Feature sets / 2D machining

Introduction

PowerMILL has a range of 2D strategies which operate specifically on entities called
Features. These are extruded along Z from wireframes (Pattern or imported model) and
are assigned as specific types such as Boss, Pocket, Slot, Hole, etc. Features are machined
independently (not gouge checked) to any existing surfaces/solids. A Feature is displayed as
an upper and lower contour linked by vertical lines. As a result it is not possible to colour
shade a Feature. A 2D Component is built up from a Feature Set consisting of one or more
related Features. Milling will occur in areas as dictated by the individual Feature types.

1. Features

Features are created from 2D geometry, and are individually defined as a Pocket, Slot, Boss
or Hole. It is also possible to extract Hole features directly from a Surface or Solid model as
well as from Area Clearance strategies when using the Drilling option for Lead In Moves.

2. Area Clearance (2D machining strategies)

On completion of a Feature Set, the 2D Area Clearance strategies are applied to create all
the 2D machining including roughing, semi finishing, and finishing strategies.

3. Drilling
Drilling options can only be applied to Hole Features. Types of cycle supported include
Standard drilling, Boring, Helical milling, Tapping and Thread Milling.

Features
There are six different types of Feature which respond very specifically to the 2D machining
options:-

1. Pocket, defines the area inside a profile, therefore the tool will only machine the inside
the Feature.

2. Slot, is curve based defining the track of the tool (with or without cutter compensation).

3. Boss, is an upstand. The tool will only machine around the outside of the Feature.

4. Hole, this is specifically used with Drilling strategies and is defined from points, circles,
curves, or directly from CAD model data.

5. Circular Pocket - a circular pocket is defined from points, circles or curves.

6. Circular Boss - a circular boss is defined from points, circles or curves.

Note; it is not possible to change an existing a Feature to one of a different type.

Stacked 2D data containing pairs of circles/curves or cylindrical surface data can be imported
into PowerMILL to be directly defined as Hole features, thereby removing the need to
manually input dimensions (eliminating a possible source of human error).
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Creating Features from Pattern seqgments

e Select File »Delete All and Tools =» Reset forms.
e Open the Project:-
e D:\users\training\PowerMILL_Data\Projects\2D-Drawing.

The imported Project contains a Pattern defining 2D geometry to be used to create a
Feature Set. The Project is Locked to prevent it from being altered hence the first step is to
Save As a separate Project locally with a different name.

e Select File - Save Project As:-
D:\users\training\COURSEWORK\PowerMILL-Projects\2DPatternExample

e In the explorer right mouse click on Feature Sets to access the local Pull
Down menu and select Create Feature Set.

&% Patterns 21|
- ¥ :‘.? =1 Create |Edit I Componentl
W dFcature Sets Name Root Ibl—
iame oo’

i Workplane Feature Sets I

g} Lewvels anc I > TEE IBDSS :l'

S Mo m e oo

L Recognise Haoles in Madel P oY
& Stock Mod — | absolute M RET
5 Groups Feature Set Names » rDefine bottom by
- Macros
Select Features... | Absalute =l oo
Deactivate ¥ Smart Creation Draft Angle IU-U
Draw Al
Undrave Al Use. [Paints I foo
Hole Creation

Preferences. .. Multiaxis =
Edit 4 Compound Hales =
Create Folder Create fram Partial Holes T
Delete Al Apply | Close I

e A new (empty) Feature Set - 1 will appear in the explorer and the Feature
Form will open ready to build the 2.5D model.

e Select the larger, rectangular Pattern Segment and enter values exactly
as shown in the above right Feature Form before selecting Apply (Do not
close the form).
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The first Feature is the main component body defined as a Boss (as shown above).

Create |Edit I Cornponentl

Name Root I pl
Type IPm:ket vl
—Define top by

| Absolute x| J40.0

—Define bottom by

[ Absolute | w0
v Smart Creation Draft Angle ID.IZI
Lse IPoints j |II|.II|

Hale Creatian
Multizxis [~

Compaund Hales T

Create from Partial Holes [©

Apply | Close |

e Select both, the filleted rectangle and the large circle Pattern Segments
and enter values exactly as shown in the above left Feature Form before
selecting Apply (Do not close the form).

If the form is closed by mistake to reactivate on the same Feature Set - right mouse click on
Feature Set named 1 in the explorer and in the local menu select Settings.
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Create |Edit | Comporlerltl

MName Root I h1
Type IHD|E VI
r~Define top by

IAbsqute x| [400

r~Define bottom by
| Absolute x| |00

¥ | Smart Creation Draft Angle IU-U
Use |Cirdes j |II-.II-

Hole Creation

Multiaxis [~

Compound Hales ]

Create from Bartial Holes [

Apply Close

e Select all 12 of the Dia 6 circles and enter values exactly as shown in the
above left Feature Form before selecting Apply.
= _:’} Patterns
V=1
. CP Feafulrisftf The contents of the Feature Set (1) should be similar to the illustration on
B bt the left (Note: The Author has opted to use a naming system where a Boss

— is prefixed with a b, a Pocket with a p, and a Hole with an h).
& h1_3 The Feature Set is now complete and ready for the creation of suitable

S 25D Machining Strategies.

=
&
&
o
&
&
&
o
+ 51 h1_6
o
o
&
&
&
o
W

M h1_12
5 Workplanes

2D Feature Set Machining

e Define a Dia 10 - tiprad 1 - Length 50 tool named D10T1.

e In the Material Block form @ Type - Feature before selecting
Calculate.

e |n the Rapid Move Heights form :_IE' select Reset to Safe Heights.

N
e Open the Toolpath Strategies form & and select 2.5D Area Clearance.
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e Select Offset AreaClear Feature Set and input data exactly as shown in
the following form.

¥ Offset Area Clearance [Feature Set Machining] 2x|
g‘g}g| | Name [D10tiat
Tool Lead In Moves
If" |j |p10T1 =l £ zl Type [Ramping =] _Optiors... |
~Tolerances Approach Qutside ¥

Tolerance |0.1 &l = Crilling Holes
Thickness Input I vl
lrgl ID'5 @ ‘ Gutput Hales Iholes
‘l‘ # I 10 Stepover I 5.0 ‘ r~High Speed Machining

T Profile Smoothing
Cotner Radius (7ol 0050
|_J—

)
|automatic =] [s.0

Machine Flats |Level 'l Lirks Ismooﬂq VI

Cut Directi Iﬁ Smoathing Allawance
ut Direction | Clim -

251 % ——
- Boundary

o -
Iﬂj I J ’_I Trochoidal Maves Il\lnne vl
Lirnit: | Tool Centre vl 10 % -1 b
Trimring |Keep Insids - l
g = —I~ RestMachining———————————————— |

r~ Profiling ITDDIpath j I

=l
“When | After Vl
Detect Material Thicker Than I 0.0

Cut Direction | Climb vl
F‘ Final Profile Pass ———————— Expand Area By I 0.0

IE\:ery z VI Allwance | 1.0 Consider Previous £ Heights
= =
~I" Area Filter | I

Filter: I Smaller Than j

Sorti i

Threshold (1w [2:0 orting Iﬂg 'I Ordering [Focket |
Filber Gnly. Enclosed | areas Type I Al l
"Tool Axis Direction I Auto - l

4

T I\l'ertial g ‘ PreferencelMinimise Air Moves
Apply I Accept | Cancel |

Ll

e Apply and after processing Cancel the form.
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e Select Profile AreaClear Feature Set and input data exactly as shown in
the following form.

@ Profile Area Clearance [Feature Set Machining] 2x|
@ [.l Name [D10t1 a2
rToal rLead In Moves
Ifi' |j |poT1 | & zl Type [Pungng ] | Cptions...|
Tolerances Approach Cutside ird

Tolerance | 0.01 r=Crilling Holes

Thickness Iniput I j'
’i...gl IU-U @ Qutput Holes Iholes

[~ Stepayver

= # | 10 5t | 5.0 ~High Speed Machining
SRt 1 Profie Smoothing

[ Stepdonn Corner; Radius (TOU} L5y
[Automatc | [10.0 ——

Machine Flats ILeveI vl U Im
N = i Smocthingdlowane——
Cut Bireckion I\Jlmb vl J——
r~Boundary

B | -
o j I J ’_l Trochoidal Moves INone vl
Lifmit: ITDD| Centre 'I 100 % -f—_— =

Trimmir IKee Inside 'I
A== —T Rest Machining —

[~ Profiing IToolpa th j I j
SWhen I.-‘«f'ter 'I
Detect Material Thicker Than I 0.0

Cut Direction ICIimb vI
Expand &rea By I 0.0

I Final Profile Pass
’7| Every 7 vl Allowance | 1.0 Consider Previous £ Heights

—I Area Filter - | I b

Filker | smaller Than j

Thresheld (01 [2.0 Sorting I ’g| v| Ordering [Pocket v
Filter Gnly Enclosed areas [ [ —
 Tool Axis

Tool axis [Vertical ;ﬂ
Apply I Accept | Cancel |

e Apply and after processing Cancel the form.

Note the tool is plunging
directly onto the form down Z.
This situation will be changed
retrospectively by applying
appropriate options in the
Leads and Links form.
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e Select the Leads and Links form and for Lead In - 1st Choice select
Pocket Centre followed by Copy to Lead Out before selecting Apply.

ZHeights | FirstLeadIn Lead In | Lead Out | LastLead Out | Extensions | Links |

1st Choice |Pocket Centre j 2nd Chaoice INone j
MNone .

Surface Normal Arc Distance I':|-':|
Vertical Arc

Haorizontal Arc Angle IEI.-ZI

Harizontal Arc Left
Horizontal Arc Right Radius IEI.'J
Extended Move
Boxed _
0.0 over gy gight Ramp Options. . |
¥ Allow start Ramp

[# Add leads to short links t!

"W Add leads at tool axis discontinuities

Angular Threshold I 90.0

[+ Gouge Check

Copy to Lead Cut | Copy from Lead Out | Apply Lead Ins

Apply I Accept | Cancel |

The tool is feeding down, central to the 2 pockets and leads on and off with a horizontal arc
move.
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¢ Define a Dia 6 Drill - Length 50 and named Drill6.

e Open the Toolpath Strategies form @ and select Drilling.
In the form select Drilling as shown in the following form.

& Hew 2l
Favourites I MyStrategies I 2.5D Area Clearance | 3D Area Clearance | Blisks  Driling IFinishing I Ports |

{‘ﬁﬁushes Dhlggﬁl QI

ﬂCDDIing |:

(‘::'&Caunherbored Tapped Preview
(‘,.'&Counherbored ........ \ peeeemeesaas

]
I{,IJ MNew Driling Method
3"& Plain
:‘ﬂ Screws
;‘i.‘&Tapped Counterbored
(‘i’&Tapped

CK I Cancel |

e The Drilling form will open in which the Select tab is clicked to open the
hole, Feature Selection form.

i’g'. Drilling 2] x|
g)@ | No Features Selected Name | Drills-a1
Tool
Iglj [orouLe =] 4 zl
Tolerances
Tolerance I 0.1
Thiness 21
’7 wdd ID'D g ID'D [ Select By |Diameter -
Minimum Diame ter l—
rLinks Maximum Diameter [
Short Links I Safe [ Diameters  Selection Filter
Dwell Time
0.0
Long Links ISafe
] Feed Rate Companent: j
I 80.0 I - l
i . »
Draw [~ Select... | Spindle Speed (rpm)
I 2600.0 Driling Cydle Output Vv Tolerance Component
] rill e Ou
Gouge Check ¥ s | ILargEst =l &
Select Close
Apply I Accept | Close / —I —I

¢ |nthe hole, Feature Selection form the Select tab is clicked to include all
defined holes in the Feature Set.

The ‘No Features Selected’ statement on the Drilling form will disappear.
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e Enter data into the Drilling form exactly as shown below before selecting
Apply.

@ Drilling 21|
@| MNo Features Selected Mame I Drils-a 1
Tool
If:— |j IDF‘.ILLG j éd Cyde Type ISlngIe Peck j
Define Top By I Hole Top j
~Tolerances Operation I Drill to Hole Depth j
Tolerance I 0.1
Sorting %l -
o= D Clearance Start
wd 0.0 : [0.0 20 ] [0 —
|
Peck Depth Depth
Links I — IF
Short Links | Safe ”
Dwell Time
0.0
Long Links ISaFe
]E ] Feed Rate Campanent
I 400.0 I vI

Draw [ Select... | Spindle Speed (rpm)
| 1800.0 Driling Cydle Output W

Gouge Chedk v

Apply I Accept | Close

¢ Close the Drilling and Hole Selection forms.
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2D Machining Exercise

For this exercise the following 2D drawing will be used.

RI00 (4 700 . 950 THRU (W 100

_— N L
¥

\\,

N

000
500
100
50 DRAET
\
)
%
2

00 /
—‘ ‘ N
| 500 |
(IS INI
00
00 | 0

Delete All and Reset forms
Import the wireframe model (as shown above):-

D:\usersl\training\Powermill_Data\Models\2d_Wizard_Example.dgk

Create appropriate Feature Sets to the above drawing dimensions.

1st Feature Set

The outer square and small
tapered, central upstand are
created as Boss Features.

The intermediate square is
created as a tapered Pocket.

The four Dia 15 circles are
created as Hole Features.

2nd Feature Set
The Slot Feature is best created
in a second Feature Set.

Create a Dia10 End Mill named Em10 (Roughing, Semi-finishing of
main Pocket and Finishing of Slot Feature).
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e Create a Dia 10 Tapered Tipped tool named D10Tr3A5, with Tip Radius
3, Taper Angle 5Deg, Length 50, Taper Diameter 10 (Final Finishing of
tapered walls Main Pocket and small Boss).

% Tapered Tipped Tool ed |
Tip IShank I Holder I Cutting Data I Description I

Name  Tool Assembly

Geometry M

[ 1 | —pue] Taper Angle |

(0 7 oo |

Length |

I 50.0 \ / 4 Taper Height
|
b

-

| 14,2876
¥ /
Tip Radius _\ Thper Diameter

Tool Status

Valid

To INumberI
Mumber of Flutes I 1

Eil

/
/

Note:- To calculate the Taper Height based on the Taper Angle and base Taper Diameter

the Manual Input, icon W adjacent to the Taper Height is clicked to apply the Calculate
option El to this parameter.
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e (Create a Dia 15 Drill named Drill15.

e Create suitable 2D machining strategies to produce an end result similar
to that shown in the following ViewMill illustrations.

Suggested Strategies:-

Main Block and Central Pocket

1/ EMI10 - Offset Area Clear (Feature)
2/ DI10Tr3A5 - Profile Area Clear (Feature)
3/ Drilll5 - Drilling

The Slot will be machined independently from the main pocket and for this reason it is better
to define it in a separate Feature Set. Note; The Y dimension of the existing Block will have
to be adjusted to fully, include the Slot Feature.

Slot
1/ EMIO0 - Profile Area Clear (Feature)

Sorting I %l v| OrderinglPocket vl
Slot Cutting | Centreline v|

Keep Left
Keep Right

Width of Slot is achieved by creating multiple
toolpaths that use different Slot Cutting options.
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Creating Features from Model holes

As well as being able to use imported 2D geometry, Hole Features can be automatically
defined from selected Holes in the 3D Surface or Solid model.

e Delete All and Reset forms.
e Select File — Import Model:-
D:\users\training\PowerMILL_Data\Models\corner_bowl.dgk.

e Make sure the Block is not defined at this stage, as the top of the Hole
features will be created at the nearest Z dimension (Max or Min) of the
Block. This is likely to result in some holes being created the wrong way
up (It is however possible to reverse a Hole feature).

e Select the whole model.
Right click over Feature Sets and select Recognise Holes in Model.

Create |Edit | Componentl
1 Patterns S — I—
Type IHoIe vI
i Workpl,  Feature Sets . )
Q Levels Define top by
Create Feature Set | absolute =l oo
B Models . i
Recognise Holes in Model
‘ Skack, Mg rDefine bottom by
G Impert | absolut =l oo
roups solute | [0
& R Feature Set Names 4 =

=4 Macros

¥ Sttt Creation Draft fnale IEI.I]
Use IHoIes j ID.D

Hole Creation

Multizxis [~
e Select Apply in the Feature form.

Compound Hales [~

Create from Partial Holes [~

Close |
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e (Calculate a Block defined by a Box around the model.
e Undraw the model.

A Hole Feature is created for each of the selected holes in the model (including the counter-
bores).

¢ Define suitable tools, then drill and counter bore these holes

Hole Capping

Hole Features can be used as the basis for capping holes in the model. If the intersection of
the hole and the top face is non-planar, PowerMILL will try and cap the hole with a curved
surface, matching the tangency of the surrounding surface. If it is not possible to create Hole
features because the holes are not exact, circular sections then it will be necessary to follow
the capping procedure in the Edit Boundaries chapter.

Example
The following example illustrates the process of capping cylindrical Hole Features defined
from a 3D model.

e Delete All and Reset Forms.
¢ Import the model Block_with_holes.dgk from PowerMILL_Data.
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e Calculate a Block defined by a Box around the model (In this case the
Holes will be created upside down).

e Select the whole model by holding down the left hand mouse button and
dragging a box over it.

Next Hole Features will be created from the model.
% Patterns
;F) Feature Sets
+- 1 Workpll  Feature Sets

* Select Recognise Holes in Model. & Levels
¥
Create Feature Set
+- il Models Recoonise Holss in Model
‘ Stock Md lecognise Holes in Mode
Groups tmport
- o R Feature Set Mames L4
¥ =8 Macros

The tops of the holes are defined as the
shortest distance from the top or bottom
of the material Block.

If Hole Features are created to a different
orientation from the natural Z Axis, They
are assigned to a new Feature Set. A new
Workplane is also created with the Z
Axis aligned to the new Feature Set,
Hole direction.

= Feature Sets

= R B
=1

Feature Set, 1 will be created containing 9 Hole features extracted from
the model.

2 O O O O B Y 3
0 0 0 0 28 0 0 28

L LT It |

In this case the holes will be created upside down to illustrate the Reverse Holes editing
option.

e Right click on Feature Set 1 and click Select All followed by Edit >
Reverse Holes.
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e Finally, select the top surface, then in the explorer, right click over
Feature Set 1 and select the Cap Holes option.

The new cap Surfaces will be generated (Tangential to the selected top surface) in a new
model called Capping Surfaces created along with a new level of the same name.

EIE‘P Feature Sets

- Workplanes
¢ Expand Levels by clicking on the + symbol. = o £ Levels

..... ¥ @' Block with holes
ol ,,Q' Capping Surfaces

e Click the light bulb to undraw main surfaces. ) @ Models

e Click the light bulb to undraw Feature Set 1.

The new capping surfaces may be created inside out (Surface Normals reversed). If
required they can be selected and from the local surfaces menu Reverse Selected can be
applied.

Note; the Capping Surfaces are automatically assigned to the new Level for easy selection.

e Click on the light bulb to draw the Block with holes level back on.

9.16 Issue PMILL 9



PowerMILL 9. Feature sets /2D machining

Creating Features from a 3D CAD Model
¢ Delete All and Reset Forms.
¢ Import the model 2DExample.dgk from examples.

e Create a New feature with the Name Example2.
e Calculate a Block defined by a Box around the model.

e Select the Two surfaces shown and in the Feature form select Type
Pocket.

¢ Input Define top by — Top of Block and Define Bottom by — Minimum
curve Z shown and create a Pocket Feature.
e (Create a Dia 20 End Mill named EM20.

From the 2 selected Surfaces a total of
5 Features are created (2 large Pockets
and 3 circular Bosses).

e Select the Pocket Feature which does not have any Boss Features
inside.
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e From Machining Strategies select the 2.5D Area Clearance tab.
e Select Profile AreaClear Feature Set and input data exactly as shown in
the following form.

@# Profile Area Clearance [Feature Set Machining] ed |
@l Name | pocket1-FinishingPass
Tool ; rLead In Moves
e [Parom 1| Lopie | :
I]‘_HJ IEMZIJ j ﬁ Type | Plunging | | @ptions . Unt|ck _ Approach
—Tolerances Approach Qutside [~

olerance I 0.01 [ Erilling Hales OUtSide
"Thidcness i} b_.’l Irput I vl

...Dl I 0.0 @ @utput Haoles I holes

- Stepover

I~ % I 10 Stepover I 50 r~High Speed Machining

T Profile Smoothing
r Stepdown Cormer Radius (ToW) 0050
U_J—

|Automatic  ~| [30.0
Machine Flats ILeveI vl Links lm
== | Smoothing Alowance ————————
I vl
Ut Directian | Climl o
Boundary

= | =
I‘-/| j I J ’_l Trachoidal Moves Il‘-lone VI
Lirrit: ITDD| Centre VI 101 s - P
Trirrirnir IKee Inside vl
& = —I RestMachining—————————————————— |

~Profiling |TO0Ipath j | j
WWhen I.-‘-\fber VI
Detect Material Thicker Than I 0.0

Cut Direction [Clinb ~| —— e Cut Direction —

[~ Final Profile Pass C I . b
’7| Every 7 vl Allawance | 1.0 CZonsider Previous 2 Heights imDp.

= -

—I" AreaFilter | I

Filker: ISmaIIer Than VI
Thresheld (Towy [20 Sorting I ﬂ vl Ordering [Pocket =]

Filter Only. Enclosed| areas Slot Cutting [Keep Left =
Toal Axis
Tool Axis I\J‘erﬁal g

Apply I Accept | Cancel |

e Stepdown 30.

e Apply and Cancel the form.

e Save the Project as:-
D:\users\training\COURSEWORK\PowerMILL-Projects\2Dtest
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Area Clearance Cutter Compensation
There is an additional option for applying Cutter Compensation to a toolpath available from
the Expert arca of the Area Clearance dialog.

e Activate Toolpath ‘Pocket Finish’.
e Select the Settings of the toolpath and make a Copy.
e Select the option to toggle the ‘Expert Area Clearance’ form.

[~ Cutter Compensation

Twpe

Mimimun Radius I 0.1

Cutter Compensation un-ticked is the default setting when creating a toolpath. PowerMILL
compensates for the entire tool radius, and in doing so assumes the tool used is an accurate
tool size, meaning the user is not required to define compensation at the machine tool.

e Tick the Cutter Compensation box and change the Type to Full Radius
and Recycle the toolpath.

] —

¥ Cutter Compensation

Type IFuII Radius vI .
Minimum Radius I 0.1 )

With Off selected PowerMILL will not compensate for the radius of the tool. In this instance
it is required to define the tool radius at the machine tool. This process is often referred to as
Part Edge Programming but is of limited value as most machine tools will not accurately
represent the contour in concave corners, or when an arc exists that is less than the tool
radius.
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e Select the Settings of the toolpath and make a Copy.
e Setthe Cutter Compensation - Type to Wear and Recycle the toolpath.

] —

v Cutter Compensation

Type I'n."'.u'ear vI
Minirmun Radius I 0.1

Protected Cutter Compensation

With Type Wear selected PowerMILL compensates for the nominal tool radius and the
machine tool compensates for any difference. It corrects for the limitations of the Off option
by ensuring that, in concave corners, a Minimum Radius field controls the size of the arc in
corners after a tool radius offset.

Most machine tools will then be able to accurately represent the contour in concave corners.
This allows PowerMILL to use the nominal tool size to check for collisions, but last-minute
corrections for the physical tool size can be applied on the machine.

Protected compensation is naturally applied up to the radius of Active Tool. Provided the
machinist does not use a compensation value (On the Machine tool controller) greater than
the radius of the Active Tool use in PowerMILL, then potential gouging in the corners will
be prevented.

(Protected) . N

Toolpath Radius

N

Profile Radius
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Thread Milling

This specialised Drilling Strategy is designed to use a Thread Milling
tool to Mill a Thread into the walls of circular Hole Feature. The tool
plunges central to a specified depth, leads on to the sidewall, and then
pitches upwards before leading off.

Within the options it is possible to apply a number of passes (stepping
outwards by an allowance value) to avoid tool overload. It is also
possible to choose either a Right Hand or Left Hand thread.

e Select File »Delete All and Tools =» Reset forms.
e Open the Project:-
D:\users\training\PowerMILL_Data\Projects\ThreadMILL1-Start

;;E PowerMILL Warning: ll

' Project ThreadMILL1-5tart is apen read-only.
L It is being edited by user 'dfb’ on computer 'DELCAM/DFE1'.

It can be saved only under another name, using 'Save Project As...'

The imported Project basically contains a Cad model, a predefined Hole Feature, a 3D
Offset Area Clearance strategy using a Tip Raduised cutter, and a Thread Milling tool.
The original Project is Locked to prevent it from being altered, hence the first step is to Save
As a separate Project locally with a different name.

e Select File - Save Project As:-
D:\users\training\COURSEWORK\PowerMILL-Projects\ThreadMILL-Examplel

e Activate the Thread Milling Tool named M40-Coarse-Pitch-5.
e Select the Hole Feature around the centre wall of the component.
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e Open the Toolpath Strategies form @ and select Drilling.
¢ In the form select Drilling as shown in the following form.

fg'. New ﬂﬂ

Favourites I MyStrategies I 2.5D Area Clearance I 3D Area Clearance I Blisks  Driling | Finishing I Ports I

:ﬂ Bushes E@l Q I

C__‘ﬂCooIing

{_‘fﬁcaunh&rbored Tapped [ Preview

.....................

@ Mew Driling Method
{_‘fﬁPIain

C‘:&SUEWS

cﬂjTapped Counterbored
i‘,"fﬂTapped

¢ In The Drilling form set the Cycle Type to Thread Milling, Radial
Thickness -3, Pitch 5, Name M40-RH-Thread, leaving all other
parameters as default (as shown below).

@ J Name I M40-RH-thread

Tool

I.\;é |j |M4D-C0arse-Pitd1 5 j gﬂ Cycle Type IThread Milling

Define Top By | Hole Top

Operation I Crill to Hole Depth

[
=l
=l
----- E Sorting I@

Tolerances
Tolerance I 0.1
Thickness 0 Clearance Start
wib ] I -3.0 - IU-U IT IT
Pitch Depth
[ Links [5.0 [570
Short Links I Safe = "
Turns Dwell Time
| 1.0 — ID.D
Long Links ISaFe
E;I Feed Rate Eompoment:
I 400.0 I VI
Draw [ Select... | Spindle Speed {rpm)
| 1200.0 Driling Cyde Output ¥

Gouge Check v

Apply I Accept | Close

e Select Expert settings .| to expand the form.
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] ™| cutber Compensation Coolant m
TwRe I Full Radius vl

1 Retract [Ful -

] i Rad\usl o Thread Inght Hand -

] Direction ICIimb -

Select the use a 45 degree arc lead option and return to the main form.
Apply the form main to mill a Right Hand thread 3mm deep into the wall.

e Create a new Block using Defined by Boundary along with Type model
and Calculate to the exact component dimensions.

¢ Right click on the toolpath D50t6-RGH-a1 (Do not Activate it) and in the
local menu select Simulate from start.

e Perform a ViewMILL simulation of both toolpaths (Do not Activate either
toolpath, so that the current Block definition is maintained).
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PRO - 2D Machining Options

Introduction

PowerMILL Pro contains 4 new strategies designed for more efficient 2D Machining
applications. These include:-

Face Milling.

2D Curve Area Clearance.
2D Curve Profile.
Chamfer Milling.

b .

2D Machining Example using Patterns

e Select File »Delete All and Tools = Reset forms.
e Open the Project:-
D:\users\training\PowerMILL_Data\Projects\Pro-2DMachiningStart.

GE PowerMILL Warning: 1'

Project 'Pro-2DMachiningStart’ is open read-only.
l . Itis being edited by user 'dfb’ on computer 'DELCAM,/SCZ'.

It can be saved only under another name, using 'Save Project
As..!

The imported Project contains 4 Tools and 3 Patterns defining the 2D geometry to be used
in the 2D Machining options. The Project is Locked to prevent it from being altered hence
the first step is to Save As a separate Project locally with a different name.

e Select File - Save Project As:-
D:\users\training\COURSEWORK\PowerMILL-Projects\PRO-2DMachining

e Activate the Pattern named CurveAC.

e Open the Block form and set Defined by to Box followed by Type as
Active Pattern and select Calculate (Do not close the form).

e Inthe Max Z Box input the value 22 before selecting Accept to close the
form.
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2
Defedby o -] |S2pel
[ Min Max Length
x [00 %J [155.0 %J [155.0 %J
v [00 %J [100.0 %J [100.0 %J
z [oo =t fia| [220 &l
o e
[ Cylinder Parameters
Centre ¥ IT‘T‘.S Diarmeter ID.D
CentraVIW ﬁ ﬁ
[ Estimate Limits
Tolerance | 0.1 Type AchvePat:errv\)
Expansion lr Calculate |
Draw ¥ Opadty |———
Accept Cancel
¢ In Rapid Move Heights click on Reset to Safe Heights.
¢ Activate the Face Milling tool named D50T6.
e From the 2.5D Area Clearance options select Face Milling and enter data
into the form exactly as shown below.
ol Toolpath name "
e Eﬂ] [ Dsots_Facemil_z20 Face Milling
----- Workplane iti 200 . ..
1: Block FacezPoston @ ‘\él\ Height of finished
----- |_| Toal Tolerance ID.l | COI’IlpOIlCIlt.
[+]-¢8 Face Mil
.= Rapid Mave Hei Stepover (s) | 35.0
- T Leads and Links
o S:rtstTnt ) XExpansion(s) |50 <+———— Extra Tool ‘run off’.
. End Point |—100.0
..... 5 Feeds and Speeds Engagement Feed Rate (3t)
----- | MNotes Auto Angle [V .
The explorer items can
ranc () [00 be directly selected to
. |_T.,\.O way =) access associated
selections and settings,
such as Tools, Rapid
Move Heights, etc.
2=l
Y —
U pastraass
Calculate | oK | Cancel I
[

Select Calculate to process the toolpath.
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e Activate the Tip Radiused tool named D16T3.
e From the 2.5D Area Clearance options select 2D Curve Area Clearance
and enter data into the form exactly as shown below.

Toolpath name
«@l Eﬂ] B Curve Area Clearance
----- k_, Workplane Curve
..... L] Toal ﬁ = : — Select the Pattern:-
----- o8 Limit Curve Position IJ vl Curve-Pockets
[#-2% Curve Area Clearance

ﬂ__ Cutter Compensation Floor Z IlD.D él

..... % Point Distribution

..... E Tool Axis Tolerance I 0.1

.= Rapid Move Heights I
o Curve Thickn 1.0
-4 :f.(' Leads and Links e eSS
-l Start Paint Type |Offset =
- End Paint

----- fir Feeds and Speeds Stepover I 3.0
----- © MNotes
Cut Direction ICIimb vl

Calculate | 0K I Cancel
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Note: While the Curve
Area Clearance form is
open, the areas to be
machined are displayed as
a shaded preview.

e Activate the End Mill named EM16.
e From the 2.5D Area Clearance options select 2D Curve Profile and enter
data into the form exactly as shown below.

= | Toolpath name
g&h‘ﬁ ﬁ]lﬁﬂlﬁ-ﬂ}CurveProﬁle Cur\'e PrOﬁle

k Warkplane Curve
ﬂ _‘T_';’;k ﬁl [curve odeets :_LE]' éﬂi’l ﬁ Select the Pattern:-
o Limit Curve Position IJ vl | Curve-Pockets

[+ Curve Profile

L Cutter Compensation Floor 7 IID.D él

.4 Point Distribution

-1 Tool Axis Talerance I 0.01

.= Rapid Move Heights
-1 Leads and Links Curve Thickness I 0.0

. )
:d”d‘ Start Paint Cut Direction [Climb =
End Point
-1 Feeds and Speeds

= Motes

Calculate | CK I Cancel

e Select Calculate to process the toolpath.
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e Activate the Chamfer Tool named D25Tr1A45/_2D Chamfer.
e From the 2.5D Area Clearance options select Chamfer Milling and e
data into the form exactly as shown below.

:p.' Chamfer Milling 2| x|

nter

oz e
@l ﬁ] | D25Tr 1445_3D Chamfer Chamfer Milling Select the Pattern:-

----- k Warkplane Curve Chamfer

g Block ﬂl | chamfer ﬁl Eﬁl

..... |.__| Toal

..... o&8 Limit Curve Position I I

-, Chamfer Miling

i} cutter Compensation I Ancle Defined By
i Tolerance |0.01

..... % Point Distribution I

..... 3 ; Chamfer Angle
L_, Tool Axis Curve Thickness. ID.D

:j Rapid Move Heights

S . Depth
[+ I Leads and Links Cut Direction IConvenﬁonaI "I r

Chamfer Angle |45.0
Width |5.n Depth |5.n

%1

- Start Point
e? End Point
_____ i Feeds and Speeds ~ Chamfer Definition | Default Chamfer
L _—1 Angle setting used
..... Motes
le Defined B -
Angle Defined By IE :I (Tool Geometry).

~Toal Position
~ The Pattern used as
the basis for the
chamfer is positioned
on the lower edge and
Calculate oK Cancel

a 1.0 overlap is
specified.

e Select Calculate to process the toolpath (Do not close the form).
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The resultant Chamfer
Milling strategy has
appeared on the wrong side
of the Pattern.

The toolpath needs to be recycled with the Chamfer Milling tool tracks on the inside of the
Pattern segments.

¢ In the Chamfer Milling form, select the Recycle icon to enable changes to
be made to the above strategy.

e Select the Interactively modify machinable sections icon to access the
Edit Machinable Sections toolbar.

e Select the Reverse machining side option, followed by the green tick to
accept the changes and close the toolbar.

Chamfer Milling

Curve
IChamfer j El

Curve Position

—— S E eS| BEE 90 |V K

Reverse machining side

¢ In the main Chamfer Milling form, Select Calculate to process the
toolpath (Do not close the form).

The Chamfer Milling options selected result in the angled part of the tool overlapping the
base of the Chamfer by 1mm.
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1.0 Overlap

A surface model of the finished component has been imported to provide a visual check of
the Chamfer Machining. The Imm tool overlap at the base of the chamfer is clearly visible
in the above illustrations.

e Run a ViewMILL simulation of the whole machining process.
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10. Tool Holder Collision
Checking

Collision Checking

Collision Checking can be applied retrospectively, as long as a tool Shank and Holder are
defined with the Active Tool. If the option Verify - Collisions is applied, two additional
toolpaths will be created from the original, one being collision safe, and the other being in
collision. At the same time a copy of the Tool with a suitably extended Overhang will be
substituted into the Original and Collision status toolpaths.

Select File - Delete all and Tools - Reset Forms from the top menu.
From the Examples folder open the model cowling.dgk.

Calculate the Block to Min/Max limits.

Reset Rapid Move Heights and the tool Start and End Point.
Create a Dia Smm Ball Nose tool Named BNS with a Length of 10.

& Ball Nosed Tool 7=l

Tip |5hank I Holder I Cutting Data | Description I

Toal Assembly

|Name EX
~ Geometry M

]
L

|
!
|
Length ‘
|

I

Diameter

Tool Status | Valid

Tool Mumber | 1

Number of Flutes | 1 K;_/
|

Close
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¢ Select the Shank tab.
e Select Add a shank component ﬂ
¢ Fill in the form as shown in the image below.

&% Ball Nosed Tool 2=l

Tp  Shank |Holder I Cutting Data I Description I

[~ Compaonents ~Tool Assembly

i i | T°g] You will now add a Shank.

Dimensions

Upper Diameter I 5.0
Lower Diameter I 5.0

Length | 20.0

|
|

|
|

|
! [
I [
I [
I [
| .

|
i Cutting length I 10.0 .

|
| .

|
! [
| !
I \
I \
|

|
|
L

shank length | 20.0

[Tool Assembly |

Close

o Select the Holder tab.

¢ Select Add holder component hal}
¢ Fill in the form as shown in the image below.

21|
To | shark Holder | cuttng Dota | Despion| A picture of the current active tool is
e I — [Tec et eE d}ilspcll'flyled on the right hand side of
| _ | the dialogue.
i Dimﬂn;%@lﬂl I Overhang — the length of the cutter
[ Upper Diameter [355 : protruding_ f_rom the chuck or collet.
: Lower Dianetr [ 25— : .If any collisions are fopnd this value
i s [F7— | is 1qcreased to t'h_e minimum value to
| el i avoid such collisions.
i ! Upper Diameter — the diameter at
i Overhang [ 15.0 | ! the top of the current section of the
! Gauge Length [30.0 | tool holder. This must be greater
: _— than or equal to the Lower Diameter.
| L] Lower Diameter — the diameter at
i ! the bottom of the current section of
‘i: Cr) the tool holder. This must be less
! - than or equal to the Upper Diameter.
Length - the vertical height of the
current section of tool holder.
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¢ Select Add holder component hal}
¢ Enter an Upper Diameter of 22, a Lower Diameter of 20 and a Length of 10.

¢ Select Add holder component i}
¢ Enter an Upper Diameter of 30, a Lower Diameter of 30, a Length of 10 and an
Overhang of 15.

e Select Save tool holder [H in C:\Temp with a File name as ToolHolder 1.pmlith.
e Select Close.

21
To | shank Holder | cuting Data | Descrioton | Once you’ve added the components
R P o fssemd gg| || youcan easily modify or delete them
by simply clicking on one of them in
| |
| N M I the form (they turn pale. The current
i upperOemeter [55— : values are displayed and available
! : for modification.
| Lower Diameter IW | . cpoe,
. | The same applies if it is necessary to
: tensi [ 100 | modify the Shank details.
' Ignore -
| |
| Overhang [15.0 | ! After creating the tool Holder you
! Gauge Length [370 ' save it. It can then be loaded at a
! : later date to check further toolpaths
: — for collisions if required.
E J_
|
| N

¢ Select Toolpath Strategies & on the main toolbar.
e Select a Raster Finishing strategy.
e Select OK.

A
el New

' 2.5D Area Clearance I 30 Area Clearance I Blisks I Driling I Favourites Finishing |Ports I

£} 3D Offset Finishing
=2 Constant Z Finishing
|cormer Along Finishing
L” Corner Pendl Finishing
&= Corner Stitch Finishing

oK I Cancel
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¢ Enter a Name as RasterFinish, an Angle of 45 and Stepover of 1.
Select Lower Left as the Start Corner.

e Seclect Leads and links E

e In the Leads and Links dialog box, select the tab Lead In and set the 1% and ond
Choices to None.

¢ Do exactly the same in the Lead Out tab.
In the Leads and Links dialog box select the Links tab, enter a Short/Long
Threshold of 2, set Short to Circular Arc and Long to Skim.

The Raster Finishing strategy form should look like in the image below.

.';‘ Raster Finishing .ﬂﬂ
Tool
[ — e
Start Comner |Lower Left -
~Tok
Tolerance [ 0.1 ﬁ -~ Perpendiadar Pass
i3 Perpendiculer Pass [T
“gl [o.0 &j Sheflow Ange | 30.0
Dt Parabel Pace [T
F IT iI ~ Ordering
iTwo Way s
- Arc Regus IT
pes =& =
[ 22|~
Trimemng IKeep Ireide \'I ArcFit [
firc Radis (10U, 0.050
Leads and Links ——————————————————— ——
Lead In | None
Lead Out | None
Shert Links |crn.ium
Long Links | Skam
il
Tool Axis
Tool Axs [Verticd ]ﬂ
Praview I [~ Draw

s | oo |
e Select Apply, followed by Cancel.

The new toolpath is generated but at this stage
no collision checking has been applied.
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e Select Toolpath Verification B

==
(12 | Collisions
CI'”Hd;“IQ 3 | . The two Check options here are Collisions and Gouges.
Scope contains options to control which actual elements of a
sope [l ] toolpath are checked.

—¥ Split Toolpath
Qutput Safe Moves W

OutputUnsafe Moves ¥ The amount by which the unsafe move is extended to Overlap
Reexcieraopethall | with an adjacent safe move.

v Split Moves
Overlap | 0.0 .
Mimmtength [0 Represents a specific safe area around the tool Shank and
Holder to be taken into account while collision checking.

Head Clearance | 600.0
I Verification Thickness —————————————
- Using the above settings the original toolpath is retained and
[~ Collision Options

repacerea [ =] | tWOnew tpolpaths are created Split' to represent thg collision
e o and collision safe areas. For the original and collision area
lder Cemrance |T toolpaths, the original tool is automatically, replaced by a copy

v Calculate Collision Depth Wlth a Sultably eXtended TOO] Length for CO]IISlon free
’—r »\dJustTll" machining.

Draw Unsafe Moves M
roply | Accept|

e Select Apply.
¢ Select OK.

e =l Tn this case PowerMILL has detected that with the current

-
\.}) Collsora; with hokder Found to & dspth of 6 (holdor-compaonsnt 1)

Cobscratn e oo s st s o1 | t00l Holder and Shank settings collisions will be present at a

depth of 6mm. A suggested tool Overhang of 21mm will
be required to avoid this.

e Select Accept on the Toolpath Verification form.

E@ Toolpaths

=% ¢ ES Rasterfinish PowerMILL has created two more toolpaths, raster finish_1 and
-8 ¢ B RasterFinish_1 raster finish_2. A new tool called BN5_1 has also been created in
=8 § B > Rasterfinish_2

the tools area in the explorer. This new tool has been created with
the new adjustments made i.e. Overhang 21.

£ Tools

m- ¢ L) Bns
- L] =Bus_1

e Activate the toolpath RasterFinish_1 in the Explorer.
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This toolpath only contains segments of the
original toolpath, RasterFinish, that do not
have any collisions so the original tool and tool
holder, BNS is still associated with it.

If your preference is to run with the shorter
overhang then you could run this toolpath on
these areas shown.

e Activate the toolpath RasterFinish_2 in the Explorer.

This toolpath contains segments of the original
toolpath that can only be machined with the newly
adjusted tool Overhang.

e Activate the original toolpath RasterFinish in the Explorer.

2> Toolpaths
&= @ { B > RasterFinish

jﬁ: : E E::E:i:::ij_ \ PowerMILL has replaced the newly created tool (with the

=4 Tools extended overhang) into the original toolpath.
w- ¢ ) p2st3

5 el /

w- gl ens

e Select File - Save Project As and enter as File name as:
ToolCollisionExample and save it in
D:\users\training\COURSEWORK\PowerMILL-Projects.

10.6 Issue PMILL 9



PowerMILL 10. Tool Holder Collision Checking

Pro - Tool Holder Collision
Checking

Automatic Collision Checking

In PowerMILL Pro, Tool Holder Collision Checking can be applied at the time of the
toolpath calculation.

If the toolpath is calculated using a tool that includes a shank and tool holder any potential
part of the toolpath segments in a collision condition will not appear. These missing segments
can then be machined later using a modified tool in conjunction with a Collision Safe
Boundary.

e Select File - Delete All and Tools - Reset Forms.
e Open the Project:-
e D:\users\training\PowerMILL_Data\Projects\ToolCollision_Start

@ PowerMILL Warning: x|

Project ToolCollision_Start' is open read-only.
It is being edited by user 'dfb’ on computer 'DELCAM,COM/CROC',

It can be saved only under another name, using 'Save Project
As...'

Select OK in the PowerMILL Warning form.
Save Project As:-
D:\users\training\COURSEWORK\PowerMILL-Projects\ToolCollisionPro_1

Right click on the toolpath RasterFinish in the explorer.
From the local menu select Activate followed by Settings and in the
Raster Finishing form select the Copy toolpath icon.

H
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¢ with the Raster Finising form open, select the Automatic Verification icon
from the Main Toolbar to open the following form.
Head Clearance | 600.0
v Automatic Collision Checking
Shank Clearance | 1.0

Holder Clearance | 1.0

Accept | cancel |

e Tick the box Automatic Collision Checking and set both Shank
Clearance and Holder Clearance to 1.0
e Accept the form.

e Apply the Raster Finishing form to directly create a collision free toolpath,
RasterFinish_1.

Note:- This method does not display a new Shank length for the missing area or
automatically create a new compatible tool (bn5_1).

Collision Safe Boundary
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A toolpath for the remaining areas will require a new Dia 5 Ball Nosed tool with increased
Shank length. The additional Toolpath will be calculated to limits set by a Collision Safe
Boundary based on the current tool (bnS).

e Ensure that the tool BN5 is Active.
e In the explorer right mouse click over Boundaries and in the local menu
select Create Boundary - Collision Safe.

L
S IEoundaries
..... 4 Patte  Boundaries
DQ Fealy Toolbar...

..... 34 Wark
RS  Create Boundary Block
- Mode Faste a5 new Boundary: Rest
& Stock Boundary Names b Selected Surface

Shallow
Sihouette

¥ Grour  Batch Process
B8 Macre Invalidate Al

Collision Safe

_ [

The lower part of the central pocket is more suited to be finish machined using an End Mill.

e Select and Delete the 2 segments in the central pocket and the outer
segment.

e In the explorer right mouse click over the Tool - BN5 and from the local
menu select Edit - Copy Tool (to create BN5-1).
= '-‘-*_“.r Tools
¥ y || Bns
a4 ¢l =8NS

e Right mouse click over the new tool BN5-1 and from the local menu select
Activate followed by Settings.
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&4 Ball Nosed Tool 2] x|
Tip | Shank Holder |Cutﬁng Data I Description I
~Companents Tool bly
Holder Mame I 1 M

| : 3
; * [=ils
! Dimensions
! Uppet: Diameter I
|
| Lavier Diameter I
| Lemgth I
! Tanore T
|
i Overhang | 25.0
! Gauge Length | 42.0 _
|
. —
|
I I
|

¢ In the Tool Definition form select the Holder tab and change the
Overhang value to 25.0 before selecting Close.

¢ Right click on the toolpath RasterFinish_1 in the explorer.

e From the local menu select Activate followed by Settings and in the
Raster Finishing form select the Copy toolpath icon.

&% Raster Finishing 2]
gﬁ| | Name |RasterFinish_1_1
rTool : IF
7 A .
I_Hlj [Brs_t = zl =
Start Corner ILDwer Left vl
Tolerances
Tolerance IU.l &l r~ Perpendicular Pass
. Perpendicular Pass [
ickness
{ Dl |u.u Shallovy Angle | 30.0
Optimise ParallslFass [
~ Stepover 3
—Ordering
Stepaver I 1.0 |
e A Two Way j
~Boundary At Radius I.:.,.j
[ZE|E =l
—Corners
Trimming IKeep Inside vl ArcFit [
L Radivs fan 0050

¢ |nthe Tool area of the form select BN5_1 and in Boundary select 1 with
Trimming - Keep Inside.

e Apply the Raster Finishing form to create a new toolpath,
RasterFinish_1_1 limited to be Inside Boundary 1.
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Note that Automatic Collision Checking is still active and as can be seen in the above
illustration there is no evidence of the toolpath being fragmented. Having said that it would
not do any harm to apply retrospective collision checking to confirm this.

e Select the retrospective Toolpath Verification icon from the top toolbar. %‘

Check | Collisions 'I

[~ Chedk Against

I Models j I j

Scope | Al -

¥ Spit Teolpath
Output Safe Moves ¥
Output Unsafe Moves [#
Reorder Toalpaths [~

¥ SplitMowves ————
Overlap I0.0
Minimum Length I0.0

Head Clearance | 500.0

—I Verification Thickness
=4 Joo [

_whww:::md—v
Shark Cesrance [10 e Select Check Collisions with both Shank and
- e Holder Clearance set to 1.0 and Apply the form.

v Calculate Collision Depth
Adjust Toal ¥

Draw Unsafe Moves W

ﬂpdvl ﬂcceml

k. 3
. . .. ! PowerMILL Informat... X
The message confirms the Active toolpath to be collision safe. i OWer nformat.. B

.5
1 ) Mo collisions were Found

''''''''''''''''''''''''''''' I8t PMILL ™77 7777
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11. Patterns

Introduction

Patterns are 2D or 3D Wireframe entities mainly used primarily for toolpath creation. A
Pattern is either projected onto the model or traced in situ using Pattern Finishing.
Patterns can be used as a medium to take Wireframes in and out of the Wireframe
Modeller. Unlike Boundaries, Patterns can contain open segments.

e Select File - Delete All
e Select Tools - Reset Forms.
e Right click on Patterns from the Explorer and select Toolbar.

Patterns

I Toolbar... I

Create Pattern
Paste as new Pattern

Pattern Mames 4
Deactivate

Draw All

Undraw Al

Edit 3

Create Folder

Delete All

¢ From the top menu select Create pattern 21 and this generates an empty Pattern
Named 1 into which you can insert geometry.

When created, the Pattern is automatically assigned a number and made Active as shown in
the Explorer.

=7 Patterns
L s
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Pattern segments are created using one or more of the following options:

~. Automatic Pattern Generation (Open the Pattern Maker form).
& Insert File into Active Pattern (eg. dgk pic dxfiges ------- ).
Save Active Pattern as a file (dgk pic dxf).
& Insert Boundary into Active Pattern.
N Insert Active Toolpath into Active Pattern.
=2 Insert Model into Active Pattern (Selected Model).
A Curve modelling.

Z Wireframe modelling (PS-Sketcher).

Automatic Pattern Generation

The Automatic Pattern Generation icon opens the Pattern Maker form. This provides 6
different options allowing the user to create 4 different types of Offset Patterns between 2
open segments or to the left and right of a single segment, an Offset Pattern inside a closed
segment, as well as a Trochoidal Pattern across a segment.

e Select File - Delete all.
e Select Tools - Reset forms.
e Import the Model:-
D:\users\training\Power MILL_Data\Models\phone.dgk.

e Select Block @ and Calculate a Block to model Limits.
e Define a dia 12mm Ball Nose tool named bn12.
e Select Rapid Move Heights :—E and then Reset to Safe Heights.

e Select Start and End Points é‘ .
Select an Isol view to display the model.

11.2 Issue PMILL 9



PowerMILL 11. Patterns

¢ Right click on Boundaries, select the option Selected Surface from the Create
Boundary flyout menu options and enter the values shown below right.

%J@ Namell

Top I
Roll Over [
~ Tolerances
Tolerance ID.DZ
Thickness IIZI.IZI
u Axial Thickness I'II.'II
Q Use Axial Thidmess [
~Tool
IU' j [Bn12 ~|

e (Create a new (empty) Pattern ﬂ .

e Select the inner Boundary segment.
In the Explorer, right mouse click on the new (empty) Pattern and from the local
menu select Insert — Boundary.

¢ Input the Boundary Name (1) and click on the Green Tick to accept.

(1 Entity name @

! VX

e Undraw the Boundary.
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¢ Select and right mouse click on the Pattern segment and in the local menu select
Edit — Offset 2D (Round Corners).

¢ Input an offset distance value of 50 in the form and click on the Green Tick to
accept.

¢ Select in the Explorer the light bulb for the Boundary to display it again.
¢ Select the inner Boundary segment.
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¢ In the Explorer, right mouse click on the Pattern and from the local menu select
Insert — Boundary.

¢ Input the Boundary Name (1) and click on the Green Tick to accept.

& Entity name @

: v K

¢ Undraw the Boundary.

¢ Right mouse click on the Pattern and from the local menu select Instrument to
display the direction arrows on the segments as shown in the image above.

¢ Select the outer Pattern segment and from the local menu select Edit — Reverse
Selected (Both Pattern segments should run in the same direction).

The Automatic Pattern Generator will be used to create a new Pattern with a series of
segments merged between the 2 segments of the original Pattern. The resultant toolpath
will follow the contour of the component form as well as creating corner free, tool tracks with
constant material removal rate.

e From the Pattern toolbar select Create Pattern X to create a new Pattern.

¢ Select Automatic pattern generation =

e With the new Pattern activated and the original Pattern displayed, select both
segments.
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¢ Select Create pattern along curves one-way and input a Stepover value of 1.

ﬂ Pattern Maker d |

= The form allows you to create a range

of multi segment Pattern styles from

- ,:; - ///fﬁ;; - k(ﬂ@_ drive curves.

Stepove @ width | 50.0

Left Distance | 0.0 Radils |2':'-':I

Right Distance | 0.0 Diteckion ICIimh v|

Apply I Acceptl Cancel |

e Select Apply, followed by Accept.

The new Pattern has been
generated independently;
between the two selected
segments of the original, de-
activated Pattern (the above
illustration shows a 2mm
Stepover for visual reasons).
The new Pattern will now be
used in a Pattern Finishing
strategy.

e Select a Pattern Finishing strategy.

2%
2.5D Area Clearance | 3D Area Clearance | Blisks | Driling | Favourites Finishing |Ports |

£} 3D Offset Finishing E @l Q I —

_ConstantZ Finishing ==

I Corner Along Finishing
£ Corner Pencil Finishing

Preview

7

| 5|Radial Finishing
= Raster Finishing
{2 Spiral Finishing

11.6 Issue PMILL 9



PowerMILL 11. Patterns

¢ Enter the settings in the form exactly as shown below then Apply and Cancel the
form.

&7 Pattern Finishing ) d |

Name I bn12-final-al

—Drive Curve

j g [se Taolpath T
Pattern Iz VI ml

Tolerances .
Orderi IPathern 'I
Tolerance I 0.1 S:l e

Pocket Machine ¥

Thickn
: iss_ v rLower Limit
""E“l 0 g Base Position I."—\ubomat'c 'I
Aial Dfset ID.IJ
[ SEepoyEr:

Stepover I | FEouge Avoidance
Gouge Check ¥

r~ Boundary Strategy ITrace vl
|§Ij I j -*_l Wpper Limit I ID.D
-

Trimming IKeep Inside I ~Multiple Cuts
MMode IOf‘f 'I

rLeads and Links
Lead In INone— [ &imun Stepdatwn I 1.0
riurnber Of Cuks I 10
Lead Qut INone
Short Links ISkim
Long Links ISkiITI
r Tool Axis

Tool Axis I Vertical ﬁ

Preview [~ Draw

Apply I Accept | Cancel |

e Undraw the Model, Boundary and Patterns to view the toolpath.

The Pattern Finishing, toolpath is
limited to exist within the defined
material Block.

i
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Trochoidal Pattern Generator

The Trochoidal Pattern option within the Automatic Pattern Maker form is a technique
for machining slots especially in High Speed Machining applications. The Trochoidal
Pattern consists of a continuous spiral of advancing loops which have the effect of restricting
the tool contact area to only a part of its circumference.

This method requires a tool diameter that is smaller than the slot to be machined. The CNC
controller then performs spiral movements to produce the full width slot. Since the tool is no
longer cutting at full width the problem of overheating is effectively removed. This is
essential where coated carbide cutters are used for High Speed Machining of hardened steel.

o Select File - Delete All.
e Select Tools - Reset Forms.

e Select File — Import Model and import the model dashboard.dgk from the
Examples folder.
e Select an ISO 1 view.

You will machine the Slot using
the Trochoidal Pattern method.

e Define the Block ¥ to Min/Max limits.
¢ In the Explorer right mouse click on Patterns and select Toolbar....

e Select Create Pattern = from the Patterns toolbar.

e Select Insert File into Active Pattern =4 from the Patterns toolbar to load in the
file trochoidal_pattern.pic from:
D:\users\training\PowerMILL_DATA\Patterns

Before producing a Slot a Helically drilled hole of diameter 8mm must be machined to
create clearance for a Slop drill to plunge down to the full Slot depth. This is achieved by
using Feature Sets (Covered in more detail in the next chapter).

e Define a Ball Nose tool of 6mm Diameter.

¢ Right mouse click over Feature Sets in the Explorer and select Create Feature
Set to open the Feature Form.
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e Select the curved Pattern (1* click) and Shift Select the end point (2™ click)
identified by the short arrow.

o Select the tab Create on the Feature Form and enter the values shown in the
image below.

21
Create |edt | Component |
NemeRoot [dia_8.5
Tyee [roe <] A new Feature will be
" Define top by created that represents the
| Absolute =] Is0 hole ready for the helical

drilling.

Define bottom by
| absolute N

¥ Smark Creation Draft Angle IU-D
0 T % B EX

Hole Creation

Multiaxis [~

Compound Hales T

Create from Rartisl Hales I

Apply |I Close |

e Select Apply, followed by Close.

Select Toolpath Strategies & on the main toolbar.
e Select on the Drilling tab the Drilling strategy.
2| x|

'2.5D Area Clearance I 30 Area Clearance I Blisks  Driling | Favourites I Finishing I Ports I

(T Bushes

Cﬂ Cooling

(ﬁ Counterbored Tapped
. Counterbored

I;_‘; Mew Drilling Method
dﬂPlain

dﬂSu’ews

C:ﬂTapped Counterbored
CﬂTapped

oK I Cancel
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Select OK to open the Drilling form.
e Select the Select... button.

&7 Drilling 2|
@| | Mo Features Selected Name I 1
rTool
II::— |j IBNS j gﬂ Cydle Type IHeI|caI j
Define Top By I Hole Top j
~Tolerances Operation I Drill to Hole Depth j
Tolerance I 0.1
Sortingl -‘Sl v|
il U Clearance Start
wid Jo.o J foo o | e
Pitch Diepth
rLinks I D I—
Short Links ISa'Fe ”
Dwell Time
Long Links ISaFe 0.0
m Feed Rate Component
I 500.0 I vI
Draw [ select.. ||| Spindie Speed (pm)
1500.0 Drilling Cydle Output [~
Gouge Check v I ng Ly 2l

Apply I Accept |

Close

@ Feature Selection

Select By IDiameber - l
Minimum Diameter I
Maximum Diameter I

rDi ) r~Selection Filter

i < i
Tolerance Component
I Largest Vl xl

gl |3

Select | Close I

Issue PMILL 9
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Before the toolpath
can be calculated, the
Hole Feature must
first be selected.

Select the Diameter 8.5 on the left side of the Feature Selection form.
Select the Select... button and then Close the form.

Enter the values as shown below then select Apply, followed by Close.



PowerMILL 11. Patterns

& Drilling j 2lxl
_‘Ej;g| | Mo Features Selected Name |_1
rTool
II::. j IENS j gj Cyde Type I Helical - l
Define Top By I Hale Top - l
i OperaﬁgnlDl'i" to Hole Depth 'l
Tolerance I 0.1
"Th'daessl_ 0 l— Clearance
i 0.0 0.0 l—
= 5.0 =1
Pitch —
rLinks I10
Short Links I safe
Long Links I Safe
]E ] Feed Rate Companent
I 500.0 I o l
Draw [ Select... | spindle Speed (rpm)
| 1500.0 Drilling Cyde Output [~

Gouge Check ¥

Apply I Accept | Cloze

You can see on the animation that the tool is Climb Milling in an anti-
clockwise direction. The 8.5mm Diameter hole has now provided the
clearance necessary for a smaller tool to plunge into the Slot prior to the
Trochoidal milling operation.

ot
%
Lo,

e
I
]
]
i
—
:

Note: Feature Sets are not gouge checked to a Surface model so care must
be taken when creating them with regard to both size and position.

¢ Create an End Mill tool of Diameter 6mm called em6.

¢ Deactivate Pattern 1 (trochoid_curve), but keep it displayed by toggling the
lightbulb.

¢ Create another empty Pattern Pt (2) which will become Active.

e Select the curved Pattern (1) with the left mouse button.

e Select Automatic pattern generation =
¢ In the Pattern Maker form select the Trochoidal option and enter the data
exactly as shown below. Select Apply and Accept.

e
5 o2 [ 4R
Stepover I 1.0 Width | 5.0
Left: Distance I']-'] Radius I L0
Right Distance I 0.0 Direction ICIimb vl
| (] o
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R

7 v SN R EATaTararr
b nﬂlnm’mml"'n. - .
L T R

&

-

=]
=)

-

Note: The Radius must not be a value greater than half the Width. A fine Stepover is
required when applying to High Speed Machining of hardened steel.

If the Radius value used in the Pattern Maker form were 2.5
the resultant Pattern would appear as shown to the left.

Select Toolpath Strategies \J

¢ On the Finishing tab, select the Pattern Finishing strategy to open up the
Pattern Finishing form.

¢ Enter the values exactly as shown in the image below.

ﬁ‘ﬁ', Pattern Finishing 2] x|
@| | Name IZ
Tool r~Drive Curve
’V |I |j IEMS | Q ‘ Use: Tanjpath [T
Pattern |z vl m
Talerances
Orderi IPathern vI
Tolerance ID.I g ng
Pocket Machine ¥
Thidcnel_ss [ Lower Li
imit
’VQI 2.0 ‘ Base Position Iaummahc vl
Ayl Offset | 0.0
Stepover
Stepover [FEoUgE Avoidance
Gouge Chesk
- Boundary Strategy! ITrace vI
|£Ij I j »_I Upper Limit I7 | 0.0
Trirnrning. IKeep Inside vl ~Multiple Cubs
fMade IOFf vl
rleadsandlijks——————
Iend I INone — Maxzimurm Stepdown | 1.0
niumber of Cuts 7 | 10
Lead Out INOHE

Short Links ISaFe
Long Links ISafE

Tool Axis
’V Tool Axis | Vertical g ‘

Preview I™ Draw

| Accept | Cancel |
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e Select Apply and then Cancel the form.

The 6mm End Mill tool will plunge into the previously
created 8.5mm clearance Hole.

The Trochoidal toolpath defaults to a Climb Mill
direction and is ideally suited to High Speed Machining
applications.

e Activate the toolpath 1 (drilling) in the Explorer.
e Select Block ¥

¢ Select Defined by — Box.
¢ Fill in the form exactly as shown for the Limits Min and Max to create a Block
definition locally along the back half the slot width.

[pefinedt, [T | (5218
r—Limits
Min Maix Length

x [-0.0 %J [40.0 %_l [80.0
v [420 %J [60.0 %J [18.0
z [20.0 %J [32.0 %_l [12.0

2 B

rCylinder Parameters

Centkre s I'J.'J I.EL' [ameter | 296. 529431
Centre [51.0 I_EIJ

~Estimate Limits

Tolerance IEI.l Type IMDEIE| vl
Expansion IEI.D Calculate |

Draw [ Opadty —FH—

| &

Accept | Cancel |

e Select Accept.
¢ Position the Block in the graphics area in preparation for toggling into Viewmill.

e Select ViewMill On/Suspend * on the ViewMill toolbar.

¢ Select Plain Shaded Image & .
® Check both the Helical and Trochoidal toolpaths in turn with ViewMill.
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Helical drill toolpath. Trochoidal mill toolpath.
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Pro - Patterns

Patterns applied to 3D Offset machining

A Pattern can be used as the basic shape to be offset across the machining area of a 3D
Offset Finishing strategy. The following exercise requires the creation of a Selected Surface
Boundary along with a Pattern (created along the one of the sides of the Boundary) to
control both the toolpath shape and order across a 3D Offset Finishing strategy.

From the top pull down menus select File - Delete All.

Import the model - Examples/speaker.dgk and select an I1so3 view.
Define a &6 Ball Nose with the name bn6.

Define a material Block to Min/Max limits.

In Rapid Move Heights click Reset to Safe Heights.

Set both the tool Start and End Points to Block Centre Safe.
Select the 3 shaded Surfaces shown in the following diagram.

e Create a Selected Surfaces Boundary to a Tolerance of 0.02.
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O - REF|pEH| OCLORR RO 2« £

e From the Pattern toolbar click the Create Pattern icon ﬂ followed by

the Insert Boundary into active pattern icon. ¢

e Undraw both the model and Boundary to visually isolate the Pattern.

k Key-point

\ Only the leading edge of the Pattern is

x Key-point required. The remaining parts are to be
removed.

From the Pattern toolbar, select Curve Modelling to open the following
toolbar.

] Il Al T~ e
N ~

Define Start Point Define End Point

Select Define Start Point and left mouse click at the left of the leading
edge as marked in the above diagram with a small arrow and labelled as
Key-point.

Select Define End Point and left mouse click at the right of the leading
edge as marked in the above diagram with a small arrow and labelled as
Key-point.

Use the left mouse key and click on the lower part of the Pattern to define
which segment is required (identified with a large arrow in above diagram).

[ S = =
\ \

Save Exit
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e Select Save and then Exit the Curve Modelling toolbar.

e At the top of the original segment use the left mouse key to select and
right mouse key to access the local Pattern menu and select Edit -
Delete Selected Components leaving the newly defined, bottom leading
edge.

e Also in the local Pattern menu
select Instrument to display the
direction of the segment.

e [fitis not running in the direction
shown select the segment and
apply Edit - Reverse Selected.

This provides the user with a method of
dictating the final machining direction.

e Select a 3D Offset Finishing strategy and enter data into the form exactly
as shown below.

&% 3D Offset Finishing 21

@ Name [ 1

Tool
: spiral [
F <] [evs [
IEIJ I Q Maximum Offsets [~ I 10

Tolerance I 0.02 S:l Pattern I 1 vl %l

Start on Pattern [

Tolerances

Thickness
]
’i...Dl IU 0 Q Direction ICIimb "l

~Stepover

Stepover I 15 ﬁl

Boundary

[EM|E =
Trimming IKeep Inside vl

rLeads and Links

Lead In lNone—
Lead Cut INone
Short Links ISkIITI—
Long Links ISkim
9
 Tool Axis

Tool Axis Ih‘ert’ml g
Presie | [~ Draw
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Draw Leads and Draw Links
have both been switched off for a
clearer view of the toolpath.

The above toolpath starts at the lowest point following the Pattern while offsetting across the
limiting Boundary in a Climb milling direction. With the addition of suitable Lead In and
Lead Out moves this is an ideal strategy for High Speed Machining.

If a Pattern is not selected in the
3D Offset form machining
strategy follows the shape of the
Boundary segment as shown
left.

3D Offset Finishing controlled by Pattern Exercise

Note:- It is not compulsory for the Pattern used to control the toolpath to be coincident with
the limiting Boundary. In the following exercise it is required to create a toolpath trimmed
Inside a Boundary with the tool tracks following a Pattern running centrally along the base
of a circular recess:-

e Select Delete All and Reset Forms.
e Open the read only Project:-
D:\users\training \PowerMILL_data\Projects\PatternBlock_Start

11.18 Issue PMILL 9



PowerMILL 11. Patterns

:ﬁ_ PowerMILL Warning:

. Project PatternBlock_Start' is open read-only.
4 Itis being edited by user 'dfb’ on computer 'DELCAM/SCZ'

It can be saved only under another name, using 'Save Project
As...

[ o |

e Select OK to close the PowerMILL Warning and Save Project As:-
D:\users\training\ COURSEWORK\PowerMILL-Projects\PatternBlock_ex1
e Create a material Block, Defined By - Box to the Model limits.

¢ In the Rapid Move Heights form select Reset to Safe Heights.

e Create a Pattern using Insert Model the wireframe arc (included with the
Model) running centrally along the recessed form.

e Select the 5 Surfaces that define the recessed form and create a
Selected Surfaces Boundary using a 0.01 tolerance, relative to the
active BN16 tool.

e Create a 3D Offset Finishing strategy that is limited Inside the Boundary
with the order and shape of the tool tracks controlled by the Pattern.
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Deep Pattern machining

If a Pattern Finishing is applied with a -ve Thickness it will only create the strategy if the
inserted value is less than the tip radius of the defined cutting tool. As an extreme example,
this makes it impossible to apply a thickness less than zero in cases where an End Mill is
being used.

It is however possible to produce a Pattern Finishing strategy that machines deeper into the
model by first projecting the Pattern to be flush with the surface (relative to the tool
geometry) and then by using different options in conjunction with a -ve Axial Offset.

Note:- The strategy produced will not be based on an 3D offset of the model form but will be
a series of copies of the original Pattern stacked downwards. As a result it is not
recommended for use on steep areas of the model.

e Select Delete All and Reset Forms.
e Open the read only Project:-
D:\usersl\training \PowerMILL_data\Projects\DeepPattern_Start

i'g,‘l PowerMILL Warning:

Project 'DeepPatternMachining_Start’ is open read-only.
! 4, Itis being edited by user 'dft’ on computer 'DELCAM/SCZ'.

It can be saved only under another name, using 'Save Project
As...'

e Select OK to close the PowerMILL Warning and Save Project As:-
D:\users\training\ COURSEWORK\PowerMILL-Projects\DeepPattern_ex1

The Project consists of component surfaces and a Pattern on Z0 representing the text ‘LH’
ready to be engraved into the component form to a depth of -3.

Calculate a material Block, Defined By- Box, using Type- Model.
Create a Dia 5 Ball Nosed tool with the Name BN5.

In the explorer right mouse click over the actual Pattern 1 and from the
local menu select Edit - Drop to project it downwards onto the model (This
projects the Pattern down Z, adjusted to the geometry of the Active tool
BN5 and the current finishing thickness value).

X
From the main toolbar, select Toolpath Strategies and in the form
select Finishing followed by the Pattern Finishing option.
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e Enter the data into the form exactly as shown on the following page and
Apply.

& Pattern Finishing 2l x|
Name I 1
@l The Thickness of -3.0 exceeds the
ool i . . .
= - prve Cuve Use Toolath Tip Radius of the Dia 5 Ball Nosed
[ a—D — .
: iz *] 1| tool hence instead of a toolpath
[ Tolerances .
Toerance [0.0 o] == jl'_ appearing, the above PowerMILL
Pocket Machine v . .
Thidmess e Error form is displayed.
’7@ |'3'0 @‘ ’7 Base Position lm
e
I'/ Y "I Current tool cannot be used with this thidkness and tolerance,
~Boundary & The tool radius is too small.
CEw
Trirmimir

| T =T _Il

e Select OK to close the form and modify the data in the Pattern Finishing
form as shown below.

ol —

rToal rDrive Curve

. |BN5 j Use Toolpath [
IHJ g Pattern m H

~Tolerances e [0 &| Ordering lm
Pocket Machine ¥ .. .
"Thidcness Select Base Position Drive Curve

r~Lower Limit
g I 0.0 @ Base Position | Drive Curve 'l and input Axial Offset -3.0

Axial Offset | -3.0
Ser [ J T Switch Gouge Check off (untick).

Gouge Check [ Tick Upper Limit.

rBoundary Strategy. |Trace vl

Iﬂj | N J Upper Limit ' |0.0 Set Offset Down with Maximum
Trimming |Keep Inside j Huliple Gt Stepdown 1.0

Mode |Offset Down vl
rLeads and Links

Lead In lNone— Maximum Stepdown | 1.0
Number Of Cuts [~ | 10

Lead Cut INone

Shart Links ISafe

Long Links ISafe

r Tool Axis

Tool Axis I Vertical ﬁ

[ Stepaver

Preview [~ Draw

Apply | Accept Cancel

e Apply the form.
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The Reversed lettering, Pattern ‘RH’ is now recessed into the Punch form to a depth of
3mm.

Note: The above toolpath will be correctly identified in the explorer with a red gouge
warning.
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